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Welcome to EasyCopy
Click here to get online help about the Main Window.

Click on Contents to open the Table of Contents.

Click on Index to open an alphabetical index of help topics.

EasyCopyTM is a software product from AGI (autoGraph international) that provides a
complete set of image communication tools.
EasyCopy lets you produce high quality full color image prints from captured screen
images or imported image files.
EasyCopy is integrated with an image viewer that allows fast and convenient image
browsing, image cropping, and WYSIWYG preview.
There are two levels of EasyCopy: the Silver Edition and the Gold Edition.
EasyCopy Silver includes:

Advanced screen capture configured with hot keys.
Browse and preview folders of image files.
Open and view image files on the screen.
Crop images and remove background colors.
Print imported or captured images.
Save captured images.
Convert image files to another file format.

EasyCopy Gold gives you additional functions:

Support for large format plotters and special printers on the UNIX platforms.
Stamp function.
Image Montage.

These functions are available within the Graphical User Interface, which gives you full
control of all selectable file type options, printer options, page layout options, and color
options.

The licensable option EasyCGM can be added to EasyCopy Silver or EasyCopy Gold
to provide powerful support of graphics file formats.

Platforms
EasyCopy is available for all major UNIX systems and Microsoft Windows.
Information marked by this symbol applies to EasyCopy Version 7.3 for Microsoft Windows NT,
98/Me, 2000, and XP, and does not necessarily apply to EasyCopy on other platforms.
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Information marked by this symbol applies to EasyCopy Version 7.3 for AIX 4.3+, Compaq Tru64
(Digital UNIX OSF/1) 4.0+, HP-UX 10.2+, IRIX 6.5+, Linux (Intel i386 or Intel IA64), and Solaris
(SPARCstation) 2.6+, and does not necessarily apply to EasyCopy on other platforms.

Copyright © 2004, AGI (autoGraph international), www.augrin.com.
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AGI Conditions of Use
(Software License Agreement)
Information about the same topics as described in this Agreement may also be provided elsewhere in
the product documentation where it is presented from a technical or educational view. AGI does not
warrant that information provided elsewhere in the documentation is error-free or complete. In the
case of potential conflict between the information provided here and elsewhere, it is the AGI
Conditions of Use which is the sole legally binding Agreement between you and AGI.

By reproducing, installing, or using the enclosed materials, you agree to be
bound by the terms of this Agreement. If you do not agree to them do not install
or use this software.
AGI is short for Augrin Software (autoGraph international), a company in the Bitlinc
Group.

Copyright
The enclosed software ("the Software") is owned by AGI and/or Bitlinc and is protected
by copyright laws and international treaty provisions. You will not remove any copyright
notice from the materials. You agree to prevent any unauthorized copying of the
materials. Except as expressly provided herein, AGI does not grant any express or
implied right to you under AGI patents, copyrights, trademarks, or trade secret
information.

License
AGI hereby grants you, the original purchaser, a non-exclusive, non-assignable license
of the type you have bought, as specified in your invoice and in the License Document
you receive together with your Password.
You are allowed to install and use the software as specified for the License Type for
which you have purchased your password on computers owned, leased, or otherwise
controlled by you.

The Software can be installed anywhere on your file system independently of the
License Type (the License Type only regulates execution of the Software, not where its
files physically reside).
You agree to use your best efforts to protect the Software from any use, reproduction,
or other distribution except as specifically allowed under this license.
Evaluation
13

When the Software is installed without a password, it is installed for Evaluation. Any
limitations that apply to the functionality of the Software when installed for evaluation
are described in the documentation for the Software.
All terms and conditions specified for a Software License apply equally for Evaluation,
subject only to the exceptions expressly provided herein.
Evaluation is royalty-free (a fee for media and handling may apply).
You may install the Software for evaluation on any number of computers for the period
of time you need to evaluate the Software. When you have completed your evaluation,
you must either buy one or more licenses or completely remove the Software from all
computers where it has been installed.
License Types
Single Node License
A single node license is permanently locked to a specific computer. This is the
computer for which the Software is licensed. A password for a single node license
is only valid for that computer.
A single node license is managed by the computer to which the software is locked.
A single node license foreordains that the Software can only use the local display(s)
of the computer to which the license is locked. This implies that the License is not
valid if the Software is used through remote login, remote shell, or similar.
Fixed Licenses for Multiple Nodes
A fixed license is locked to a single computer.
Fixed Licenses are managed by the License Dispatcher.
The Dispatcher itself is locked to a specific computer. A password for a pool of
fixed licenses is only valid for that computer. The Dispatcher must be installed on a
server that can be accessed from any computer on which you want to use the
Software.
A fixed license can be taken from the pool and locked to a specific computer in two
ways:

The System Administrator can assign licenses to specific computers.
If there are unassigned licenses in the pool, a license is taken and locked the
first time a user activates the Software.

A fixed license which has been locked is returned to the pool and marked
unassigned, if the Software has been terminated and not activated again for a
period of 60 days.
The System Administrator may also unassign the license. The computer to which it
was assigned will in this case not be able to have it reassigned for a period of 60
14

days.
Floating License
A floating license can be shared by several computers, but can be used only by
one computer at a time.
Floating licenses are managed by the License Dispatcher.
The Dispatcher itself is locked to a specific computer. A password for a pool of
floating licenses is only valid for that computer. The Dispatcher must be installed on
a server that can be accessed from any computer on which you want to use the
Software.
A floating license becomes locked to a single computer as soon as the Software is
activated on that computer.
It remains locked to that computer ("is in use") for a period that depends on how
the Software was started:

If the Software was started through its graphical user interface it is locked until
the graphical user interface is properly terminated.
If the Software was started in command line mode it is locked for a period of
minimum 30 minutes, unless it was started solely for the purpose of displaying
version or help information.

Common for All License Types
The Password you get for your license must be installed to enable those capacities
of the Software, which are covered by the license you have bought. After you have
installed the Password, other capacities may still be available with the limitations
provided for, when the Software is installed for Evaluation, and you are allowed to
continue Evaluation of these capacities. However, the Password only assists you in
using the Software correctly according to the terms valid for your license. Your
rights and obligations are the ones set forth in this Agreement.
You are allowed to copy the Software for normal backup purposes. You may only
restore the materials from a backup on the computer or server for which the
Software is licensed.

Distribution
You may use the Software for application development and systems integration.
However, no resulting system or application is allowed to be used for commercial or for
internal purposes without a License Agreement between you and AGI for each
distributed copy. You may not otherwise rent, lease, or sell the Software in whole or in
part, and you may only transfer the Software License to another party on terms and
conditions approved in writing by AGI.
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Distribution of the Software is also subject to the following limitations:
a. You shall be solely responsible to your customers for any update or support
obligation or other liability, which may arise from the distribution.
b. You may not make any statement that the application or integrated system is
"certified" or that its performance is guaranteed by AGI.
c. You may not use AGI's name, trademarks, or logos to market the application or
integrated product without written permission from AGI.
d. You shall prohibit disassembly and reverse engineering as specified under
Non-Disclosure.
e. You shall indemnify, hold harmless, and defend AGI and its suppliers from and
against any claims or lawsuits, including attorney's fees that arise or result from
your distribution of any product.
f. You may not export the Application in violation of applicable export laws.
You must reproduce and include the copyright notice in any copy of the Software or
portions there of, whether or not merged into another program. Each copy of an
application or integrated system in which the Software is used must include a
trademark and copyright notice referring to the Software and AGI. The copyright notice
must appear in your product documentation, in the application's opening panel, its
About box, or any similar location where you specify your own trademark and
copyright, and in a layout and point size similar to notices from other suppliers of
components used in the application.
These are examples of copyright notices:
1. EasyCopyTM Copyright© 1989-2003, AGI autoGraph international.
2.
3. EasyCopy(tm)
Copyright (c) 1989-2003, AGI autoGraph international.
Any use of the EasyCopy logo, as in the example above, requires AGI's prior approval
in writing.

Updates
If the Software contained within this package is acquired through an AGI update
program or Software Subscription Service, this updated version of the Software is the
only version you are entitled to use.
You may only install this updated version on the computer for which the Software is
licensed. Unless otherwise agreed in writing by AGI, this is the same computer as the
one on which the previous version is installed.
When you have installed this updated version, you must completely destroy any copy
you have made of any material, which is part of a previous version of the Software
(including but not limited to binary programs and printed copies of the documentation).
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Termination
The license to use the Software contained in this package is effective until terminated.
You may terminate it at any time by destroying or returning the media contained in this
package on which the programs reside. AGI may terminate this license at any time if
you are in breach of any of its terms and conditions.
You agree upon termination to completely destroy the Software together with any
copies, modifications and/or merged versions in any form, and to destroy any
documentation received with the Software.
Termination of the license does not eliminate any prior failure on your part to comply
with this agreement.
Your obligations to use your best efforts to protect the Software from unauthorized
use, including but not limited to non-disclosure, remain in effect upon termination.

Non-Disclosure
You may not disassemble or reverse engineer the Software in whole or in part.
If you distribute an application or integrated system in which the Software is used, you
must in the conditions of use for that system include a similar clause covering, that
disassembly or reverse engineering the Software in whole or in part is not allowed.
This clause may cover the application or integrated system in general, in which case it
need not mention the Software explicitly.

Limited Warranty
The Software and enclosed materials and any other material you receive from AGI
related to the Software are provided 'as is' without warranty of any kind, either
expressed or implied, including but not limited to the implied warranties of
merchantability and fitness for a particular purpose. AGI does not warrant, that your
use of the software will be uninterrupted, or that the operation of the software will be
error-free or secure. AGI does not warrant, that the documentation is error-free. The
entire risk as to the quality and performance of the software is borne by you.
AGI makes no warranties, that the Software is fault-tolerant. The software is not
designed, manufactured or intended for use with on-line control equipment in
hazardous environments requiring fail-safe performance, such as in the operation of
nuclear facilities, aircraft navigation or communication systems, air traffic control, direct
life support machines, or weapons systems, in which the failure of the software could
lead directly to death, personal injury, or severe physical or environmental damage
("High Risk Activities"). AGI and its suppliers specifically disclaim any expressed or
implied warranty of fitness for High Risk Activities.
However, to the original purchaser only, AGI does warrant the media on which the
Software was recorded to be free from defects in materials and faulty workmanship
under normal use and service for a period of twelve (12) months from the day of
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purchase. If during this 12-month period a defect occurs, the media will be replaced
without charge to you provided that there is a proof of the purchase, and the defective
program media is returned to AGI. This offer is void if the media defect results from
accident, abuse, or misapplication.
Limitations of Remedies
AGI's entire liability and your exclusive remedy shall be the replace- ment of the media
if you have met the conditions as described under Limited Warranty or a full refund if
AGI is unable to deliver a program media free from defects or faulty workmanship.
In no event will AGI be liable to you for any special, incidental, consequential, indirect,
or similar damage arising from your use of the Software, including but not limited to
damage due to loss of data, loss of business profits, business interruption, or any
other damage, even if AGI or an agent of AGI has been advised of the possibility of
such damages.

Other
By using the Software contained in this package you acknowledge that you have read
this AGI Conditions of Use, that you understand it and that you agree to be bound by
its terms and conditions. You further acknowledge that this is the sole agreement
between us and that it supersedes any previous proposal or agreement oral or written
between us relating to the subject matter.
This Agreement shall be governed by the laws of Denmark.
If any provision of this Agreement is found void or not enforceable by any court of
competent jurisdiction, it will not affect the validity of the balance of this Agreement,
which shall remain valid and enforceable according to its terms.
No statement contained in this package shall affect the statutory rights of consumers.

U.S. Government Restricted Rights
Use, duplication, or disclosure by the Government is subject to the restrictions as set
forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software
clause in DFAR 52.227-7013 or the equivalent clause in FAR 52.227-14 or 19
whichever is applicable.

Trademarks
AGI, EasyAdmin, EasyCapture, EasyColor, EasyConvert, EasyCopy, EasyCopy/X,
EasyCopy/NT, EasyCopy/Graphics, EasyCopy/Page, EasyCopy/Scan, EasyCGM,
EasyHPGL, EasyQueue, EasyView, FleXprint, FleXimage, and JPEG PRO are
trademarks of Augrin Software (autoGraph international) and/or Bitlinc.
All other trademarks and product names referred to in materials related to the
Software are trademarks of their respective holders.
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Should you have any questions concerning this Agreement, please contact AGI's Sales
Department.
Copyright © 2003, AGI (autoGraph international), www.augrin.com.
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Software Subscription Service
Software Subscription Service is a very attractive offering from AGI that ensures that
your EasyCopy installation can be maintained and updated to the optimal level as soon
as software enhancements and new features become available.
A yearly fee entitles the subscriber to these benefits:

License to upgrade to new versions of product(s) included in subscription at no
additional cost.
CD-ROM with product(s) under subscription is sent promptly when a new regular
version is announced.
Password to Subscriber's Area on www.augrin.com. Subscriber's Area is a forum
for premium support. New printer description files, maintenance releases, patches
and fixes, and other product updates can be downloaded from Subscriber's Area.
Password change at no cost in case of system replacement.
Hotline support.

Contact our sales team for additional information.
Copyright © 2003, AGI (autoGraph international), www.augrin.com.
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License System
Configurations
Single Node
A "single node" license is node-locked to one specific workstation. EasyCopy can
only be used on the local display of that workstation. A single user license permits
no execution of the software by any method from remote workstations no matter
where in file system the software resides.
Multiple Nodes
Install the software on a file server and utilize common setup and maintenance
functions. The EasyCopy License Dispatcher must be installed on your network if
you have multiple licenses. These can be fixed or floating.

The license dispatcher is node-locked to a specific computer in your network; we
call this computer the License Server.
The license dispatcher must run on a UNIX server or a Windows server. Licenses from one server
can be assigned to clients on both systems.

Fixed licenses are node-locked but differ from single-nodes because the System
Administrator decides to which nodes they become permanently locked. Fixed
licenses that have not been assigned can be taken (and become permanatently
locked) by any user who opens EasyCopy.
Note, that it is the combination of workstation, display, and user that defines a
node.
Floating licenses float around among the users, as they need them.
You can assign floating licenses to specific nodes for shorter or longer periods. This
is effectively the same as changing a floating license into a node-locked license for
that period.
The difference between a fixed license and an assigned license is that you cannot
change the expiration of a fixed license to less than 60 days, and each time the
software is used from the node to which the license is locked the expiration period
is reset to another 60 days. In other words: an assigned license expires on its
expiration date, a fixed license expires only when it has been unused for 60 days.

When is a License in Use
When a user in a network with floating licenses starts EasyCopy's Graphical User
Interface it will take one license from the pool of available licenses. This license will be
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in use until EasyCopy is terminated.
An EasyCopy license will also be taken if one of its components is started through its
command line interface. Licenses taken by command line programs, however, will be
marked as "in use" for a period of 30 minutes where it can only be used from the node
that took the license. The expiration period of 30 minutes is reset each time a
command line program is executed. A fixed or an assigned license is permanently in
use until the assignment period expires. If there are no licenses available the user is
given the option of starting EasyCopy in demo mode. Demo mode also applies if the
user attempts to use a feature that is not included in the license, for example importing
a CGM file when the license does not include EasyCGM.

License Management
The License Dispatcher is used as a network-wide tool to manage EasyCopy licenses.
It is node-locked to the server on which it is running. Clients in the network connect to
the License Dispatcher
1. to get a license (if any is available);
2. to query the license status; and
3. to report when a license is no longer in use.
The License Dispatcher is available for UNIX and Windows (except Windows 98/Me).

No matter on which platform the Licens Dispatcher is running it can serve clients on
both UNIX and Windows.

EasyCopy License Dispatcher (UNIX version)
The information below applies when the License Dispatcher is installed on a UNIX system.

The License Dispatcher is running as a daemon on the License Server. It can be
started, stopped, and maintained only be System Administrator. It is controlled by the
ecdaemon command:
ecdaemon { start | stop | restart | status | assign }
The functions are the following:
The License Dispatcher functions are only available for the System Administrator, and (except for
the status display) they must be run on the license server.

ecdaemon start
This command starts the License Dispatcher. It may take a couple of minutes
before the daemon is ready.
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ecdaemon stop
This command stops the License Dispatcher.
ecdaemon restart
This command restarts (stops and starts) the License Dispatcher.
ecdaemon status
This command displays the current status of your EasyCopy licenses. The
command eclic is provided to give the same function, so that the status display
can be available without access to ecdaemon.
Example
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--- Available licenses ----------------------------------No. Product
Version
Tot/Free
Type
Components
---------------------------------------------------------1 EasyCopy
7.2
10
2
Floating
Gui
Print-1
Print-2
Convert
View
Capture
Montage
EasyCGM
--- Assigned licenses (marked #) and licenses in use-----------------No.
Product
Version
When
Who
IP
Hostname
---------------------------------------------------------------------1 1: EasyCopy
7.2
bill
192.192.1.11
(wsb11)
2 1: EasyCopy
7.2
joe
192.192.1.33
(wsb33)
3# 1: EasyCopy
7.2
12 days
smith
192.192.1.86
(wsc86)
4 1: EasyCopy
7.2
daisy
192.192.1.37
(wsb37)
5 1: EasyCopy
7.2
17 minutes rob
192.192.1.21
(wsb21)
6 1: EasyCopy
7.2
wendy
192.192.1.82
(wsc82)
7 1: EasyCopy
7.2
smith
192.192.1.78
(wsc78)
8# 1: EasyCopy
7.2
18 days
supp
192.192.1.54
(wsc54)

The first part of the example shows that there are a total of 10 licenses for
EasyCopy 7.2 (including the listed components of the EasyCopy), and that there
currently are 2 unsused (free) licenses.
The second part of the example shows how the remaining 8 licenses are being
used:

Two licenses (3 and 8) are preassigned to specific users. One assignment
expires in 12 days, the other in 18 days.
Five licenses (1, 2, 4, 6, and 7) are taken by users who have started
24

EasyCopy's Graphical User Interface. Any of these will become available when
the user terminates EasyCopy.
One license (5) is taken by a user who started a command line application. It
will become available within 17 minutes, unless the user at the node wsb21
starts a new command line program in the meantime.

ecdaemon assign
This command lets you assign or unassign licenses. It produces the same display
as ecdaemon status but you can then select one of four available options:
assign
This assigns a license. You are prompted for information about the node (IP
address) to which the license will be temporarly locked and the length of the
period. You can specify the period in units of years (y), months (m), days (d),
hours (h), or minutes (M) whichever is most convenient for the actual
requirement.The System Administrator should assign fixed licenses immediately
after installation is complete; otherwise they are automatically assigned to the
first users who take them. Fixed licenses have a minimum expiration period of
60 days. You cannot change it to a shorter period.
unassign
This unassigns a license. You are prompted for information about which of the
assigned licenses you want to unassign. This manual procedure is only
necessary if you want to terminate the assignment before it expires. You are
only allowed to unassign fixed licenses if the workstation to which it is assigned
is replaced or its network address is changed.
list

This refreshes the status display.

quit
This terminates the command.

EasyCopy License Dispatcher (Windows version)
The information below applies when the License Dispatcher is installed on a Windows server
(Windows NT/2000/XP). Note, that the License Dispatcher is not available for Windows 98/Me.

The License Dispatcher is running in the background on the License Server. It can be
started, stopped, and maintained only be the Administrator. It is controlled from this
monitor:
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Use Start | Programs | EasyCopy | EasyCopy License Dispatcher to open the
monitor.
If the License Dispatcher is not running you can start it by means of the Start button.
If the License Dispatcher is running you can use these four buttons:
Stop
This command stops the License Dispatcher.
Restart
This command restarts (stops and starts) the License Dispatcher.
Status
This command displays the current status of your EasyCopy licenses. The status is
shown in a command prompt window. Refer to the description of the corresponding
command in the UNIX version.
Assign
This command lets you assign or unassign licenses. It opens a command prompt
window. Refer to the description of the corresponding command in the UNIX
version.
If you close the monitor window it has no impact on the License Dispatcher. If it is
running it keeps running after you close the window.

License Dispatcher and System Startup
It is recommended that you start ecdaemon as part of the server's normal startup
procedure.
The details about how you integrate the ecdaemon start command with the server's
startup procedure depend on your system. Here are some suggestions for various
platforms:
AIX
Edit the file /etc/rc.tcpip and add the following line:
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[ -x /usr/bin/ecdaemon ] && /usr/bin/ecdaemon start
HP-UX 9
Edit the file /etc/rc and add the following line to the localrc() function:
[ -x /usr/bin/ecdaemon ] && /usr/bin/ecdaemon start
Other UNIX systems
Copy the file ecdaemon from the directory of invocation scripts to the directory
init.d, and create links that automate startup and shutdown in the directories rcx.d
(where x depends on how your system's run levels are defined). These directories
are normally found in /etc (/etc/init.d/, /etc/rc0.d, /etc/rc1.d, ... ), but on some
systems they are located in /sbin (Compaq Tru64, HP-UX 10) or /etc/rc.d (some
Linux systems).
Example
Assume the following assignments of run levels:
0=
1=
2=
3=
4=
5=
6=

Halt
Single user mode
Multiuser
Multiuser with NFS
Unused
X11
Reboot

For the run levels that are used for multiuser system startup (2, 3, and 5 in this
example) you need links that start the daemon. Make sure, that this happens
relatively late in the startup procedure, so that any prerequisite system components
have been started before ecdaemon. You should thus create this link in rc2.d,
rc3.d, and rc5.d:
ln -s ../init.d/ecdaemon S99ecdaemon
For the run levels that are used for system shutdown (0 and 6 in this example) you
need links that stop the daemon, and this should happen relatively early in the
shutdown produre. Create this link in rc0.d and rc6.d:
ln -s ../init.d/ecdaemon K01ecdaemon
Windows
Include the startup of the License Dispatcher in Scheduled Tasks
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Note, that you must add the start option to the command line, and you must also
supply the folder name in which the License Dispatcher should start.
Schedule the task to start at system startup. The License Dispatcher will then be
running if only the server is started.
If you have installed EasyCopy on a file system which is not local to the server, you should
schedule the task to run at logon rather than system startup.

Security Issues
The license dispatcher needs a working file (.agilic) that is readable and writable by
ecdaemon. This is not a problem if the license dispatcher runs as privileged user, for
example root. The files in the easycopy directory are normally owned by root with
permissions 755 or 644, so they are not writable by ordinary users.
If your security policy does not allow that the license dispatcher runs privileged we
recommend an alternate solution:

Create a user acount, say ecuser, with standard (or even restricted) privileges.
Let the program ecdaemon be owned by ecuser with permissions 500 and enable
setuid.
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Let the file .agilic be owned by ecuser with permissions 600.
This method is safe against attacks, and it only gives the license dispatcher minimal
permissions.
When installation is complete use these commands to implement the method
described above (modify directory paths to the names that actually matches your
system):
adduser ecuser
cd /usr/local/easycopy/system
chown ecuser .agilic
chmod 600 .agilic
cd /etc/init.d
chown -s ecuser ecdaemon
chmod 500 ecdaemon
Copyright © 2003, AGI (autoGraph international), www.augrin.com.
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Windows Installation
The information provided here applies to EasyCopy Version 7.3 for for Microsoft Windows NT,
98/Me, 2000, and XP.
Refer to the topic UNIX Installation for information about installation of the UNIX versions of
EasyCopy.

System Requirements
EasyCopy can be installed on these systems:
Microsoft
Microsoft
Microsoft
Microsoft
Microsoft

Windows 98
Windows Me
Windows NT 4.0
Windows 2000
Windows XP

Installation from CD-ROM
If an autorun procedure is activated when you mount the CD-ROM you will normally
find "Installation of EasyCopy for Windows" as one of options you can choose. Select
this option to start the installation procedure.

If the is no autorun active you must manually locate the Windows installer for
EasyCopy on the CDR file system (try D:\ec_win\install.exe). Start this program to
start the installation procedure.

Installation from the Web
You have downloaded a single file, for example ec73setup.exe. Double-click to
start unpacking to a temporary location and start the installation procedure.

Installation Procedure
1) Start the Installation
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When you see this dialog you are ready to start the installation.
Click Next to continue.

2) Accept license conditions

You must accept the License Agreement before you can install the software .

Click Yes when you have read and accepted all terms of the License agreement.

3) Select Installation Type
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This step requires Administrator rights.
If you do not have Administror rights, or if you install on Windows 98 and Me, you will
automatically get a local installation.

You can choose between a local installation or installation on a Network Server.
Click on installation type you want and click Next to continue.

If you are installing on a Network Server you need three additional steps after you
have completed the server setup (this procedure):

Administrator's client setup (create a response file to be used for unattended client
setup).
User setup (unattended client setup) to give workstation users access to the
software and documentation installed on the server.
Schedule automatic start of the License Dispatcher (not needed if you also have
the License Dispatcher running on a UNIX system in your network).

4) Choose Destination Location
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Choose a destination location where EasyCopy will be installed. This location will
internally in EasyCopy be known through the environment variable %ECTOPDIR%
which, for example, is used in the filter definitions.
If you install on a network server you must ensure that the location is shared.

When you have selected the desired location click Next to continue.

5) Icon

Select where you want an icon to start EasyCopy.
33

The installation program can create the icon in Window's Start menu
the desktop.

and on

The default is both. Click Next to continue.

6) Select Program Folder

Select a folder in the Start menu where you want icons for EasyCopy (if this was
selected in the previous step).

The default proposal is an EasyCopy folder in the Start menu's program folder.
Click Next when you have made your selection.

7) Copy Files

34

You are now ready to start copying files to the destination location.
Review the installation options. You may click Back to step back and make changes if
necessary.

Click Next when you are ready to start copying files into the installation destination.

8) Finish the Installation

When all files have been copied you get this message:
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The installation is now complete.
Click Finish to terminate the installation.

If you are installing on a Network Server you still need these steps:

Administrator's client setup (create a response file to be used for unattended client
setup).
User setup (unattended client setup) to give workstation users access to the
software and documentation installed on the server.
Schedule automatic start of the License Dispatcher (not needed if you also have
the License Dispatcher running on a UNIX system in your network).

Installation on a Network Server
This topic describes how a System Administrator can install EasyCopy for Windows on
a network server in order to distribute it to the users.
This type of installation requires that you have Multiple Node licenses for EasyCopy.

The installation procedure incorporates three steps:
1. Server setup. This step installs the software, online documentation, and client
setup program on a network server. It is the same installation procedure as for
local installation on a single node, except that the installation type must be chosen
as Network Server.
Select "Network Server" as the Setup Type
Choose a Destination Location on a shared network drive (the default
proposal is not necessarily a good choice for this setup type)
2. Administrator's client setup. This step creates a response file to be used for
unattended client setup.
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3. User setup (unattended client setup). This step gives a workstation user access to
the software and documentation installed on the server.
If you want to have EasyCopy available for both Windows and UNIX clients in your network you must
install the Windows version and the UNIX version independently. The only shared component
between the two is the license dispatcher which must run on a UNIX server.

Administrator's Client Setup
The purpose of administrator's client setup is to create a response file to be used for
unattended client setup.

In the following it is assumed that you selected "Network Server" as Installation Type
when you installed EasyCopy.

In the Destination folder on the server where you installed EasyCopy there will be a
subdirectory called ClientSetup. It contains a setup program that you can run either in
recording mode (administrator) or in silent mode (client).

First run it in recording mode to create the response file (setup.iss). An icon for this
setup program has been installed in the EasyCopy program folder:

Click on Start > Programs > EasyCopy >

EasyCopy Client Setup

Do not use any other method to start the client setup. If it is started with wrong or insufficient
parameters it will not function correctly.

This starts a new Installation Wizard:
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The Installation Wizard for EasyCopy Client will do the following:
1. It will require that you accept the license conditions.
When you accept the license conditions again during Client Setup you do it on
behalf of any user with access to the client workstations, whereas when you
accepted the license conditions in the first place during the installation of the
EasyCopy software on the server, you only committed yourself).
2. You determine which icons should be created for the clients (icon on the desktop
and/or in the Start menu).
3. You may select a specific program folder in the Start menu (default is EasyCopy
Client.

All the options you specify will be written to the response file when you run it in
recording mode.
This response file is used later when it is run in silent mode to perform user setup.

User setup
The unattended client setup is suitable for scripting and integration into your existing
procedures for software deployment.
When you have completed administrator's client setup there will be a response file
(setup.iss) in the ClientSetup subfolder.

The command to be executed on the client in order to make EasyCopy available is the
following:
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<easycopy>\ClientSetup\setup.exe -s
<easycopy> must be substituted with the network path as known by the clients to the location where
you have installed EasyCopy

This will install an EasyCopy icon on the client's desktop and prepare EasyCopy entries
in the client's registry. The Installation Wizard for EasyCopy Client will read all required
information from the response file, so it runs completely unattended.
The details about you push out this command line to the clients shall not be described
here. It all depends on how your server/client system is configured and what systems
you use for software deployment.
If you don't want to integrate EasyCopy in your general procedures, but only want to
make an installation shared among a few users, you may decide a more primitive
approach, such as sending a e-mail to the users to let them cut and paste the
command line to a command prompt window.
Copyright © 2003, AGI (autoGraph international), www .augrin.com.
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UNIX Installation
The information provided here applies to EasyCopy Version 7.2 for AIX 4.3+, Compaq Tru64
(Digital UNIX OSF/1) 4.0+, HP-UX 10.2+, IRIX 6.5+, Linux (Intel i386 or Intel IA64), and Solaris
(SPARCstation) 2.6+.
Refer to the topic Windows Installation for information about installation of the Windows version
of EasyCopy.

Upgrading from a Previous Version
You can use the installation procedure described here if you upgrade from EasyCopy
6.0 or later.
If you upgrade from EasyCopy/X (EasyCopy older than 6.0.0) or FleXprint we suggest
that you remove the previous version completely before you start the installation. This
is because EasyCopy since version 6.0 introduced a major change in architecture.
Previous directory structures and print queue interfaces cannot coexist with newer
versions.

Prerequisites
The supported hardware and operating system platforms are:
AIX 4.3+
IBM RS/6000 workstations
Compaq Tru64 (Digital UNIX OSF/1) 4.0+
Compaq (Digital) Alpha AXP workstations
HP-UX 10.2+
HP 9000 workstations
IRIX 6.5+
Silicon Graphics (RISC) workstations
Linux
Intel i386 or Intel IA64 based workstations
Solaris 2.6+
Sun SPARCstation
For download of EasyCopy from www.augrin.com you need access to the Internet.

For installation from CD-ROM you need a CD-ROM drive (locally available or
mountable across a network). If you access the drive across a network, you must
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include its file system in the exports of the system to which the drive is attached.
The supported printer connections are:

Centronics parallel port for printers with parallel interface.
RS-232C serial port for printers with serial interface.
TCP/IP interface for printers with a network card or printers connected via a
network interface box or a print server.
A remote shell connection to a workstation or server where a printer is connected.
SCSI connection for SCSI printers is available with EasyCopy Gold on selected
platforms.

X Server
The graphical user interfaces and the view programs require an X Window System
(X11 release 4 or higher).
Adobe Acrobat Reader
You need Adobe Acrobat Reader in order to view or print this manual.
You get an extra advantage if you have Adobe Acrobat Reader installed on the
same system as EasyCopy. You can then open the manual by pressing a button in
EasyCopy's graphical user interface and thus utilize the manual as an online
resource.
Adobe Acrobat Reader is distributed on CD-ROM together with EasyCopy, and you
can choose to install it together with EasyCopy if it is not installed already on your
system.
The same does not happen if you download EasyCopy from our Web site. If you
want to install Adobe Acrobat Reader you can download it from www.adobe.com.

Web Browser
EasyCopy comes with extensive context-sensitive online help. This resource
requires a web browser. The default installation is prepared for an interface to
Netscape Navigator because this browser is widely distributed in the UNIX
environment.
If you use another browser you can reconfigure this interface.
If a browser interface is not configured you will only get a brief, text based help
system.
You can download Netscape Navigator from http://home.netscape.com.

Disk Space
Disk space requirements are approximately 100 MB for a standard installation.
In addition you need generous disk space for temporary files. Temporary disk space
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requirements for screen capture and print jobs depend on your display, printer, and
selections. A minimum of 100 - 500 Mbytes (depending on your printers and
applications) is recommended; refer to the guidelines below:
Screen Capture
A full screen capture in full color from a display of 1600x1200 pixels requires
approximately 8 MB temporary disk space.
Print Jobs (Spooling)
Estimate the requirement by using this formula:
Disk space requirement (in MB): W x R x H x R x C / 8,388,608
where
W

=

image width (in inches)

H

=

image height (in inches)

R

=

printer resolution (in dots per inch)

C

=

1 for black-and-white printers
3 for RGB or CMY printers
4 for CMYK printers
24 for dye sublimation printers

Examples:
Letter size 600 dpi color inkjet

8.5 x 600 x 11 x 600 x 4 / 8,388,608

= 16.1 MB

E-size 300 dpi color inkjet plotter

34 x 300 x 44 x 300 x 4 / 8,388,608

= 64.2 MB

Actual disk space requirement may differ from this estimate depending on
expansions and reductions due to overhead, encoding, and compression.
Graphics Conversion
If you use EasyCGM or EasyCopy/Graphics to print vector graphics you need
additional temporary space:
Disk space requirement (in MB): W x R x H x R / 349,525
where W, H, and R have the same meaning as above.
Examples:
Letter size 600 dpi color inkjet

8.5 x 600 x 11 x 600 / 349,525

= 96.3 MB

E-size 300 dpi color inkjet plotter

34 x 300 x 44 x 300 / 349,525

= 385.2 MB
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Before You Install
Before you start the installation of EasyCopy you should consider these topics:

Primary Key
You will eventually need a unique Primary Key for your workstation (single node
license) or the workstation you want to use as license server for EasyCopy, but you
do not need this key before you install.
Your pre-installation task with respect to primary key is simple: Don't worry! You
need the primary key when you order a password, and a password is all you need
to change a demo version into a licensed version. You will not need to reinstall the
software later when you get the password.
Confirm the printer support
Check how EasyCopy supports the printer(s) you want to use.

Verify that the printer is attached to your system by one of the connection methods
supported by EasyCopy. Make a note of the path or address by which your system
knows the printer.
Check the disk space
Estimate your need for temporary disk space based on your expected use of
EasyCopy and the printer(s) you want to use. Use the information provided above
to make this estimate.
Use the df command to verify that your system has enough disk space available at
the location where you intend to install the software and sufficient temporary disk
space in /usr/tmp.
Root access
You may need root access to complete the installation and to setup printers. You
will normally be able to complete a single-node installation without root access, but
if you want to make a network installation you will normally need root access.
Consult your system administrator if the need arises.
Use the su command to get root access:
$ su
Password:
#

(type the root password)

Installation from CD-ROM
You have all available programs in the product suite for all supported platforms if you
43

have EasyCopy on CD-ROM.
Before you can start the installation you must mount the CD-ROM file system by
means of a system specific procedure. If you are familiar with any automatic or menu
assisted procedure on your system, follow that procedure. On many systems the
mount procedure starts automatically when you place the CD-ROM in the drive.

If no other procedure is at your disposal you can use the following basic procedure.
It requires root access.

Open a console or terminal window, and proceed as described here.
1. Determine the system.s CD-ROM mount point. Common names are /cdrom, /disc,
or /mnt/cdrom. Use the command ls / to detect, for instance, if /cdrom exists.
2. Enter the mount command with no parameters to get a list of currently mounted
devices. Use this list to deduce the name of any previously mounted CD-ROM file
system.
3. Detach the previously mounted file system (use the umount command).
Do not use the umount command on a system with an automatic mount procedure. If another
CD-ROM occupies the drive you can normally use the eject command to detach it.

4. Load the CD-ROM into the CD-ROM drive
5. Mount the CD-ROM using the appropriate mount command. The parameters to
the mount command are system dependent.
AIX

mount -v cdrfs -r /dev/cd0 /cdrom

HP-UX 10.x /etc/mount -rF cdfs -o cdcase /dev/dsk/c0t2d0 /cdrom
IRIX

mount -rt iso9660 /dev/scsi/sc0d?l0 /CDROM

Linux

mount -rt iso9660 /dev/cdrom /mnt/cdrom

Solaris 2

mount -F hsfs -r /dev/dsk/c0t6d0s0 /cdrom

Tru64

mount -rt cdfs -o noversion /dev/rz?c /cdrom

You must replace the ?-sign by a digit reflecting the SCSI id of your CD-ROM
drive.
6. Change directory to the mounted CD-ROM when it has been mounted
7. You can now start the installation.

You can extract the primary key by means of the getkey script in the CD-ROM top
directory. (You do not need the primary key at this stage, but the script is useful, for
example if you want to order a password for another workstation than the one on
which you may have made a trial installation).

Installation from the Web
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You can download UNIX versions of EasyCopy as .gz compressed archives.
You need gunzip installed on your system in order to uncompress these files.
To see if you have gunzip installed type the command which gunzip in a terminal or console
window. If you get a reply like "/usr/local/bin/gunzip" everything is fine. If you get a reply like "no
gunzip in /usr/sbin /usr/local/bin /usr/bin ..." you need to install it.
If gunzip is not installed on your system you can download and install it from www.gzip .org.

When you download EasyCopy from www.augrin.com you can only download the
software for one platform at a time.

If you want to make a common installation for multiple platforms you should download
the installation files to the same directory, for example /usr/tmp.

Before you start the installation you must uncompress and extract the archive(s). The
example shown here assumes that you have downloaded EasyCopy for Linux and
Solaris to usr/tmp:

$ cd /usr/tmp
$ ls
ec720fp_linux.tar.gz
ec720fp_sun5.tar.gz
$ gunzip ec720fp_*.tar.gz
$ ls
ec720fp_linux.tar
ec720fp_sun5.tar
$ tar xvf ec720fp_linux.tar
$ tar xvf ec720fp_sun5.tar
$
The archives are extracted to a common easycopy subdirectory (/usr/tmp/easycopy in
this example.

Installation Procedure
Go to the directory where the installation files reside (the CD-ROM mount point or the
temporary location where you have unpacked the files you have downloaded), and
start the installation:

$ ./install
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Some systems require that you use capital letters for files on a CD-ROM file system:
$ ./INSTALL

It is important that the install script is started on the command line
from a terminal or console window. Do not click on the script's
icon in a File Manager window, unless your system supports
Common Desktop Environment.

In CDE the required terminal window is opened automatically
when you click the icon, but on other systems you may enter an
infinite loop if you start the script in a wrong context.

Root Access
The install script will first check if you have root access.
You can supply the root password to switch id to root or continue.
You may need root access to complete the installation and to setup printers. You will
normally be able to complete a single-node installation without root access, but if you
want to make a network installation you will normally need root access.

Accept License Conditions
Before you start installation you must read and accept the AGI Conditions of Use.

Install Menu
Next, the install script starts the Install menu.

In most cases you can just accept the default choice ([3]) which will install the
EasyCopy products on your system.
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Choose option [1] to change product component selection before you install. The full
product suite (EasyCopy and EasyCGM) will be installed by default. You will need to
change the selection if you want EasyCopy/Graphics in stead of EasyCGM.
Only choose option [2] if you will copy everything to another destination and install at a
later time. This might for example be the case that you want to copy from the
CD-ROM file system to a file server which has no access to a CD-ROM drive.

Select Platforms
By default your current platform is selected.
You may choose to install binaries for several platforms in one common directory on a
network file server. This is much easier (also when it comes to maintenance) than
installing EasyCopy separately on each workstation.

Available platforms are marked by one asterisk *. Two asterisks ** mark the selected
platforms.
You select or unselect a platform by entering its number. Enter q when you have
selected all desired platforms.

Installation Setup Menu
In this menu you select details of the installation.
Installation Main Directory
This is the path name of the main target directory for the installation. This directory
is referred to in this documentation as the easycopy directory. The default is
platform dependent:
AIX

/usr/lpp/easycopy

Solaris

/opt/easycopy
47

All other systems

/usr/local/easycopy

These defaults are meaningful for a single-node installation.
When you install EasyCopy on a shared network drive there are no "meaningful
defaults" in the sense that it all depends on how you normally organize shared
network installations. Choose a path that fits your conventions. As an example
has /mnt/prod/easycopy been used here.

When you change this directory you will see that the defaults for other paths in this
menu are changed as well to keep the structure consistent.
Invocation Scripts Directory
The installation program creates invocation scripts ("commands") for the graphical
user interface and the command line programs. These scripts prepare environment
variables and call the corresponding binary programs.
Command

Description

Program

Man page

ecx

Graphical User Interface

ecx.bin

ecx(1)

ecview

Image Viewer

ecview.bin

ecview(1)

eccapt

Screen Capture

eccapt.bin

eccapt(1)

ecconv

Image Converter

ecconv.bin

ecconv(1)

ecprint

Print Engine

ecprint.bin

ecprint(1)

eclpd

BSD output filter

eclpd.bin

eclpd(1)

ectcp

Socket output filter

ectcp.bin

ectcp(1)

ecqadm

Print queue administration

ecqadm.scr

ecqadm(1)

eclpq

Print queue status

eclpq.bin

eclpq(1)

ecdaemon

License dispatcher

ecdaemon.bin
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eclic

License display

eclic.bin

The default is /usr/bin. This is a good choice for a single-node installation,
because /usr/bin is always on your path. For a network installation you should
select a shared location which is already on the users' path, or can easily be
appended. As an example has /mnt/prod/bin been used here.
System-wide Initialization File
The system-wide initialization file contains default options as defined by the System
Administrator. The default file name is ecrc and it is by default placed in the
easycopy directory.

System Directory
EasyCopy uses the system directory for printer description files, EasyColor profiles
and other system related files. The default is a subdirectory called system in the
easycopy directory.
Temporary Directory
The programs need to write temporary files. All users must have read and write
permissions to this directory. The default proposal is /usr/tmp. The menu displays
the free space currently available. Refer to the topic disk space for details about
temporary dick space requirements.

Manual Pages Directory
The manual pages listed in the table above (ecx(1), etc.) are copied to the system's
man directory usr/man/man1 or to the directory you specify. You may also decide
not to install the pages.
XkeysymDB File
The keyboard definition is stored in a file, XKeysymDB. Normally, this file already
exists; it is installed when you install X11R5 or X11R6. The file also existed in the
X11R4 distribution, but it was not installed by default. You can choose to install or
update XKeysymDB to the version distributed with EasyCopy. The default is not to
install or update this file.
Install Documentation
EasyCopy documentation (manual in PDF format and online help in HTML format)
will by default be installed in a subdirectory called docs in the easycopy directory.
You can choose an alternate location, or you can choose not to install any
documentation.
Default Paper Size
This option determines whether a US (Letter) or International (A4) paper size will
apply as default when you later install printers.
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Default Mail Server
If you want to send images as email attachments by means of the Send To dialog
your workstation must connect to an SMTP mail server to deliver outgoing mail.
The script proposes the local host (127.0.0.1) as default mail server. Specify host
name (or IP-address) of the mail server that is normally used by mail clients in your
system. The user may change this specification in the Preferences dialog. The
Send To dialog fails if it cannot establish a connection to an SMTP server.

Password Maintenance
You can install your password from the Install menu. You will probably not do this
when you install the first time.

When you have pourchased a license and received the password you can install it by
several methods:

You can go to the easycopy directory, start the install script, and choose option [4]
Password Maintenance.
You can select Password in the Options menu.

If you have made a separate license server installtion you must install the password
both on the license server and on the file or application server from which the users
have access to EasyCopy. This is because you need to make the password available
to the license dispatcher and to create a connection from EasyCopy to the license
dispatcher. (This consideration is not necessary if the license server and the
application server use a common file system).

License Server Installation
If the machine you want to use as license server is the same as the application server
on which you have installed the UNIX version of EasyCopy, or if the license server has
permanent access to the shared network file system, you will not need a separate
installation of the license server.

Just start the license dispatcher by means of this command

# ecdaemon start
Root access required.

Only if your license server has no access to the file system you must perform a
separate installation. You can do that by performing a standard EasyCopy installation
as decribed above locally on the license server.

Environment Variables
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EasyCopy uses the following environment variables. The invocation scripts set the
required environment variables before a program is executed.
HOME
Used to get the user's "home" directory. Each user has private initialization files
stored in the home directory.
This variable is normally already set in the user's login script.
PRINTER
Used by ecprint to get the printer name. Refer to the -printer option.
ECTOPDIR
Used to get the easycopy directory.
ECBINDIR
The location of binary programs. The invocation scripts set this variable.
ECDOCDIR
The location of the documentation (PDF manual). The HTML-based help files
reside in a subdirectory.
ECPRTDIR
The location of the printers directory. You can use this variable to allocate printers
among user groups.
ECWEB
Specifies the path to a Web browser used for online help. The installation
procedure attempts to locate a Web browser and set the correct path in the ecx
invocation script. EasyCopy only requires this variable if neither Netscape Navigator
nor NCSA Mosaic can be found on the normal execution path.
ECPDF
Specifies the path to Adobe Acrobat Reader used for online access to the
documentation. The ecx invocation script contains the correct path if the Acrobat
Reader has been installed as part of the EasyCopy installation or an existing
Acrobat Reader could be located by the installation procedure.
SYSDIR
Used to get the easycopy/system directory.
INIFILE
Used to get the system wide initialization file.
TMPDIR
Used to get the directory for temporary files.
DEFAULT_PAGESIZE
Specifies the preferred default page size (US Letter or International A4). The
invocation script sets this variable based on the preference chosen during
installation.
SCSI_DEST
The destination parameters for a SCSI printer in a Tru64 system. Refer to the topic
SCSI Printers.
XENVIRONMENT
Used to get the application defaults file Ecx.
DISPLAY
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Used to get the display.
Setting Environment Variables
Setting an environment variable depends on the type of shell you are running.
In Bourne shell and Korn shell, type:
$ PRINTER=acme; export PRINTER
$ DISPLAY=ws1:0.0; export DISPLAY

In C shell, type:
$ setenv PRINTER acme
$ setenv DISPLAY ws1:0.0

Copyright © 2003, AGI (autoGraph international), www.augrin.com.
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Starting EasyCopy
The information provided below applies to the UNIX versions of EasyCopy.

Start from a Console or Terminal Window
Make sure that the X Window system is running and start EasyCopy by typing the
following command:
$ ecx &
The & character is advised to ensure that EasyCopy runs as a background process.
You can enter options together with the ecx command.

Automatic Start at System Login
The system administrator can add an invocation of EasyCopy to the system-wide
startup shell script (/usr/lib/X11/xinit/initrc) to make EasyCopy automatically available
to all users. For example, to start EasyCopy automatically in iconic mode the following
line should be added:
$ ecx -iconic &
When EasyCopy is in iconic mode you only see the EasyCopy icon.

The icon label is the name of the selected printer (in this example hp8500_PCL). Click
on the icon to restore the graphical user interface.

If the automatic invocation is not installed globally you can insert the line in your private
X window initialization file ($HOME/.xinitrc).

Run EasyCopy on a Remote Server
If EasyCopy should run on a remote server you can start it from a remote display in
several ways.
Remote Login
You can make a remote login from a terminal window to the server, and then start
EasyCopy by means of the ecx command:
$ rlogin servername
... (login sequence)
$ ecx -display remotedisplay:0.0 &
Remember the -display option! Otherwise the graphical user interface is opened on the
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server s monitor and nothing happens on your display.
Remote Shell Script
A much easier approach than remote login can be established by means of a local
script that you run from the display. Let this script take care of remote login and
correct display setup. Your advantage is that you access EasyCopy as were it a local
application. The only potential drawback is that your local file system is visible in
EasyCopy only if it has been exported and mounted on the server. An example of such
a script for remote use of EasyCopy is given here.
#!/bin/sh
xhost servername
rsh servername ecx -display `hostname`:0.0 $*
Substitute servername with the name of the server on which EasyCopy is installed.
The remote display is automatically substituted for `hostname`.
The script itself may be placed in a shared directory. The system administrator may for
example create the script on a network drive and make EasyCopy available to the
users for which the associated display licenses are purchased by putting the location
on these users path.
EasyCopy will look for your initialization files in your home directory. It is therefore
required that you have a home directory on the server.
You can avoid that the script prompts for a login password if you create an .rhosts file
in your home directory on the server. The .rhosts file tells the server from which nodes
you can login without being prompted for a password.

Start EasyCopy from CDE
You can start EasyCopy from a CDE control panel if this has been defined as an
action. The system administrator can add EasyCopy to the applications available in the
control panel, or a user can add it to Personal Applications.
Icons
The four icons shown here are installed together with EasyCopy (in the icons
directory). To make the icons available on CDE s normal icon path you must copy
them to /etc/dt/appconfig/icons/C (system-wide icon folder) or to $HOME/.dt/icons
(personal icon folder).

ec.t.pm
16x16

ec.s.pm
24x24

ec.m.pm
32x32

ec.l.pm
48x48

If you have the choice between various licenses, for example EasyCopy Silver and
EasyCopy Gold, you need to be able to distinguish between them. For this purpose
there is a selection of icons at disposal:
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Name

Intended usage

ec

General (or EasyCopy Silver if this distinction is required)

ecplus

EasyConvert Plus

ecgold

EasyCopy Gold

ecgraf

EasyCopy with a licensable option for graphics (EasyCGM or EasyCopy/Graphics)

You associate an icon with specific license requirements in the command line
parameters you specify for the command that the icon represents (see step 6 below).
Adding EasyCopy to Personal Applications
To add EasyCopy to your Personal Applications proceed as follows:

55

The action information has now been saved in your $HOME directory.
Next, you must open your $HOME directory in the File Manager in order to add the
action to your Personal Applications:

This completes the configuration of the CDE panel.
Now you can start EasyCopy from Personal Applications in the CDE panel by clicking it
on the menu:
56
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Main Window

When you start EasyCopy you get the Main Window containing a Menu Bar and a Tool
Bar.

When you have opened a file, captured an image, or if you specified an input file when
you started EasyCopy, an Image Display Window is appended to the Main Window.
Image Display Window

The Image Display Window contains the current open file (imported file, screen
capture, or image copied from the clipboard). The window is not present until you open
an image file, make a screen capture, or paste an image.
The displayed image reflects the current settings for color options, stamp options, label
options, rotation, and mirror.

You can select a rectangular area of the image and use the Crop tool if you only
want to work with a subsection of the image (refer to the topic Image Cropping).

General options for the Main window and image display are set in the Preferences
dialog:

Tool bar
The tool bar can be shown or hidden.
Image display
You can view the image scaled or full size. In scaled mode the image is scaled to fit
the width of the Main Window. In full size mode the window is resized to fit the
image. If necessary the window is equipped with scroll bars. You can also choose
58

not to display the image window at all.
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Menu System

The menu bar in the Main Window includes these menus:

File Menu

Open
Close
Montage
Save As
Send
Exit

Edit Menu

Copy
Paste
Crop
Full Image
Rotate
+90
180
-90
Mirror Horizontally
Mirror Vertically
Go To

Capture Menu

Window
Region
Full Screen
Repeat
Quick Print

Options Menu

Printers
Printer Setup
Page Layout
Colors
Capture
60

Hot Keys
Stamp
Label
Preferences
Password

Help Menu

Help Topics
AGI Web Site
License Server
About EasyCopy
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File Menu

The File Menu contains these commands:
Open
This command opens the Open Image Dialog to let you select a file to be opened.

The Open tool

in the tool bar provides the same function.

When you open an image file it is displayed in the Image Display Window. The file
remains open until you do any of the following: open another image file, make a
screen capture, paste an image, or close the file explicitly.

Close
Use this command to close the current image file. The Image Display Window
disappears when the file is closed.

Montage
Open the Montage Dialog to let you add text and simple graphics to the current
image.

The Montage tool

in the tool bar provides the same function.

You can also open the Montage dialog without a current image. The montage
package itself can import images.
Save As
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This command opens the Save Image Dialog to let you export the current image in
any of the supported image file formats.

The Save tool

in the tool bar provides the same function.

Send To
This command opens the Send Attachment Dialog to let you send the current
image in any of the supported image file formats. The file attachment is made by
EasyCopy according to your choice of format and options, and it is sent by means
of your default mail system.

Print
Use this command to open the Print Dialog from which you can print the current
image.

in the tool bar lets you print the current image without opening the
The Print tool
Print dialog. Use this shortcut if you are sure that the image should be printed on
the current printer using the current settings.

Exit
Use the Exit command to terminate EasyCopy. Use the Preferences dialog to
specify what you want to happen with your current parameter settings on exit.
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Edit Menu

The Edit Menu contains these commands:
Copy
This command is only available in the Windows version of EasyCopy.

Use the Copy command to copy the current image to the clipboard in order to
make it available for other applications. You can also copy a selection made by
dragging a rubber band - see the topic Image Cropping for more details. The image
remains on the Clipboard until you copy or cut another selection (in EasyCopy or
another application). The options selected in the Color Options dialog, the Stamp
Options dialog, and the Label Options dialog apply to the copied image.

Paste
This command is only available in the Windows version of EasyCopy.

This command is used to paste an image from the Clipboard. The pasted image
becomes the current image in EasyCopy and replaces a previous image.
Crop
Use the Crop command to complete an image cropping operation.

The Crop tool

in the tool bar provides the same function.

The command is only available when you have used the mouse to drag a rubber
band in the Image Display Window.
You must first drag the rubber band selection; then you decide what to do with the selection (crop
or copy to clipboard).
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Refer to the topic Image Cropping for a more detailed description.

Full Image
Use the Full Image command to undo the result(s) of any previous crop
operation(s). The Image Display Window is redrawn and contains now the original
image (except that color options, stamp options, label options, rotation, and mirror
still apply).

Rotate
You can rotate the image (relative to its current orientation) by +90, 180, or -90
degrees.

A positive angle denotes a counter-clockwise rotation, and a negative angle
denotes a clockwise rotation.

Original

+90

180

-90

Horizontal Mirror
Use this command to mirror the image horizontally.

Original

Mirrorred

Vertical Mirror
Use this command to mirror the image vertically.
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Original

Mirrorred

Go To
This command is available when you have opened an image with multiple pages.
Use the command to open the Go To dialog in which you can specify which page
you want to view.

You can also use the tool buttons Previous Page
page back or forward.

and Next Page

to go one
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Capture Menu

The Capture Menu contains these commands:
Window
Select Window to capture a single window, then click on the window you want to
capture. Click inside the window to capture it without its frame, or click on the frame
to capture the window including the frame (refer also to the topic Capture Types).

You can also configure a hot key, for example CTRL+ALT+W, to initiate Window
capture.

Region
Select Region to capture any rectangular area on the screen, then use the mouse
to drag the rectangular area, and, finally, click the mouse to complete the capture
(refer also to the topic Capture Types).

You can also configure a hot key, for example CTRL+ALT+R, to initiate Region
capture.

Full Screen
Select Full Screen to capture the entire screen (refer also to the topic Capture
Types).

You can also configure a hot key, for example CTRL+ALT+F, to do Full Screen
capture.

Repeat
Use this command to repeat the previous capture operation.
in the tool bar provides the same function. You can also
The Capture tool
configure a hot key, for example F10, to repeat last capture.

Quick Print
Enable Quick Print to make a print with the current settings each time you make a
67

screen capture.

UNIX Capture Modes
Choice of Capture Mode is only relevant for the UNIX versions of EasyCopy.

X Enhanced Mode
The default capture mode is X Enhanced Mode which is used for correct capture of
any visuals controlled by the X Window system. Colors of individual windows are
preserved when you capture the full screen or a region with any combination of
windows. Even when a window appears in pseudo-color on the screen (due to color
map restrictions) it is captured with its original colors.
XWD Mode
For more simple requirements you can use XWD Mode as a faster alternative. The
capture is performed by a system call to the X Window capture program xwd. This
option is dimmed if xwd is not available on the system.
GL Mode on IBM RS/6000
GL capture is available on IBM RS/6000 workstations, but only if the local display is
used. The frame buffer to be captured must also be specified.

Select GL Mode to capture visuals generated by a GL-based application, because
it may contain elements that cannot be seen by the X Window System.
GL Mode on SGI
68

GL capture is available on Silicon Graphics workstations.

Select GL Mode to capture visuals generated by a GL-based application, because
it may contain elements that cannot be seen by the X Window System. Capture in
GL Mode is performed by a system call to the native SGI screen capture program
scrsave, and the captured image is, by default, saved in SGI s RGB format.
OpenGL
If a windows is controlled by an OpenGL application it is captured correctly in X
Enhanced Mode on all platforms.
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Options Menu

The Options Menu contains these commands:
Printers
Use the Printers command to open the Printer Selection dialog to select a printer.

Printer Setup
Use the Printer Setup command to open the Printer Setup dialog from which you
can specify printer setup options.

Page Layout
Use the Page Layout command to open the Layout dialog from which you can
specify how the image is scaled and positioned on the page.

Colors
Use this command to open the Color Options dialog from which you can specify
color options for the image (color mode, background removal, color adjustment,
etc.).

Capture
Use this command to open the Capture Options dialog from which you set options
for screen capture.

Hot Keys
Use this command to open the Hot Keys dialog from which you can configure hot
keys for easy access to screen capture operations.

Stamp
Use this command to open the Stamp dialog from which you can specify a stamp to
be written across the image.
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Label
Use this command to open the Label dialog from which you can specify a label to
be put at the edge of an image.

Preferences
Use this command to open the Preferences dialog in which you can choose among
options for the graphical user interface.

Password
Use this command to enter the password you have purchased.

A valid password is required to upgrade a demo version to a licensed version.
A licensed version is node locked to the computer for which the password is issued.
Installation of password for a network installation should be done by the System Administrator.
It requires write access to the folder in which EasyCopy is installed.
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Help Menu

The Help Menu contains these commands:
Help Topics
Use this command to open EasyCopy's online documentation.
The Help tool

in the tool bar provides the same function.

AGI Web Site
Use this command to open AGI's home page www.augrin.com (if you have access
to the internet). in your default Web browser.
Windows users: EasyCopy will automatically select your default Web browser.

UNIX users: The interface to a Web browser must be configured when EasyCopy is installed.

License Server
Use this command to display the output from the eclic program in a command
prompt window.
Windows 98 and Windows NT 4.0: The command prompt window is limited to 24 lines. If the
message from the license server exceeds 24 lines you will only see the last 24 lines. (This
problem does not exist in Windows 2000 and Windows XP as the command prompt window
has a scrollbar).

UNIX users: This command is not available in the user interface. You may start eclic by typing
the eclic command in a console or terminal window.

About EasyCopy
Use this command to display the About EasyCopy information box.
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About

This dialog contains version and license information.
Click on System Info to get additional information about your system's current state.
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Tool Bar
The most commonly used commands are accessible through the buttons in the tool
bar in the Main Window.

The following tool buttons are available in the Tool Bar:
Open tool
Opens the Open dialog to import a file.
Command equivalent: File | Open
Save tool
Opens the Save As dialog to export an image file.
Command equivalent: File | Save As
Capture tool
Repeats the previous screen capture operation.
Command equivalent: Capture | Repeat
Print tool
Print current image to selected printer with current options (without opening the
Print dialog).
Command equivalent: File | Print | OK
Crop tool
Complete mouse controlled crop operation in the Image Display Window.
Command equivalent: Edit | Crop
Montage tool
Opens the the Montage dialog to let you add text and simple graphics to the
current image.
Command equivalent: File | Montage
Help tool
Opens EasyCopy online help.
Command equivalent: Help | Help topics

If you do not want the toolbar you can disable it in the Preferences dialog.
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Preferences Dialog

The Preferences dialog is used to select options for the graphical user interface. Use
the Preferences command in the Options menu to open the dialog.

Image Display Window
Use this menu to select how the Image Display Window is shown.

Full Size
In Full Size mode the window is resized to fit the image when a new file or capture
is opened. If the image cannot fit within the limitations of the screen size the
window is equipped with scroll bars. You can resize the window by means of usual
windows control, for example by dragging an edge or a corner by the mouse.
Fit to Dialog
In this mode the image is scaled to fit the default width of the Main Window. This is
the default.
Disabled
Select this option if you do not want the image displayed at all.

Show Toolbar
Disable this option to hide the toolbar

Save Settings Automatically
All current settings are saved as personal defaults each time you exit from a dialog, if
this option is enabled. Otherwise, if you want settings to apply beyond the scope of the
current image, they must be saved manually by pressing the Save button in the
corresponding dialog. Refer also to the topic Defaults.
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Scope of Options
Defaults
The default options are merged from two sources:
1. Personal defaults are saved in the system registry. Personal defaults have higher
priority than system and factory defaults.
Whenever you press the Save button in a dialog, your personal defaults are
updated to reflect the settings you have selected in that dialog. If you enable Save
Settings Automatically in the Preferences dialog, all your settings are saved as
personal defaults when you exit a dialog (unless you use exit by pressing Cancel).
The options you select in the Preferences dialog are always saved and apply as
personal defaults. The number of print copies is never saved. It is always reset to
one copy after you have submitted a print job.
2. System defaults are saved in the system registry by the system administrator.
System defaults have higher priority than factory defaults.
3. Factory defaults are built into EasyCopy.
Factory defaults only apply when no information is provided by personal or system
defaults.
Whenever this online help facility refers to an option's default setting, it means the
factory default.

Options
All image related options are reset to their default values each time you open a new
file, make a new screen capture, or paste an image from the clipboard. If you want to
process many images with the same set of options, you should save the desired
options as your personal defaults.
Printer related options and general options are not reset when you open a new file.
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Image File Formats
EasyCopy supports the following image file formats:
BMP
Microsoft Windows or OS/2 image format, version 1, 2, and 3.
Colors

Bilevel, grayscale, color mapped, or RGB.

Compression

Uncompressed or run-length encoded.

Import

All supported modes.

Export

Version 3, uncompressed.

CALS
CALS Raster Type 1 (MIL-STD-1840C)
Colors

Bilevel.

Compression

CCITT Group 4.

Import

All supported modes.

Export

All supported modes.

CATIA
CATIA raster picture format, version 2 and 4
Colors

Grayscale, color mapped, or RGB.

Compression

Uncompressed or run-length encoded.

Import

All supported modes.

Export

Version 4, RGB, uncompressed.

CGM
Computer Graphics Metafile.
Colors

Grayscale, color mapped, or RGB.

Compression

Uncompressed or run-length encoded.

Profiles

ATA, CALS or PIP.

Import

Requires licensable option EasyCGM .

Export

All supported modes (image).

GIF
Graphics Interchange Format, version 87A and 89A.
Colors

Grayscale or color mapped.

Compression

LZW.

Import

All supported modes with the following limitations for GIF 89A:

Multiple frames (animated GIF) are not supported, only the first frame is read.
Transparent background color is not removed.

Export

Version 87A, non-interlaced.

IDEAS
Binary IDEAS picture files.
Colors

RGB.

Compression

None.

Import

Only the raster data part of an IDEAS file is read. No support for raster data in multiple viewports.
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Export

Not supported.

JPEG
ISO international standard 10918, "Digital Compression and coding of continuous-tone
still images". JFIF (JPEG File Interchange Format) is a subset of JPEG. It includes
additional headers implemented as JPEG application markers.
Colors

Gray scale, RGB, YUV. 8 or 12 bits per color (2-16 bits in lossless mode).

Compression

Baseline, sequential, progressive, and lossless modes are supported.

Import

All supported modes.
If a JPEG image embedded in another format (DICOM, NITF, etc) EasyCopy reads the JPEG part correctly, but headers
belonging to the host format are skipped.

Export

All supported modes.
JFIF application markers are inserted if the selected options conform to JFIF.

JPEG 2000
ISO international standard 15444-1, "Information technology
coding system".
Colors

JPEG 2000 image

Gray scale or RGB. 8 per color.

Compression

Reversible and irreversible wavelet compressions are supported.

Import

All valid modes and progression orders.

Export

LRCP progression order, 5 resolution levels.

PBM
Portable Bitmap family of image formats. Includes PGM (Portable Gray Map), PPM
(Portable Pixel Map), and PNM (Portable Anymap). PNM is a common name for any of
the other members of the family.
Colors

Bilevel, grayscale, RGB images (Portable Pixel Map).

Compression

None.

Encoding

ASCII or binary.

Import

All supported modes.

Export

RGB, binary encoding.

PCX
PC Paintbrush format, version 2.5 and 2.8.
PCX Version 3.0 (RGB) is not supported.
Colors

Bilevel, grayscale, or color mapped.

Compression

PackBits.

Import

All supported modes.

Export

All supported modes, version 2.8.

PDF
Adobe Portable Document Format
Colors

Bilevel, grayscale, or RGB.

Compression

Deflate, JPEG, CCITT.

Import

Through Ghostscript filter.

Export

All supported modes (image).

PNG Portable Network Graphics, version 1.2
Colors

Bilevel, grayscale, color mapped, or RGB.
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Compression

Deflate.

Import

All supported modes.

Export

All supported modes.

RGB
Silicon Graphics raster files (SGI).
Colors

Grayscale or RGB.

Compression

Uncompressed or run-length encoded.

Import

All supported modes.

Export

Uncompressed.

Starbase
Hewlett-Packard graphics library.
Colors

Grayscale, color mapped, or RGB.

Compression

None.

Import

All supported modes, except 6-bit images.

Export

All supported modes. Color mapped and grayscale images are written as 8-bit images.

SUN Raster
SUN raster files.
Colors

Bilevel, grayscale, color mapped, or RGB.

Compression

Uncompressed or run-length encoded.

Import

All supported modes.

Export

Uncompressed.

Targa
Truevision raster image format.
Colors

Grayscale, color mapped, or RGB.

Compression

Uncompressed or run-length encoded.

Import

All supported modes.

Export

Uncompressed.

TIFF
Tagged Image File Format, version 6 and previous.
Colors

Bilevel, grayscale, color mapped, RGB.

Compression

Uncompressed, CCITT bilevel encodings (Group 3, Group 4), PackBits compression, LZW compression, and JPEG
compression.

Import

All supported modes.

Export

All supported modes.

XWD
X Window Dump.
Colors

Bilevel, grayscale, color mapped, or RGB.

Compression

None.

Import

All supported modes.

Export

All supported modes.
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Import Filters
EasyCopy can use import filters to extend its range of supported file formats. An
import filter is any program which can detect a file format and convert it to another
(known) file format. If a file is not immediately understood by EasyCopy the filters
apply in the sequence in which they are defined. A number of filters are automatically
configured when you install EasyCopy. These are described below. Your system
administrator may modify these filters or add more filters by editing the filters file.
Filter Definition File
Filters are defined and configured in the filter definition file filters in the
easycopy/system directory. Each line defines one filter by means of three fields:
"detection" "command-line" "description"

The first field describes the file type detection. This can be the "magic word" for a file
format (a short unique sequence of characters in the beginning of the file, for example
"8BPS" which is a unique identifier for an Adobe Photoshop image file. Special
characters in the "magic word" may be specified by their octal code, for example \033
for an escape character.
Some file formats do not have a simple "magic word". They have certain other
characteristics, and EasyCopy is prepared to detect these. Filter definition lines for
these formats contain a reserved word in place of the "magic word".
Strictly, the "reserved word" is first assumed to be the name of an executable program that can do a
safer file detection. If a program of that name cannot be found on the path it is assumed to have the
fixed meaning as described below. However, this feature is not currently used by any of the filters
distributed with EasyCopy.

The following reserved words are known:
*xzASCII

Plain ASCII text file

*xzPOSTSCRIPT

PostScript files

*xzPDF

Portable Document Format

*xzCalcomp

CalComp plot files

*xzCGM

Computer graphics metafiles

*xzHPGL

HP-GL files

*xzGRAPHICS

Any of the three vector formats listed above

The second field contains the command line necessary to convert a file on stdin from
one format to another. This command line program must read from stdin and write to
stdout (if necessary, you must hide the program in a script). You may use environment
variables in the command string. You can also use any of these three symbols:
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%R

Printer resolution (in dpi)

%W

Maximum page width (in points)

%H

Maximum page height (in points)

These symbols are substituted at run time according to the current printer setup.
The third field is a short text string that is displayed next to the preview image in the
Open dialog. If this string is terminated with ".\n" (period, newline) this will terminate
the displayed text. Otherwise a new type (originating from the interpretation of the
converted file) is appended. Include ".\n" if you want the description to be final.
Terminate with a blank if the next type should also be displayed (for example "gzipped
").

Example: (Windows)
If you have a program that converts Adobe Photoshop images to Portable Pixel Map
you can install it as a filter by putting this line in the filters file:
"8BPS" "C:\\Program Files\\My Filters\\pds2ppm.exe" "Photoshop image.\n"

The "magic word" is "8BPS", and the program is invoked as c:\program files\my
filters\pds2ppm.exe.
The above is only an illustrative example. AGI has no knowledge about the availability of any
pds2ppm program.

Default Filter Definitions
The default filter definitions are described under these topics:

Compressed files
EasyCGM (CGM, HPGL)
Ghostscript (PostScript and PDF)
ASCII text
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PostScript and PDF
EasyCopy can read PostScript and PDF files and let you view, print, or convert the
document to an image file.

PostScript and PDF files are opened as other image files in the Open dialog.

tool
and Next
By default the first page is opened. You can use the Previous
buttons to navigate in a multi-page document. You can also use the Go To command
in the Edit menu to open the Go To dialog.
When you open a PS or PDF file in EasyCopy every page you request is converted to raster format.
This is useful when you want to treat the page as an image, and this is exactly the purpose of the
PS/PDF support is EasyCopy.
However, this approach is not very efficient if you just want to browse a document.
You should therefore not expect that EasyCopy can replace a general PDF browser.

EasyCopy uses Ghostscript as a filter to convert PostScript and PDF files into raster
format.
82

The filters are established by the following lines in the filter definition file:
Windows

*zxPDF "\"$ECTOPDIR\\gs\\gs\\bin\\gswin32c.exe\" \"-I$ECTOPDIR\\gs\\gs\\li
;$ECTOPDIR\\gs\\fonts\" -sDEVICE=ppmraw -r%Rx%R -q -dBATCH -dSAFER
E -sOutputFile=- \"%F\"" "PDF\r\n(GhostScript).\r\n"
*zxPOSTSCRIPT "\"$ECTOPDIR\\gs\\gs\\bin\\gswin32c.exe\" \"-I$ECTOPDIR\\gs\
gs\\lib;$ECTOPDIR\\gs\\fonts\" -sDEVICE=ppmraw -r%Rx%R -q -dBATCH
dNOPAUSE -sOutputFile=- -" "(GhostScript).\r\n"

UNIX

*zxPDF "$ECTOPDIR/ecgs -r%Rx%R" "PDF\n(GhostScript).\n"
*zxPOSTSCRIPT "$ECTOPDIR/ecgs -r%Rx%R" "PostScript\n(GhostScript
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ASCII Text Files
EasyCopy includes a filter that implements support for ASCII text files by means of the
of the Text to PS Converter.

The filter is established by the following line in the filter definition file:
Windows

"*xzASCII "\"$ECTOPDIR\\text2ps.exe\"" "ASCII.\r\n"

UNIX

*xzASCII "$ECBINDIR/text2ps.bin" "ASCII.\n"

This filter converts the file to PostScript which in turn is taken through the Ghostscript
filter.

The text2ps program does the conversion to PostScript. It is automatically installed
together with EasyCopy. Refer to the description of the Text to PS Converter for a
more detailed description of the conversion program.

You can also configure the filter to call another converter than the one delivered with
EasyCopy. A popular ASCII converter is the free a2ps available from
www.inf.enst.fr/~demaille/a2ps/.

ASCII to PostScript Conversion
EasyCopy can convert ASCII text files to PostScript and print the resulting file on a
PostScript printer or pass it to a PostScript filter.
The conversion is done by means of the program text2.ps. This program is installed
together with EasyCopy and is by default configured as an import filter in the filters
configuration file.

A file is recognized as an ASCII text file if:
1. At least 80% of the first 1024 characters in the file must be white space
characters (0x09, 0x0A, 0x0C, 0x0D, 0x20) or "normal" ASCII characters (0x20 <
c < 0x80).
2. The file has not been recognized as another file type (PostScript files and some
ASCII based image or graphics formats might otherwise pass the test).
The calling syntax for the converter is:
Windows

text2ps.exe [options] [input]

UNIX

text2ps.bin [options] [input]
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Input File
If no input file is specified the filter reads from stdin.
Options
-aaspect-ratio
You can specify a narrow or wide font by means of the aspect ratio. It is used
as a horizontal scale factor. The default is 1.
Specify -a0.75 to make a narrow text (75% of normal character width).
-eencoding
You can specify the encoding vector for the character set. The default is
IsoLatin1Encoding. The encoding vector must be know by Ghostscript (or the
PostScript printer if you use text2ps to send ASCII files to a printer).
-ffont
You can specify the font to be used. The default is Courier. The font must be
known by Ghostscript (or the PostScript printer).
Specify -fHelvetica -s12 to print in 12 point Helvetica.
-h

Specify this option to display help information on the command line syntax of
the converter.

-llinelength
The maximum line length. The default is 256 characters.
-mmargin
You can specify a margin. It applies to the left, top, and bottom. To the right is
printed as much as allowed by the printable area of the printer. The margin
must be specified in millimeters. The default is 25.4 mm (1 inch).
-n

The noheader option disables a header on each page. By default headers are
enabled.
File: hello_world.c
Page 1

Tue May 25 13:04:43 1999

smith

-ofilename
You can specify an output file (the PostScript file). By default the output goes to
stdout.
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-r

Use the rotate option to specify landscape printing.
The page size (-x and -y options) always refer to portrait orientation of the page.

-ssize
You can specify a point size of the printed text. The default is 10 points.
-xpagewidth, -ypageheight
You can specify the page size. Width and height must be specified in points.
The default is 595 by 842 (this corresponds to A4).
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Graphics Formats
You need the licensable option EasyCGM in order to open these graphics formats:
CGM
Computer Graphics Metafiles, including CGM+, CGM3, and seismic extensions.
HPGL
HPGL and HPGL/2.
On selected UNIX platforms you can use EasyCopy/Graphics as an alternative to EasyCGM.

EasyCGM
EasyCGM is a licensable option for import of graphics file formats ("vector graphics")
into EasyCopy.
EasyCGM allows you to view, print, and convert graphics files in the same way as
image files.
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EasyCGM is installed as an input filter to EasyCopy. You cannot use it independently
of EasyCopy.

EasyCGM is by default automatically installed with EasyCopy and works in demo
mode, unless you buy the additional license.
The program EasyHPGL takes care of HPGL conversion. Note, however, that it cannot operate without
EasyCGM, so that HPGL and CGM is available as one option called EasyCGM.

Filter Definition
Windows

*xzCGM "\"$ECTOPDIR\\easycgm.exe\" -m 10 -dpi %R " "(EasyCGM).
*xzHPGL "\"$ECTOPDIR\\easyhpgl.exe\" stdin" "(EasyHPGL).\r\n"

UNIX

*xzCGM "$ECBINDIR/easycgm.bin -m 10 -dpi %R" "(EasyCGM).\n"
*xzHPGL "$ECBINDIR/easyhpgl.bin stdin" "(EasyHPGL).\n"

These filter definition lines implement support for graphics files in EasyCopy through
EasyCGM.

EasyCGM is installed automatically with EasyCopy, but it runs in demo mode unless
you have a separate license for this option.

CGM Font Mapping
The file alias.fnt (in the easycgm/fonts folder) is used to map font names contained in
the CGM FONTLIST to standard CGM fonts.
The format is simple clear text and can be edited with any text editor. Lines beginning
with '#' are comment lines.
The first non-comment line contains a dummy filename and a list of major words used
in a font matching algorithm. These major words are given a weight 1000 times higher
than other words when a font name is compared to the alias list.
All other lines are comprised of a filename, some white space and an alias string.
For example:
time.fnt

Times_Roman

meaning that a font called "Times Roman" is realized by means of the CGM font
provided in in the file time.fnt (underscores are considered word breaks for matching
purposes).
The default font (if no match can be made) is given by the first font in the list (the
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second non-comment line).
You can edit the file alias.fnt if you need to map additional fonts or change the default. This will
normally require that you have System Administrator rights

EasyHPGL
EasyHPGL is a part of EasyCGM.
Copyright © 2003, AGI (autoGraph international), www.augrin.com.
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Pen Assignment Dialog
The information below applies when EasyCopy uses EasyHPGL (EasyCGM).

Click here here for the corresponding information when EasyCopy/Graphics is used (only available
for selected UNIX platforms).

The Pen Assignment Dialog specifies attributes (color and width) to the pens used in
an HPGL file, either directly or by means of an EasyCopy Pen Profile.
To open the dialog you must select Pen Assignment in the Preferences menu in
Montage. Note, however, that the settings will also apply to HPGL files you open after
you have closed Montage.

There are 256 pens. Pen 0 is always fixed: white (invisible) and a defined width of 0.25
mm. It is not shown. Pen 1, 2, ... 255 can be defined in this dialog and (optionally)
saved in a profile. These pens are shown in the scrollable table in the left-hand sid of
the dialog.
EasyHPGL will use a set of default pens or pen definitions in the HPGL file (if any) as
long as you do not select a Pen Profile and do not change any pens or their order. If
you select a profile or make changes it will no longer take pen definitions in the HPGL
file into account.
Changing the Color of a Pen
1. Select the pen you want to change by pressing the corresponding row in the table.
2. Set the desired RGB values directly in the fields R, G, and B, or press the Colors
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button to open the Color Selection dialog.
3. Yoy will see that the new color is reflected both in the sample to the right of the
RGB values and in the table.

Changing the Width of a Pen
1. Select the pen you want to change by pressing the corresponding row in the table.
2. Type the desired width in millimeters, inches, or points in the Pen Width field near
the right-hand side of the dialog.
3. The width is always displayed in millimeter units in the table.
Changing the Order of Pen Definitions
1. Select the pen you want to move by pressing the corresponding row in the table.
to move the pen up or down.
2. Press the up or down arrow
3. If you move pen number i up it becomes pen number i-1, and the previous pen
number i-1 becomes pen number i.
If you move pen number i down it becomes pen number i+1, and the previous pen
number i+1 becomes pen number i.
Using a Profile
When you open this dialog the first time there is no profile used (the Profile drop-down
menu displays (none).
You may select a profile from the menu. The selected profile will be loaded and its pen
definitions will be shown in the table.
EasyCopy is installed with these predefined profiles:
Autodesk
This profile corresponds to the default settings when an HPGL file is made by an
Autodesk® product like AutoCAD®.
CorelDraw
This profile corresponds to the default settings when an HPGL file is made by
CorelDraw® version 8.
You can make your own additional profiles (refer to Creating new profiles below), or
your System Administrator can make additional profiles available to all users of an
EasyCopy installation.

When such additional profiles exist they also appear in the drop-down list.
Reset All
Press this button to get back to the default state (no profile selected, no pens
changed).
The default pens correspond to the Autodesk profile.
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There is one important difference between choosing the Autodesk profile and the default state: Pen
definitions in the HPGL file itself will only apply in the default state.

Creating New Profiles
1. Press the button Create New to create a new EasyCopy Pen Profile.
2. The following prompt appears:

Type a unique name (as you want it to appear in the profile drop-down menu), and
click OK.
3. You will now have a profile of the specified name, and this new profile will be
selected.
4. Its contents will be the same as the pen definitions you had before you pressed
Create New. If you want to specify further changes you may do so, but they will
only be written to the profile if Save Changed Profile is checked when you exit the
dialog by pressing OK.
The profiles you create will be saved in your home directory. They are thus a kind of
personal settings.
If you are logged on as System Administrator the profiles will be saved in EasyCopy's
system directory, and thus be available to all users.
Saving Changes to a Profile
If you have write permissions to the selected profile (this will normally only be the case
for the profiles you have created yourself) changes in the pen attributes and pen order
will by default be saved when you press OK and exit the dialog.
You can prevent that changes are saved if you disable Save Changed Profile.
The Save Changed Profile is not available if you do have write permission.
Removing a Profile
Press Remove Profile to remove the selected profile. This button is is only available if
you have write permissions to the profile (this will normally only be the case for the
profiles you have created yourself).
Copyright © 2004, AGI (autoGraph international), www.augrin.com.
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EasyCopy/Graphics
EasyCopy/Graphics is only available for selected UNIX platforms.

EasyCopy/Graphics is a collective name for three licensable options from AGI for
viewing and printing of graphics file formats ("vector graphics") by EasyCopy.
Each graphics file format requires a separate license.
You can also use EasyCGM as a filter for CGM and other graphics formats.

Supported Graphics Formats
EasyCopy/Graphics supports the following graphics formats:
CalComp
The full command set for CalComp 906 and 907 plotter controllers is supported.
Commonly used commands for 951 format and PCI format are supported.
HCBS generated CalComp files are supported.
CGM
Computer Graphics Metafiles in binary and character encoding are supported.
HPGL
Almost the full set of HPGL (including HPGL/2) commands are supported. A few
(not commonly used) HPGL commands are recognized, but ignored.
Filter Definition
*xzCGM "$ECTOPDIR/ecgxcgm -resolution %R dpi" "(Ec/G).\n"
*xzHPGL "$ECTOPDIR/ecgxhpgl -resolution %R dpi" "(Ec/G).\n"
*xzCALCOMP "$ECTOPDIR/ecgxcalc -resolution %R dpi" "(Ec/G).\n"

These filter definition lines implement support for graphics files in EasyCopy,
provided that you have EasyCopy/Graphics installed. (It is not installed by default).

Options
EasyCopy/Graphics options can be specified in the Profile Manager dialog and the
Graphics Options dialog.

Differences between EasyCGM and EasyCopy/Graphics
The major differences between EasyCopy/Graphics and EasyCGM are:

The CGM support in EasyCGM includes CGM 3 and seismic extensions.
EasyCGM allows you to convert a graphics file to an image file, for example CGM
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to TIFF. With EasyCopy/Graphics you can only view and print graphics.
A license for EasyCGM includes CGM and HPGL. These formats must be
licensed separately with EasyCopy/Graphics.
EasyCopy/Graphics is only available for selected UNIX platforms. EasyCGM is
available both for UNIX platforms and Windows.
Copyright © 2003, AGI (autoGraph international), www.augrin.com.
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Graphics Options Dialog
The information provided below applies to the UNIX versions of EasyCopy with EasyCopy/Graphics
installed.

The Graphics Options dialog allows you to specify the graphics conversion method
used with EasyCopy/Graphics.

The dialog is opened by the Graphics > Options command in the Options menu.
This command is not present unless EasyCopy/Graphics has been installed.

Choose among:
Metric
Preserve absolute metric as specified or defaulted in the graphics file.
Abstract
The graphics is translated and scaled (up or down) to make maximum use of the
page size within current margins.
Fit
Preserve absolute metric as specified or defaulted in the graphics file, unless
margins are violated, in which case the graphics is translated and scaled down to fit
the page size within current margins.
This is the default setting.
Copyright © 2003, AGI (autoGraph international), www.augrin.com.
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EasyCopy/Graphics Profile Manager
The information provided below applies to the UNIX versions of EasyCopy with EasyCopy/Graphics
installed.

The Profile Manager dialog allows you to specify in detail how you want to interpret pen
attributes (color, line width, etc.) for each graphics file type.

The dialog is opened by the Graphics > Profile Manager command in the Options
menu.

The Profile Manager lets you define and modify profiles. A profile describes the
mapping of pen attributes to a desired form on the output device. The current profile is
later used during raster conversion of the graphics file.
The attributes in the profile normally serve as defaults and are ignored if the graphics
file itself defines these attributes. You may, however, also specify that attributes in the
profile apply unconditionally (Freeze option).
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Select File Type

Use the File type selection menu at the bottom of the dialog to select the graphics type
(HPGL or CalComp) for which you want to specify or modify the profile. By default the
Profile Manager is opened with the most recently activated HPGL profile. Refer also to
the topics Create a New Profile, Modify a Profile, and Activate a Profile.
The Profile Manager does not apply to CGM files; their attributes are always recorded in the file itself
and cannot be modified.

Profile Manager Commands
The dialog contains its own menu bar; it includes a File menu and a Help menu.
File menu

Open
Load an existing profile by means of the Profile Manager's Open dialog:
File type
This field just displays the graphics type (HPGL or CalComp) selected in the
Profile Manager dialog.
Profiles
Displays a list of available profiles for the selected file type. Select one by
clicking on the desired name in the list.
Selection
Displays the name of the selected profile. You may also type the name
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directly into this field.
Save
Save an updated version of the currently opened profile reflecting the current
settings.
Save As
Save the current settings into a profile. The command opens a Save As dialog
(similar to the Open dialog).
You can use Save As when you are creating a new profile or if you want to save
an updated profile under a new name.
Exit
Terminate the Profile Manager. If there are unsaved changes to the current
profile you are asked whether to save the profile.
Help menu
All commands in the Help menu open a Help dialog by which you can browse the
entire help information availazble foir the Profile Manager. The choice of command
in this menu just determines which help page is displayed first.
Create a New Profile
Refer to the topic Modify a Profile if the new profile should be a variation of an existing
profile.

To create a new profile from scratch follow this procedure:
1. Select HPGL or CalComp in the File type menu at the bottom of the Profile
Manager dialog.
2. Use the File | Open command to activate the Open dialog. Type the name you
want to use for the new profile in the Selection box, and press OK. This will create
a new profile which is initially empty.
3. Define the pens you want to assign in the new profile as described in the topic
Using the Profile Manager.
4. Use the File | Save command to save the profile when you have completed pen
definitions.
5. Press the Activate button if you want the profile to be used next time you select a
graphics file of the corresponding type.

Modify a Profile
To modify an existing profile follow this procedure:
1. Select HPGL or CalComp in the File type menu at the bottom of the Profile
Manager dialog.
2. Use the File | Open command to activate the Open dialog. Select the profile in the
Profiles list (or type its name in the Selection box) and press OK. This will prepare
the Profile Manager for this profile, and you will see its pen definitions are now
displayed in the lower part of the Profile Manager dialog.
3. Change the pens you want to modify, remove pens, or add new pens as
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described in the topic Using the Profile Manager.
4. Use the File | Save command to save the profile when you have completed your
modifications, or use File | Save As if you want to keep both the modified and the
original profile.
5. Press the Activate button if you want the profile to be used next time you select a
graphics file of the corresponding type.

Activate a Profile
To activate a given profile to be used next time you select a graphics file of the
corresponding type follow this procedure:
1. Select HPGL or CalComp in the File type menu at the bottom of the Profile
Manager dialog.
2. Use the File | Open command to activate the Open dialog. Select the profile in the
Profiles list or type its name in the Selection box, and press OK. This will prepare
the Profile Manager for this profile, and you will see its pen definitions are now
displayed in the lower part of the Profile Manager dialog.
3. Press the Activate button.
Using the Profile Manager
Pen List
The lower part of the dialog contains a list of the pens defined in the current profile.
The current selected pen definition is highlighted. You can change the pen selection
by clicking a pen definition.

When you open the Profile Manager the pen list reflects the most recently activated
HPGL profile. Refer to the topics Create a New Profile and Modify a Profile if you
want an empty or an alternate profile.

The menus Width and Color in the pen list display are used to control how the pen
list is presented:
Width
Use this menu to select the unit in which pen widths are displayed in the pen list:
mm, cm, or inch. The default is mm; this default is restored each time you enter
the dialog. The choice in this menu does not affect the corresponding menu in the
upper part of the dialog or vice versa; you may display pen widths in other units
than you use to set the attribute.
Color
Use this menu to select the color model in which pen colors are displayed in the
pen list: RGB, CMYK, CMY, or HLS. The default is RGB; this default is restored
each time you enter the dialog. The choice in this menu does not affect the
corresponding menu in the upper part of the dialog or vice versa; you may display
pen colors in another model than the one you use to set the attribute.
Freeze
Use this menu to modify the Freeze options:
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On

Freeze On is set for all pens.

Off

Freeze Off is set for all pens.

Swap

Freeze option is inverted for all pens.

The settings resulting from the Freeze menu are saved in the profile, and are also
immediately reflected in the corresponding check box in the upper part of the
menu. However, if you change the Freeze attribute for a pen by means of the
check box, the change is not reflected in the pen list until you press the Change
button.
Pen Selection
Pen attributes are always managed for one pen at a time (with the Freeze menu in
the pen list display as the only exception). You can select the current pen in a
number of ways:
a. Click on a pen definition in the pen list display.
b. Type the pen number into the field labeled Pen.
c. Increase or decrease the pen number by means of the up and down arrow
buttons to the right of the field labeled Pen.
d. The pen number is automatically increased by one when you press the Add
button. When you press the Remove button the current pen is automatically
changed to the nearest existing lower number.
When you open a profile the default selection is the lowest defined pen number
(usually number 1).
Add a New Pen to a Profile
Do the following to add a new pen to a profile:
1.
2.
3.
4.

Select the pen number you want assigned to the new pen definition.
Modify the pen attributes to the desired settings.
Press the Add button.
The new pen definition is not considered outside the Profile Manager until the
updated profile is saved and activated.

Remove a Pen Definition from a Profile
Do the following to remove a pen definition from a profile:
1. Select the pen you want to remove.
2. Press the Remove button.
3. The pen removal is not considered outside the Profile Manager until the
updated profile is saved and activated.
Changing Pen Attributes
Points to remember:
1. Changes always refer to the currently selected pen when you modify pen
attributes. It is therefore important that you select the pen before you modify
any attributes, otherwise the changes vanish when you change the pen
selection.
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2. The changes are not reflected in the pen list display until you press the Change
button. Otherwise, all changes vanish.
3. The changes are not considered if you save the profile before you have put
them into the pen list by pressing the Change button.
4. The changes are not considered outside the Profile Manager until the updated
profile is saved and activated.
Display
The width and color of the selected pen is shown in a window placed in the upper
left corner of the dialog.
The color of the pen and its break-down into RGB components are shown in a
window to the left of the color control sliders.
This window always shows RGB components no matter what color model is selected in the Color
menu above the window.

Pen Width
You can enter the pen width by typing a number, or you can use the slider to the
right of the field. The valid range is 0 - 2.54 mm (0 - 0.1 inch). The unit for pen
width is selectable from a menu:
mm

Millimeters (default)

cm

Centimeters

inch

Inches

The choice is this menu does not affect the corresponding menu in the lower part
of the dialog or vice versa; you may specify pen widths in other units than you use
in the pen list display.
Pen Color
The color model is selectable from a menu:
RGB

Red / Green / Blue

CMY

Cyan / Magenta / Yellow

CMYK

Cyan / Magenta / Yellow / Black

HLS

Hue / Lightness / Saturation

The choice in this menu does not affect the corresponding menu in the lower part
of the dialog or vice versa; you may specify pen colors in another color model than
the one you use in the pen list display.
The display window below the menu displays break-down into RGB components no matter which
color model you select.

The selected color model defines the interpretation of the three (four) color
components. You can enter the color components directly by typing values into the
corresponding fields, or you can use the sliders to the right of these fields. The
range is 0 ... 255 for all color components and all color models.
Freeze
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The Freeze option checkbox controls how profile attributes are merged with
attributes in the graphics file.
Freeze Off (default) means that attributes for the given pen number in the graphics
file take precedence. Attributes in the profile serve as defaults and are used when
an attribute is not set in the file.
Freeze On means that any attributes for the given pen number in the graphics file
are ignored and in any case replaced by the attributes defined in the profile.
Use the checkbox to change the Freeze option for individual pens. You may also
change the option globally by means of the Freeze menu in the pen list display.
Copyright © 2003, AGI (autoGraph international), www.augrin.com.
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Compressed Files
Compressed files are decompressed on the fly by EasyCopy.

UNIX Compression
This filter definition line implements support for UNIX compressed files (.Z) in
EasyCopy. Files are expanded on the fly, so if you have a compressed image, say
bigimage.rgb.Z, EasyCopy treats it as the corresponding uncompressed file
(bigimage.rgb).
Windows

\37\235 "$ECTOPDIR\\gzip.exe -cd" "compressed\r\n"
Decompression is done by means of the gzip package which is installed as a filter
together with EasyCopy. For further information about gzip refer to www.gzip .org.

UNIX

\37\235 "uncompress -c" "compressed\n"
Decompression is done by means of the uncompress system command.

gzip'ed Files
This filter definition line implements support for gzip'ed files (.gz) in EasyCopy. (.gz is a
commonly used alternative to .Z on UNIX systems).
Windows

\37\213 "$ECTOPDIR\\gzip.exe -cd" "gzipped\r\n"
Decompression is done by means of the gzip package which is installed as a filter
together with EasyCopy. For further information about gzip refer to www.gzip .org.

UNIX

\37\213 "gunzip -c" "gzipped\n"
Decompression is done by means of the gunzip command. It is assumed that you
have installed the gzip package on your system. For further information about gzip
refer to www.gzip .org.

Zip Archives
This filter definition line implements support for zip'ed files (.zip) in EasyCopy. If the zip
archive contains more than one image only the first one is decompressed and opened.
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Windows

\120\113 "$ECTOPDIR\\gzip.exe -cd" "zipped\r\n"
Decompression is done by means of the gzip package which is installed as a filter
together with EasyCopy. For further information about gzip refer to www.gzip .org.

UNIX

\120\113 "gunzip -c" "zipped\n"
Decompression is done by means of the gunzip command. It is assumed that you
have installed the gzip package on your system. For further information about gzip
refer to www.gzip .org.
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Open Image Dialog
The Open Image dialog is used to select and open an image file.

How to open the dialog from EasyCopy
or the Open command in the File menu.
Use the Open toolbutton

How to open the dialog from EasyCopy Montage
or the Open Image command in the File menu.
Use the Open Image toolbutton

The dialog behaves basically like any other "file open dialogs" on your system.
A preview image is included; it displays the image currently selected in the dialog's file
selection box. The preview is interrupted as soon as you select another file. Basic
information about the file is also displayed together with the preview. You may thus use
the dialog as a primitive image browser.
You can preview and open image files in any of the supported image file formats and
any format supported through an installed filter. The latter includes PostScript, PDF,
text files, CGM, and HPGL.
Copyright © 2003, AGI (autoGraph international), www.augrin.com.

105

Multi-page Images
EasyCopy supports multi-page image files in these formats:

TIFF
PostScript
PDF

When you open the file the first page will be selected.

Use the Go To dialog to switch between pages.

You can also use the Previous
document.

and Next

tool buttons to navigate in a multi-page

Copyright © 2003, AGI (autoGraph international), www.augrin.com.
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Go to Page Dialog
Use this dialog to switch between pages in a multi-page image file.

EasyCopy
Open the dialog by means of the Go To command in the Edit menu.

You can also use the Previous
multi-page document.

and Next

tool buttons to navigate in a

EasyCopy Montage
Open the dialog by means of the Go To command in the Image menu.
Copyright © 2003, AGI (autoGraph international), www.augrin.com.
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Image Crop
You can do image crop in three quick steps:
1. Position the cursor at one corner of the area you want to crop;
2. Press the left mouse button, drag the rubber band to the opposite corner, and
release the button.
3. Click the Crop tool to complete the operation.
The cropping does not take place until you press the Crop tool
command in the Edit menu).

(or use the Crop

The tool is dimmed unless a rubber band has been drawn.

The Image Display Window will be redrawn and will contain the cropped area only.
Subsequent commands now refer to the cropped image.
You can get back to the original, uncropped image by means of the Full Image
command in the Edit menu.
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Color Options Dialog
Use the Color Options dialog to set device independent color options. They describe
color changes to the input image.
In many printer setup dialogs and in file format specific dialogs you can select device dependent color
options. These apply to the image after the options specified in the present dialog have been applied.

When you print, save, or send an image you can decide if you want these options
taken into account or not.

Whenever you open a new image (including screen capture and paste from clipboard)
your default color settings apply. This is because color settings you specify for one
image in most cases are irrelevant for the next image you open.
If you need to keep specific color settings for a sequence of images you can use the Save button, and
when you later want to get rid of these settings you can use the Reset button.

You open the Color Options dialog by selecting Colors in the Options menu or by
pressing Colors in one of these dialogs: the Print dialog, the Save As dialog, or the
Send Attachment dialog.
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Color Output Mode
Color
24 bit RGB color mode. This is the default.
B/W
Color and gray scale images are converted to black-and-white (bi-level).
Gray
Color images are converted to grayscale.
8 Color
The image is reduced to eight "pure" colors. These eight colors are red, green blue,
cyan magenta, yellow, black, and white. This option is useful if the image contains
many thin lines.

Remove Backgrounds
EasyCopy can detect and remove up to 5 background colors.
Many screen images are best viewed on a dark background, but when the image is
printed, it is often better to have no background. You save ink, and image details are
often more easily seen (see example).
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Reversal Modes
Color Reversal
RGB colors are inverted (100% becomes 0%, and vice versa) so that the image
looks like a color negative. This can be a useful alternative to background removal
if the image contains may thin lines in light colors.
Gray Reversal
Pure gray scale values are inverted (light gray becomes dark and vice versa).
Colors apart from gray are not changed. This is sometimes useful together with
background removal if lines and annotation is white or light gray (see example).

B/W Reversal
Pure white and pure black are inverted.

Color Adjustment
Brightness
Use this slider to increase or decrease the brightness of the image.
Contrast
Use this slider to increase or decrease the contrast of the image, see example.

Chrominance
Use this slider to increase or decrease the chrominance (color saturation) of the
image.

Tint Balance
Use these three sliders to manipulate the color balance of the image.
Decrease

Slider

Increase

More cyan

Red

More red

More magenta

More yellow

Green

More green

Blue

More blue

The tint balance adjustment can be illustrated as pulling the response curves for R, G,
and B. These curves remain fixed at their endpoints, (0,0) and (255,255), respectively,
so that pure colors never change.
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No adjustment

Changed tint balance

The situation to the right corresponds to these settings:

Saving and Resetting Color Options
Press the Save button to save the current settings of the Color Options dialog as your
own defaults.
Color settings are normally something you adjust individually for each image. We recommend, that
you use the factory defaults (no color transformations) as your defaults, and only save alternate
settings when you occasionally need to keep identical settings for a sequence of related images.

Press the Reset button to reset all color options to factory defaults: output
mode=color, no backgrounds removed, no reversal options, reset all 6 sliders to 0.
Note, that the color options only are saved when you press the Save button in this dialog explicitly.
This means, that if you want to set your own defaults back to factory defaults, you must first press
Reset and then press Save.
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Stamp Options Dialog
Stamp is available with EasyCopy Gold

The Stamp dialog is used to specify the text string and color of a stamp. You open the
dialog with the Stamp command in the Options menu or by pressing Stamp in one of
these dialogs: the Print dialog, the Image Export dialog, or the Send Attachment
dialog.

Administrator lock
Administrator may enable this box in which case the dialog as well as stamp
enabling/disabling becomes unavailable for any other user. (If you are not
Administrator this box is dimmed).
Text
You can enter one line of text that will be used for the stamp.
Color
You can specify any of the eight basic colors or you can specify "Inverse" which means
that each pixel of the stamp is given the inverted color of the original image pixel (see
example below).
Enable Stamp
This switch is enabled automatically each time you enter the dialog. This means that
the Stamp feature by default is actived when you press OK.
You can also activate or deactivate the feature in the Print dialog, the Image Export
dialog, or the Send Attachment dialog.

Example
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You can enable the stamp independently for printing and saving. Refer to the Print
dialog and the Save As dialog, respectively.
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Label Options Dialog

Use the Label dialog to specify the contents and position of a label. You open the
dialog with the Label command in the Options menu or by pressing Label in one of
these dialogs: the Print dialog, the Image Export dialog, or the Send Attachment
dialog.

Administrator lock
Administrator may enable this box in which case the dialog as well as label
enabling/disabling becomes unavailable for any other user. (If you are not
Administrator this box is dimmed).
Text
You can specify one or more lines of text.
You can include environment variables, for example %USERNAME% as shown above.
Position
You can place the label at any of these six positions:
Vertical = Top or Bottom
Horizontal = Left, Center, or Right
Enable Label
This switch is enabled automatically each time you enter the dialog. This means that
the Label feature by default is actived when you press OK.
You can also activate or deactivate the feature in the Print dialog, the Image Export
dialog, or the Send Attachment dialog.

Example
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In this example the label is placed Bottom/Right.

You can enable the label independently for printing and saving. Refer to the Print
dialog and the Save As dialog, respectively.
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Image Scaling
Image scaling as described here applies to viewing and conversion.
The image viewer always uses the Averaging method.
Three different scaling methods are available for conversion. You select scaling
method in the Image Size dialog.

Pixel Replication
This is a fast method. However, it may lead to blocky images for large scaling
factors (example 1).
Interpolation
This method employs bilinear interpolation between four neighboring pixels. This
method is slower than pixel replication. It reduces the blocking by making more
smooth transitions at the expense of sharpness (example 2).
Averaging
This is an alternate interpolation method. It performs anti-aliasing without reducing
the sharpness significantly. It is recommended for downscaling and for scaling of
images containing patterns, for example, images scanned from a printed source
(example 2). Also images with thin lines (example 3) should be scaled using this
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method. For large scaling factors it induces the same blocking artifacts as pixel
replication (example 1).
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Image Dither
View and Save
When an image is displayed or saved and color reduction applies there are two
options:
No shading
Any difference between input and output color is ignored. This may easily result in
"color banding".
Error diffusion
This is the default. Color differences are distributed to the neighboring pixels.
Normally, this results in a substantially better color rendering, although at the
expense of image details; the sharpness becomes slightly degraded.
Each output image pixel is in any case chosen as closely as possible to the input color
of that pixel.

No shading

Error difussion

Print
The information provided below applies to the UNIX versions of EasyCopy.

When an image is printed on a printer which can truly reproduce color intensities (dye
sublimation printer) the methods described above for Display and Save apply.
On any other printer color intensities are simulated by dot patterns. EasyCopy
supports different Shading Methods:

No shading
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This is the fastest shading method; it includes only a threshold operation for each
pixel: if the intensity of a primary color is greater than 50% the dot is set, otherwise
it is not. The method is only recommended for draft output.
Intensity
The intensity distribution method uses error diffusion to record and accumulate the
intensity errors introduced by threshold operations for one dot and compensates for
the error by distributing it to the neighbors.

Intensity distribution is recommended for printing photographic images on ink jet
printers and laser printers; it can often give a better photo-realistic rendering than
screening.
Scatter
This is a proprietary improved error diffusion method in which the placement of
each pixel used to compensate for correct intensity is calculated from a detailed
analysis of all pixels in the neighborhood.
This method is recommended for superb reproduction of photographic images. It is, however, not
available for all printers.

Dithering
Select Dithering to get a dispersed dither shading method: Color intensities are
rendered by means of dither patterns built from dither cells in which the active dots
are distributed evenly over the area to be shaded:

Dither shading is available for 2x2, 3x3, 4x4, 6x6, and 8x8 dither cells. The cell size
determines the number of distinct intensity levels that can be rendered and
represents the tradeoff between sharpness and color depth; the optimal choice
depends on the image contents.
Dither shading is recommended for printers if the dot size is approximately the
same as the dot distance. However, the dot size is often larger than the dot
distance; twice the dot distance is not unusual for high resolution printers. In these
cases dither shading results in excessive color saturation:
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All intensities above ~0.3 give full coverage in this example, so avoid dither shading
when the dots are greater than the distance between dots.
The specified resolution of a printer reflects how accurate a dot can be positioned on the media,
that is, it refers to the dot distance rather than the dot size.

Halftoning
This method is also known as clustered dither. Color intensities are rendered by
means of dither patterns built from dither cells in which the active dots are
clustered as closely as possible over the area to be shaded:

Halftone shading is available for 2x2, 3x3, 4x4, 6x6, and 8x8 dither cells. The cell
size determines the number of distinct intensity levels that can be rendered and
represents the tradeoff between sharpness and color depth; the optimal choice
depends on the image contents.
Halftone shading is recommended for printing drawings and diagrams on printers
with high resolution. The method overcomes the problem of dots being larger than
the dot distance that was mentioned for dither shading.
For low resolution the result of halftoning is a visible raster imposed on the image,
and dither shading is then a better choice.
For photographic images the method can result in unpleasant interferences (moiré
patterns), because all primary colors are rendered using the same grid of dither
cells.
Screening
This method employs rotated clustered dither cells (halftones). By using different
screen angles for each primary color this method avoids moiré patterns. It is
therefore well suited for photographic images on high-resolution printers.
The cell sizes offered by EasyCopy for screening are known as 4x4 and 6x6.
However, these figures are not to be taken literally, they are used for convenience
and express the nearest halftoning equivalent. The true cell size is more complex.
In order to get correct tiling several unit cells are used to compose a macro cell.
The unit cell dimension is not as simple as, say, 6x6; in the example shown below
the side of the unit cell is non-integral, namely = 6.7 pixels.
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Hardware
Some printers have built-in support for color rendering. If you use a hardware
based Shading Method a hardware based Scaling Method must also be used.
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Capture Modes
Choice of Capture Mode is only relevant for the UNIX versions of EasyCopy.

You can select capture mode in the Capture menu or in the Capture Options dialog.

X Enhanced Mode
The default capture mode is X Enhanced Mode which is used for correct capture of
any visuals controlled by the X Window system. Colors of individual windows are
preserved when you capture the full screen or a region with any combination of
windows. Even when a window appears in pseudo-color on the screen (due to color
map restrictions) it is captured with its original colors.

XWD Mode
For more simple requirements you can use XWD Mode as a faster alternative. The
capture is performed by a system call to the X Window capture program xwd. This
option is dimmed if xwd is not available on the system.
Below is shown an example that demonstrates how color map restrictions can
influence a screen capture in XWD resp. X Enhanced Mode:
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XWD mode

X Enhanced Mode

GL Mode on IBM RS/6000
GL capture is available on IBM RS/6000 workstations, but only if the local display is
used. The frame buffer to be captured must also be specified.
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Select GL Mode to capture visuals generated by a GL-based application because it
may contain elements that cannot be seen by the X Window System.

GL Mode on SGI
GL capture is available on Silicon Graphics workstations.

Select GL Mode to capture visuals generated by a GL-based application because it
may contain elements that cannot be seen by the X Window System. Capture in GL
Mode is performed by a system call to the native SGI screen capture program
scrsave, and the captured image is, by default, saved in SGI s RGB format.

OpenGL
If a windows is controlled by an OpenGL application it is captured correctly in X
Enhanced Mode on all platforms.
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Capture Types
You can capture a Window, a Region, or the Full Screen.

Window Capture
To capture a single window, follow this procedure:
1. Select Window in the Capture menu or hit a selected hot key.

2. Move the mouse pointer to the desired window and click a mouse button.
What is captured depends on the way you point at the window.
Point inside the window
Capture window, excluding its frame.
Point at the window's frame
Capture window, including its frame.

Point at the desktop
Capture the full screen.
3. The selected window is captured and becomes the current image in EasyCopy.
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Region Capture
To capture a region (any rectangular area on the screen), follow this procedure:
1. Select Region in the Capture menu or hit a selected hot key.

2. Move the mouse pointer to one corner of desired region and click a mouse button.
3. Move the mouse pointer to the other corner of the region and click a mouse
button.
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4. The selected region is captured and becomes the current image in EasyCopy.

Full Screen Capture
Select Full Screen in the Capture menu or hit a selected hot key. No further action is
required. The full screen is captured and becomes the current image in EasyCopy.
Screen capture in Montage:
Select Capture Window, Capture Region , or Capture Full Screen , in the File menu .
The captured image is inserted on the canvas.

Capture Tool Button
Use the Capture tool (or the Repeat command in the Capture menu) to repeat the
previous capture operation. This is useful when you want to capture the same window
or region a number of times, for example to show the progress of a process in a
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sequence of images. You can also configure a hot key to perform this function.
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Capture Options Dialog

Use the Capture Options dialog to set special options for screen capture. You open the
dialog by selecting Capture is the Options menu.

Delay
You may specify that screen capture is delayed 0 - 60 seconds. This is useful if you
need to change something by means of the mouse before the capture event, for
example, capture a window with an expanded menu.
By default there is no delay.
Occasionally, the system's event handling may initiate the capture event before
EasyCopy's menu has been hidden; this conflict is also resolved by inducing a delay.
Beep
The beep option is enabled to issue a beep before and after screen capture. By default
there is no beep.
Include Cursor Image
Enable this option to include the current cursor image (
image.

, for example) in the captured
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Hot Keys Dialog
Use the Hot Keys dialog to specify hot keys for capture operations.

You open the dialog by selecting Hot Keys is the Options menu.

1.
2.
3.
4.
5.

Select an operation, for example Capture Full Screen;
Hit the key combination you want to use for this operation, for example Ctrl+Alt+F;
Press Assign
Select Enable hot keys;
Press OK

Hot keys give you a flexible tool for easy screen capture. If you also enable Quick Print
your hot key is an efficient Print Screen utility which prints the captured image
immediately on the printer you have selected in EasyCopy.

There are no predefined hot keys; you can assign any key combinations you want.
Do not assign keys which are commonly used for other purposes.
Backspace and Delete cannot be used as hot keys (refer to How to Delete a Hot Key.

Hot key operations are not available while Montage is running.

Capture Full Screen
Capture Window
Capture Region
Repeat Last Capture
These hot key definitions give you equivalents to the corresponding commands in
the Capture menu.
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Hide/Show Menu
You can also assign a hot key to toggle EasyCopy's graphical user interface, so
that the user interface can be hidden. If you want to use EasyCopy primarily as a
screen capture utility, you will only need to have the user interface visible, when
you want to change options, or if you occasionally want to employ some of
EasyCopy's many other functions.
Your selection of hot keys is always saved in your the system registry and will apply as
default next time you start EasyCopy.

How to Delete a Hot Key
You can delete a hot key definition as follows:
1. Highlight the function, for example Capture Region.
2. Hit the Backspace key or the Delete key.
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Automatic Print
Enable Quick Print in the Capture Menu to make a print with the current settings
automatically each time you complete a capture operation (Window, Region, Full
Screen or Repeat).

Quick Print is very useful together with hot keys. You may unmap EasyCopy, and still
have the hot key as a tool for capture and print. This setup gives you an efficient "Print
Screen" button.
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Printer Support
EasyCopy supports all printers installed in your Windows system by means of normal Windows
printer drivers.

Printer Drivers
The information provided below applies to the UNIX versions of EasyCopy.

EasyCopy offers drivers for practically all printers in the market: All PostScript printers,
all common laser printers, ink jet printers, large format plotters, color laser printers,
thermal transfer, sublimation printers. It also provides color profiles for all important
printers to ensure perfect color match. EasyCopy's profiles ensure that you get the
best out of the printer.
The printer support depends on your license:
EasyCopy Silver

EasyCopy Gold

B/W PostScript

All sizes

All sizes

Color PostScript

All sizes

All sizes

B/W Laser

All sizes

All sizes

Color Laser

Up to A4 / Letter

All sizes

Inkjet

Up to A2 / C-size

All sizes

Thermal Transfer

Up to A4 / Letter

All sizes

Dye Sublimation

Up to A4 / Letter

All sizes

SCSI Connection

No

Yes

Printer Support Web Pages
The information provided below applies to the UNIX versions of EasyCopy.

You can find details about support of a specific printer on our printer
support page on www.augrin .com.

Select tha manufacturer, and click on the printer model to get details.
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If you have a Software Subscription Account you can also download the files required
for support of a new printer when support has been added (or updated) after the
release of the EasyCopy version you have installed.
In some cases new printers require new or updated printer drivers in which case you may need to
upgrade to a newer version of EasyCopy.

Generic Printer Drivers
The information provided below applies to the UNIX versions of EasyCopy.

EasyCopy also provides generic printer drivers. They are mainly used for three
purposes:
1. Support of new printers until support files for explicit support become available.
2. Support of older and less common printers which may be lacking explicit support.
3. Troubleshooting if you experience difficulties or unexpected results with the normal
support.
These generic dirvers are available:
PostScript
Encapsulated PostScript Level 1
Supports any PostScript level 1 printer at a resolution of 300 dpi. The page size
is not specified.
PostScript Level 1 (small pages)
Supports any PostScript level 1 printer at a resolution of 300 dpi and these page
sizes: ISO A4, Letter (A.size), and Legal.
Generic PostScript Level 1 (medium page sizes)
Supports any PostScript level 1 printer at a resolution of 300 dpi and these page
sizes: B-size and ISO A3
Encapsulated PostScript Level 2
Supports any PostScript level 2 printer at resolution up to 1440 dpi and a
selection of page sizes, including custom page size.
Generic PostScript Level 2
Supports any PostScript level 2 printer at a resolution of 300 dpi and a selection
of page sizes, including custom page size.
Generic PostScript Level 3
Supports any PostScript level 3 printer at a resolution of 300 dpi and a selection
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of page sizes, including custom page size.
PCL
General PCL driver for PCL printers that support scaling in hardware.
Supports 300 and 600 dpi and common paper sizes.
Special driver optimized for PCL 5 color printers.
Supports 300 and small paper sizes.
RTL
Requires EasyCopy Gold

General RTL driver for large format plotters.
Resolution 300 dpi. Common plotter page sizes.
Special RTL driver for large format plotters that support hardware scaling.
Resolution 300 dpi. Common plotter page sizes.
CGM
Requires EasyCopy Gold

Abstract scaling
Generic CGM driver, 300 dpi.
Metric scaling
Generic CGM driver, 300 dpi.
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Adding Support for New Printers
The information provided below applies to the UNIX versions of EasyCopy.

Add Support for a New Raster Printer
To make a newly released raster printer (non-PostScript) available to EasyCopy you
need an EasyCopy Printer Description file (EPD file) from AGI.
Free download of printer support files is only available for customers with Software Subscription
Service.

Copy the EPD file to the easycopy/system directory, for example:
# cp acme8001.epd /usr/local/easycopy/system/.

The new printer is then automatically included in the Printer Type list in the Add Printer
dialog. If the manufacturer is not already represented it is also added to the
Manufacturer list. EasyCopy support for the new printer can now be added as
described in the Add Printer dialog.

If an EPD file is not available you can in many cases get the printer supported by
means of a generic EasyCopy printer driver.
Add EasyColor profile for a Raster Printer
If EasyColor support is not installed from the original EasyCopy distribution you can
add it later when it becomes available.

To add EasyColor support for a non-PostScript printer you need to install one or more
color profile data files (these files have extension .cxr) and an updated EPD file. These
files are copied to the easycopy/system directory. When the files have been installed
you can reinstall the printer with EasyColor support by proceeding as described in
Associate a Print Queue with Another Printer.
Free download of printer support files is only available for customers with Software Subscription
Service.

Add Support for a New PostScript Printer
To make a newly released PostScript printer available to EasyCopy you need a
PostScript Printer Description file (PPD file). The PPD file must be compliant with
Adobe PPD standard version 4.0 or higher. The PPD file is normally provided by the
manufacturer and shipped with the printer. Copy the PPD file to the easycopy/system
directory, for example:
# cp acme9001.ppd /usr/local/easycopy/system/.

The new printer is then automatically included in the Printer Type list in the Add Printer
dialog. If the manufacturer is not already represented it is also added to the
Manufacturer list. EasyCopy support for the new printer can now be added as
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described in the Add Printer dialog.

If it is not clearly indicated in the printer's documentation where you find the PPD file,
try to locate it on the media containing the Microsoft Windows printer driver, if one is
provided (the file has the file name extension .ppd). Otherwise, refer to the printer
manufacturer for information on how to get the latest version of the PPD file.
In many cases the PPD file is packed together with printer driver and other programs
on the media, and you have to install the driver on a Windows PC before you can get
the PPD file.

If a PPD file is not immediately available you can get the printer supported as a generic
PostScript printer.
Add EasyColor profile for a PostScript Printer
If EasyColor support is not installed from the original EasyCopy distribution you can
add it later when it becomes available.

To add EasyColor support for a given printer you need to install one or more color
profile data files (these files have extension .cxr) and a PPE file to supplement the
PPD file. These files are copied to the easycopy/system directory. When the files have
been installed you can reinstall the printer with EasyColor support by proceeding as
described in Associate a Print Queue with Another Printer.
Free download of printer support files is only available for customers with Software Subscription
Service.
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EasyColor
Windows printer drivers will normally include ICM or ICC color profiles which can be used to
ensure optimal print quality. The best results are often obtained by means of the manufacturers'
defaults.

The information provided below applies to the UNIX versions of EasyCopy.

EasyColor is AGI's proprietary color matching system. A frequent problem in color
printing is that the color gamut of the printer (the range of colors it can reproduce) is
not the same as the range of colors in the image. This problem is illustrated by this
figure:

Another problem is originates from the non-linear response of inks and dyes.
Normally, you will consider the image on your screen to be the "correct" representation
of that image. Color matching, thus, serves the purpose of mapping the colors of the
screen image into printer colors as good as possible within the limitations of the gamut.
EasyCopy is distributed with EasyColor profiles for the majority of the supported
printers. A profile is a complex set of parameter values that are used for the mapping
of image colors into printer colors.
Each profile is only usable under specific conditions. A profile for plain paper does not
apply to coated paper or transparencies; a profile for 360 dpi does not apply to 720
dpi; a profile for one halftone screening does not apply to other screenings, etc.
A small logo is shown in the Appearance section of the Printer Setup dialog when
EasyColor profiles are available for a printer.
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Print Dialog

Use the Print dialog to print the currently open file. You open the Print dialog by means
of the Print command in the File menu.
You can bypass this dialog and use the Print tool
in one click.

to print the current image on the current printer

The dialog displays the current printer, the current image, and the page size.
A preview image shows how the image will be printed. The preview reflects the
orientation, position, and scale of the image on the page.
The preview also reflects color options, stamp options, label options, rotation, and
mirror.

The image is shown in gray scale if a monochrome printer is selected.
Printer
This is the printer you have selected. Your default Windows printer is automatically
selected when you open the dialog. You can select any printer you have defined in
your Windows system.
Multiple Copies
Specify the number of copies you want. One copy is the default.
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The number of copies is always reset to one copy each time you open the Print dialog.

Print to File
Enable Print to File to direct the printer data stream to a file in stead of creating a print
job. You get a standard Save dialog when you press Print; this allows you to specify
directory and filename.
You can use Print to File if you want to save the image in the file format supported by
the printer, for example PostScript or RTL.
Use the Image Export dialog rather than Print to File to save an image as a device independent CGM
file or as a PDF file.

Printer Setup
Press Printer Setup to open the Printer Setup dialog in which you can select printer
specific options (paper size, media type, input tray, print quality, color correction, etc.).
The Printer Setup dialog is part of the printer driver you use for your printer.

Page Layout
Press Page Layout to open the Page Layout dialog in which you can specify how the
image is scaled and placed on the page.

Colors
Press Colors to open the Color Options dialog in which you can specify device
independent color modifications to the image.
You can suspend these color modifications by means of the check box next to Colors.

Stamp
Press Stamp to open the Stamp Options dialog in which you can specify a stamp to be
written diagonally across the image.
You can suspend the stamp overlay by means of the check box next to Stamp.

Label
Press Label to open the Label Options dialog in which you can specify one or more
lines to be written as a label near the edge of the image.
You can suspend the label by means of the check box next to Label.

OK
Press OK to start the print job and close the dialog.
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Printer Selection Dialog
Use the Printer Selection dialog to select a printer. You open the dialog as follows:
EasyCopy
The Printers command in the Options menu.
Montage
The File > Printers command.

Windows
The information provided here refers to the Windows version. The dialog has a different look in
the UNIX versions.

The dialog displays the current printer and its paper size selection.
You can also select printer directly from the Print dialog.

Printer
This is the printer you select. Your default Windows printer is automatically selected
the first time you open the dialog. You can select any printer you have defined in your
Windows system.
Printer Setup
Press Printer Setup to open the Printer Setup dialog in which you can select printer
specific options (paper size, media type, input tray, print quality, color correction, etc.).
The Printer Setup dialog is part of the printer driver you use for your printer.

UNIX
The information provided here refers to the UNIX versions. The dialog has a different look in the
Windows version .
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Use the Printer Selection dialog to select printer. You can open the dialog by selecting Printers in the
File menu, by selecting Printers in the Options menu, or by pressing Printers in the Print dialog.

Select a Printer
To select a printer from the list you must highlight it (click on it) and press OK.
All Printers or Short List
Enable List All Printers to see a list of all printers installed by the System Administrator. Any printer you
select from the full list will be included in your short list.

Disable List All Printers to see your short list. This is the default, so the first time you open the dialog
you must first list all printers and make your selections to create a short list.
To remove a printer from the short list you must highlight it and press the Remove button.

The System Adminitrator has no short list. If you have root access you always have all printers
listed.

Use System-wide Defaults
Enable Use System-wide Defaults to reset all options for the printer you select. Your previous defaults
for the printer will no longer exist.
All options for the printer are created the first time you select a printer by copying the system-wide
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options set by the System Administrator. Alternate, private defaults are created any time you press the
Save button in the Printer Setup dialog.

Add

System Adminitrator
Press Add to open the Add Printer dialog which allows you to install new printers and create print
queues.

The Add button is dimmed unless you have root access.
Remove
Press Remove to remove the highlighted printer from your short list.
The Remove button is dimmed if you have enabled List All Printers.

System Adminitrator
Press Remove to open the Remove Printer dialog which allows you to remove printers and print
queues.

Status
Press the Status button to get a display of the print queue status for the selected printer.
The detailed format of the status display depends on the platform and system you are using (the
commands lpstat or lpq are used to build the the status part of the display). Here is shown an
example:

Utilities
Press Utilities to open the Printer Utilities dialog. This button is dimmed if there are no utilities available
for the highlighted printer.

Test
Press Test to send a test page to the highlighted printer. This button is dimmed if the printer is not a
PostScript level 2 or 3 printer.
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The test page provides an easy method to verify the printer's connection. You can use it in
trouble-shooting situations: if you cannot print the test page you have a clear indication, that the
problem is related to the printer connection
OK
Press OK to exit the dialog. The printer that is highlighted at the time you press OK becomes the
current printer.
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Printer Setup Dialog
EasyCopy
Select the Printer Setup command in the Options menu or press Printer Setup in
the Print dialog.
EasyCopy Montage
Select the Printer Setup command in the File menu or press Printer Setup in the
Print dialog
EasyCopy uses the normal Windows printer drivers. The Printer Setup Dialog is unique for each
printer as it is a part of the printer driver. It is therefore not documented here. Refer to your
Windows or printer documentation.

The information provided below applies to the UNIX versions of EasyCopy.

The Printer Setup dialog is used to set printer specific options. The available options
are not the same for all printers. The options, their possible values, and constraints
between choices are defined in the printer description file by which the printer is
supported. Options are divided into three groups:
Paper
Describes media and media handling;
Appearance
Describes color and print quality;
Features
Describes other options for a given printer.

The dialog is divided into three "tabs" that correspond to this classification of options.

The System Administrator has a fourth tab for modification of Installable Options.

Only one of these groups is visible at a time. You switch to a given group by pressing
its "tab".
The buttons in the bottom of the dialog are common for all three tabs:
OK
Press OK to accept the selected options and close the dialog.
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If you have enabled Save Settings Automatically in the Preferences dialog the
selected options are saved in your initialization file and will apply as default next
time you start EasyCopy. Otherwise, the selected options only apply for the current
session of EasyCopy, unless you press Save.

Cancel
Press Cancel to close the dialog without changing any options.
If you press Save and then Cancel your defaults have been changed, but your
current settings remain unchanged.
Save
Press Save to save the selected options as defaults in your initialization file.
The button is dimmed if you have enabled Save Settings Automatically in the
Preferences dialog. In this case options are are always saved when you press OK.

Paper Options
Paper options and their possible values are specific for each printer. Page Size,
Source, and Media Type are commonly used paper options.
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Page Size
This option is always present. It allows you to select the media size. Typical values
are Letter, A4, etc.
This option defines the dimensions of the media itself. The maximum printable area is smaller.
The absolute margins that limit the printable area for a given page size are shown in the Layout
dialog.

If the printer supports custom definition of the page size you can choose Custom in
the Page Size menu. This will open the Custom Page Size dialog.

Source
This indicates the media source (input tray). Typical values are Upper Tray, Lower
Tray, Manual Feed, etc.
Media Type
Typical values are Plain Paper, Coated Paper, Transparency, etc. The choice of
media type may influence the availability of EasyColor options, because EasyColor
profiles are not necessarily provided for all possible media.
Some printers combine the choice of input tray and media type in the Source option.

Appearance Options (Color and Quality)
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Added Saturation
This slider fine adjusts the color correction of image files provided by the EasyColor
profile. It represents the tradeoff between reproducing a correct saturation and a
correct hue in the printed color image. The slider is dimmed if EasyColor has been
disabled or is not available.

Maximum Added Saturation (100) means that the saturation is as correct as
possible. On printers with a poor gamut range this is obtained at the expense of the
hue of highly saturated colors. Minimum (0) means that the hue is as correct as
possible. Depending on the printer's gamut range this obtrudes poorly saturated
(pale) colors. On most printers the default (50) results in a fair compromise
between correct hue and correct saturation.
Decrease Added Saturation to compensate for dot gain on a printer with high
resolution and good gamut. This gives a better reproduction of photographic
images.
Increase Added Saturation if you print drawings and charts, especially if your
printer has low resolution.
Blue Adjustment
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This slider is used to fine adjust the reproduction of blue colors with EasyColor. You
can reduce green or purple, depending on which compensation is necessary for
your printer.

Blue is the most difficult color to reproduce correctly on a printer. It may happen
that identical printers produce different blue colors from the same input. It may also
happen, that the blue changes dramatically after you have replaced the ink or dye
supply. In a few cases a printer can be so sensitive, that one image may print with
fine colors and another one, almost identically, may print with all blue shades tilted
towards green or purple.
Gamma
Use this slider to brighten or darken your printed images. High values give dark
images.
The gamma value refers to the monitor's response curve. The image you see on
the screen is affected by the non-linear response curve. This must be taken into
account when a similar image should be printed.

The default is 2.20, except on Silicon Graphics workstations, where it is 1.70.
These values reflect the most common system defaults.
You may need to adjust the value when you exchange image files between
platforms.
Resolution
This menu is used to select resolution if the printer supports different resolution.
However, the field is present (to give you resolution information) even if the printer
only supports one resolution.
A few printers use different printer description files for different resolutions. EasyCopy will
consider this as two (or more) different printers.

Print Quality
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This menu is used to set specific combinations of other quality options to produce
either Presentation or Draft quality. The menu is present if such combinations are
defined in the printer description file. Normally, these quality settings refer to
Shading Method and Scaling Method.
Choose Presentation to obtain the best quality. This is normally also the most time
consuming printing method.
Choose Draft to obtain the fastest printing method.
Choose Customized if you want to set your own combination of quality options.
Scaling Method
The scaling method determines how an image is resampled when it is printed.
Resampling is required unless the image size (in units of dots) is exactly the same
as the input image.
The scaling methods are Replication, Interpolation, and Averaging. These are
described in the topic Image Scaling.

You can choose scaling method only if Customized Print Quality is selected. With
Draft or Presentation it is chosen automatically.
If scaling is done locally in the printer (PostScript printers) this option is not present.
Shading Method and Shading Matrix
The shading method (together with a shading matrix) determines how the printer
driver renders color intensities. Shading Method and Shading Matrix are not
present if shading is done locally in the printer (PostScript printers), or if the printer
can vary the dot size to reproduce the desired color intensity without using raster
patterns to render the color (dye sublimation and variable dot ink jet printers).
You can choose shading method and matrix only if Customized Print Quality is
selected. With Draft or Presentation it is chosen automatically.
The available methods are described in the topic Image Shading.

Printer Features
The tab labeled Features includes those printer setup options that do neither belong to
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Paper nor Appearance.

Mirror
This option enables a horizontal mirror of the printed image.
Data Encoding
This option is available for PostScript printers. It specifies the encoding of binary
data (image data) in the Post-Script output file. The default is Auto Select. This
means:

If the printer supports binary data, and binary data can be sent over the
printer's connection, binary data are not encoded. This provides the most
efficient data transfer.
If these conditions are not fulfilled, binary data are encoded by means of the
ASCII-85 encoding scheme defined in PostScript level 2.

You may select ASCII in the menu to force ASCII-85 encoding. This can be useful
for troubleshooting if the printer produces unexpected output.
Compression
If a non-PostScript printer supports various compression schemes these can be
selected from a menu.
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LZW Compression
This option is available for PostScript level 2 and 3 printers. It specifies that the
PostScript output file should be LZW-compressed before it is sent to the printer.
LZW compression speeds up the printing of large files over slow I/O ports.
The LZW option is on by default, unless the printer is connected via TCP/IP (this
connection is usually so fast, that the overhead induced by compression and
subsequent decompression in the print engine exceeds the gain in download
speed).
PostScript input files:
LZW compression applies to the entire input file, but the PostScript header
provided by ecprint is not compressed.
Raster images:
LZW compression applies to the bitmap image data (after JPEG Compression,
if both are specified).
LZW Mode
This option menu is available if LZW compression has been enabled. It is used to
determine if the "prediction mode" of the LZW algorithm is employed; the
performance is usually much better in prediction mode, but not all printers support
it.
Auto Select
Prediction is used if the printer supports it.
No Predictor
Forces prediction off.
Predictor
Forces prediction on.
Prints are corrupted if Predictor is enabled and the printer does not support it. It may happen
that EasyCopy's method to detect predictor support fails. In this case you must force No
Predictor to get correct results.

JPEG Compression
This option is available for PostScript level 2 and 3 printers. It specifies that a raster
image file should be JPEG compressed. This option is off by default. The box is
dimmed if the file is a PostScript file.
JPEG compression employs DCT (Discrete Cosine Transform) encoding. This is a
lossy compression method, in which the maximum compression is achieved, but
with a possible compromise in image quality. It normally yields a higher
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compression than LZW, which is a lossless compression.
You may select both LZW and JPEG Compression, but LZW only improves the compression
marginally, or even cause the resulting file to expand slightly, compared to selecting only JPEG
Compression. The same may happen if LZW Compression is specified for a file that is already
compressed, for example a PostScript file containing a compressed image.

JPEG compression operates on continuous-tone images with one or three
components (gray level or color). Indexed images are automatically expanded to
RGB before JPEG compression. The grade of compression is controlled with the
Quality slider.
JPEG Quality
The grade of JPEG compression is controlled with the JPEG Quality slider.
The maximum compression is achieved but with a possible compromise in image
quality.
The size of the file and the image quality are traded off. The slider can be set
between 1 and 20. A quality of 1 (leftmost slider position) gives the highest
compression at the expense of image quality. A quality of 20 (rightmost slider
position) gives the highest image quality and a lower compression.
The compression ratio depends on the contents and size of the original image.
Results in the range from approximately 50 : 1 (low quality) to 10 : 1 (high quality)
can normally be expected.
Copyright © 2002, AGI (autoGraph international), www.augrin.com.
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Layout Dialog
Use the Page Layout dialog to specify orientation, position, and scale of the current
image when it is printed on the current printer. You can also select Rotation and Mirror
of the image.

The dialog is opened when you select Page Layout in the Options menu or if you press
Page Layout in the Print dialog.

You can also open the dialog from the Montage dialog to set layout properties for a
single image object.

Orientation
Landscape
Horizontal axis along the long paper edge.
Portrait
Horizontal axis along the short paper edge.
Best Fit
Let EasyCopy determine the best orientation from the aspect ratio of the input
image. This is the default.
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The maximum image size depends on the orientation.
Best Fit is the orientation that gives the largest image.

Rotation
You can rotate the image 90 degrees relative to its current appearance (you can also
rotate the image in the Edit menu).

By default a counter-clockwise rotation applies. Use the check box Clockwise to force
a clockwise rotation.
The Rotation option refers to the image, whereas the Orientation option refers to the paper. Note,
however, that the paper will follow the rotation if orientation is Best Fit.

To rotate the image 180 degrees you cain either click twice on Rotate 90 or you can
mirror the image horizontally and vertically.

Mirror
The mirror functions available in the Edit menu are also available in this dialog.

Click on Horizontal Mirror to mirror the image horizontally, or click on Vertical Mirror to
mirror the image vertically. (click again to get back to the previous appearance).

Position
By alignment
Horizontal
Left
Center
Right
Vertical
Top
Center
Bottom
You can specify a relative position of the image on the page by means of Horizontal
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and Vertical alignment (alternatively, you can specify an absolute position - refer to
Offset below).
Left, Right, Top, and Bottom alignment refer to the printer's margins (the printable area). Center
alignment, however, refers to the center of the page. This is not necessarily the same as the center of
the printable area. This implies that the maximum scale factor normally is less than 100% if you
choose Center alignment.

By offset
You can specify an absolute position of the image on the page by entering the
coordinates of the top left corner (alternatively, you can specify a relative position refer to Alignment above).

If you type an offset value, which is out of range, or in combination with the current
image size would cause (parts of) the image to be positioned outside the printable
area, the offset is changed to the alignment that best fits the intended offset.

Unit of Measurement
Choose among these units:
Inches
Millimeters
Points
We define a point "the PostScript way", namely 1/72 inch. This is almost the same
as a traditional "typographical" point.
Dots
This will give a measure in units of dots for the currently selected printer.

Scale
You can specify the size or scale of the printed image in different ways:

Explicit dimensions
Scale relative to page size
Pixel scale
Metric scale

Width, Height
Type the absolute size of the printed image (in the selected units).

If you change Width or Height when Maintain Aspect Ratio is enabled the other is
automatically updated.
Scale Slider
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You can specify the relative size of the printed image as a percentage of the
maximum size.
The maximum size (100%) is defined as the largest size you can get within the
printable area for the given orientation and aspect ratio. This is the default image
size.
Use the slider to specify a smaller scale.
Pixel Scale
You can specify the scaling of the image be specifying the number of printer dots
per input pixel. This is called pixel scale. You can use this to control the image size
relative to the image displayed on the screen.
Example:
An image of 340 x 252 pixels displayed on a screen at 75 dpi occupies 4.53 x 3.36 inches (or 115
x 85 millimeters). To print it at the same size (4.53 x 3.36 inches) on a 600 dpi printer you can
specify pixel scale 600/75 = 8.

Metric Scale
Some image file formats support metric size information, for example in terms of a
resolution (pixels per inch). If metric size information is available you can specify
the size of the image as a metric scale factor.
1:1
Fit

Press this button to get 1:1 metric scale.
Press this button to get best relative fit (100% on the slider).
Metric scale options are only available if the input file contains metric size information. If you
specify a metric scale that exceeds the page size the image is clipped.

Aspect Ratio
The image is by default printed in the original aspect ratio. If you want to stretch
the image you must
1. Disable Maintain Aspect Ratio.
2. Specify image size explicitly (Width and Height).
Maintain Aspect Ratio is automatically restored if you change the image size by
means of Scale or Pixel Scale.

Margins
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All printers have a "dead zone" around the edges where you cannot print. These
margins constitute the printable area.
The margins impose limits on the image position and size. No part of the image can be
outside the margins. Enable Show Margins to include the outline of the margins in the
preview window.
Copyright © 2003, AGI (autoGraph international), www.augrin.com.
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Printing Models
The information provided below applies to the UNIX versions of EasyCopy.

A printer and print queue connected to EasyCopy can be configured in a number of
different ways. The corresponding printing models are described in the following.
EasyCopy distinguishes between print queues created by EasyCopy itself and other
print queues. If a print queue is created by EasyCopy it uses ecprint as a filter.
Direct processing can work with both types of print queues.

Print queue processing requires that the print queue is created by EasyCopy.

Direct Processing

Direct processing means that the input file is processed be ecprint instantly on the
local host, and the resulting output file in the appropriate printer format is sent to the
print queue, and queued for printing.

Print Queue Processing
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Print queue processing means that ecprint is installed as a filter in the print queue, so
that the input file is sent to the print queue, and the output file in the appropriate printer
format is generated in the print queue.
The advantage of direct processing is, that the print queue need not be an EasyCopy
print queue; it can be established by other procedures, and it can be used by other
applications. Use direct processing if it is essential to manage the print queue by
another tool than EasyCopy.
The disadvantages compared to print queue processing are the following:

Direct processing normally requires more disk space for spooling than print queue
processing.
Direct processing must be performed on the local host; print queue processing
may offload the work to a remote server.
Direct processing requires resources immediately, whereas print queue
processing may run as a background task with lower priority.
Any file in one of the supported formats, for example a TIFF file, may be sent to
print queue processing by using the lp or lpr command. In the case of direct
processing each file must be sent individually from the Graphical User Interface or
by explicit use of the command line interface for ecprint.
Copyright © 2003, AGI (autoGraph international), www.augrin.com.
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UNIX Printer Installation Summary
The information provided below applies to the UNIX versions of EasyCopy.

Add a Printer and Create a New Print Queue
Add a Printer and Use an Existing Print Queue
Remove a Printer and its Print Queue
Remove a Printer Only
Associate a Print Queue with Another Printer
These functions are only available to the System Administrator.

Add a Printer and Create a New Print Queue
To add a new printer and create a new print queue when you have started ecx as
System Administrator, follow this procedure:
1. Check if a printer description file is available with EasyCopy. For a newly released
printer you may need to install an appropriate printer description file before you
can inswtall the printer. Refer to the topic Adding Support for New Printers.
2. Prepare in advance your notes about any optional features installed on the printer,
and any information you will need for specifying the correct parameters for printer
connection; also decide on printer utilities, and prepare the UDF file, if appropriate.
3. Select Printers command in the Options Menu.
4. Press Add in the Printer Selection dialog; this brings up the Add Printer dialog.
5. Press Create New Queue; this brings up an xterm window with ecqadm invoked
for the choice "create a print queue".
6. Proceed as described in the topic Create a Print Queue. The xterm window closes
when you terminate ecqadm.
7. You are now back in the Add Printer dialog. Select a printer from Manufacturer
and Printer Type, update Description and other information if desired, and make
your selections of Installable Options.
8. Press OK to write a system-wide initialization file for the new printer, and return to
the Printer Selection dialog.
9. Press the Test button in the Printer Selection dialog (if available) to send a test file
to the print queue. Verify that the file is printed correctly; this confirms that a
trouble-free connection has been established.
10. Optionally, set and save system-wide defaults in the Printer Setup dialog and
Layout dialog.

Add a Printer and Use an Existing Print Queue
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To add a printer that uses an existing print queue follow this procedure:
1. Check if a printer description file is available with EasyCopy. For a newly released
printer you may need to install an appropriate printer description file before you
can inswtall the printer. Refer to the topic Adding Support for New Printers.
2. Verify that the new printer can be used with the connection options set for the
print queue to be reused.
3. Prepare in advance your notes about any optional features installed on the printer;
also decide on printer utilities, and prepare the UDF file, if appropriate.
4. Select Printers command in the Options Menu.
5. Press Add in the Printer Selection dialog; this brings up the Add Printer dialog.
6. Locate the queue in the Print Queue list and click on the queue name.
7. Select a printer from Manufacturer and Printer Type, update Description and other
information if desired, and make your selections of Installable Options.
8. Press OK to write a system-wide initialization file for the new printer, and return to
the Printer Selection dialog.
9. Press the Test button in the Printer Selection dialog (if available) to send a test file
to the print queue. Verify that the file is printed correctly; this confirms that a
trouble-free connection has been established.
10. Optionally, set and save system-wide defaults in the Printer Setup dialog and
Layout dialog.

Remove a Printer and its Print Queue
To remove a printer and a print queue follow this procedure:
Select Printers command in the Options Menu.
Select the printer in the list of Available Printers.
Press Remove; this brings up the Remove Printer dialog.
Check Also Remove Print Queue and press OK. This brings up an xterm window
with ecqadm invoked for the choice "remove a print queue".
5. Proceed as described in the topic Remove a Print Queue. The xterm window
closes when you terminate ecqadm.

1.
2.
3.
4.

Remove a Printer Only
To remove a printer without removing the print queue follow this procedure:
1.
2.
3.
4.

Select Printers command in the Options Menu.
Select the printer in the list of Available Printers.
Press Remove; this brings up the Remove Printer dialog.
Make sure that Also Remove Print Queue is turned off and press OK.

Associate a Print Queue with Another Printer
To associate a print queue with another printer, assuming that the new printer is
connected in the same way as defined when the queue was first created, follow this
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procedure:
1. Make the queue available by removing the printer originally associated with the
queue as described above in Remove a Printer Only.
2. Add the new printer as described above in Add a Printer and Use an Existing Print
Queue.
Copyright © 2003, AGI (autoGraph international), www.augrin.com.
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Add Printer Dialog
The information provided below applies to the UNIX versions of EasyCopy.

This dialog is only available to the System Administrator.

The Add Printer dialog is automatically entered the first time you start EasyCopy after
installation because at least one print queue must be defined before you can use all
functions of EasyCopy.

The dialog allows the System Administrator to add a printer, control its installable
options, and associate is with a print queue.
The dialog is also entered when you press the Add button in the Printer Selection
dialog. This button is only available if you have root access.
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Printer Name
Enter the name you want to use for the printer in the Printer field.
By default the name of the print queue applies. However, if you want to assign more
than one logical printer to the same queue you will need to give each printer a unique
name. This might, for example, apply if a printer can run in either PCL or PostScript
mode.
Print Queue You have several options for associating the printer with a print queue:
Use an Existing Print Queue on a Print Server
Prefer this approach whenever possible. All it requires is that you have a print
queue running already on a print server.
1. Enable the switch labeled Print Queue is on Print Server;
2. Type the host name (or IP address) of the server;
3. Type the name of the print queue in the filed labeled Print Queue;
Proceed by selecting printer model and other parameters as described below.
When these details have been selected you can complete the installation by
pressing the OK button.
Use an Existing Local Print Queue
Take this approach if you already have established your printer environments and
only want to add EasyCopy as a new application.
1. Use the Print System menu to select the print system you want to use for the
print queue (if you have concurrent print systems like BSD, System V, or
others).
Unknown print system means that the system is unknown to EasyCopy, not
that you don t know! A good example is a plot management system that has
implemented its own (non-standard) print system. EasyCopy cannot suggest a
Print Command (see below), and therefore the system becomes unknown.
Refer to the frame How to Make an Unknown Print System Known if you want
EasyCopy to learn about additional print systems.
2. The available print queues for the selected Print System are displayed in a list.
Queues not created by EasyCopy are marked with an asterisk (*); this includes
queues created by EasyCopy/X 5.2 or previous versions. If you choose one of
these queues Direct Processing will be forced.
3. Click on the queue you want to use. Make sure that it does not contain any
waiting jobs before you start modifying its definition (press Queue Status to
display the queue s current status).

Proceed by selecting printer model and other parameters as described below.
When these details have been selected you can implement the changes by
pressing thd OK button.
Create a New Local Print Queue
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1. Use the Print System menu to select the print system you want to use for the
print queue (if you have concurrent print systems like BSD, System V, or
others).
You cannot select Unknown print system if you want to create a new print
queue.
2. Press Create New Queue to create a new print queue. This starts ecqadm in a
terminal window.

Proceed as described in Create a Print Queue on page 132. The terminal window
closes when you terminate ecqadm. Then select printer model and other
parameters as described below. When these details have been selected you can
complete the installation by pressing the OK button.
Queue Status
Press this button to display the status of the highlighted print queue.
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Print Command
This field contains the command that sends data to
the print queue. EasyCopy constructs this command
template automatically. You may, however, edit the
template if you want to implement non-default
options.
If the Print System is Unknown there is no default
print command. You must in this case construct the
template yourself.
You have a number of symbolic parameters at your
disposal when you make the print command:
$PQ Name of the print queue.
$PH Remote host.
$NC Number of copies.
As System Administrator you can add support for
"unknown" print systems as explained in the column
to the right.

How to Make an Unknown Print System Known
If you are using a print system that is unknown in
EasyCopy (for example a proprietary system that
comes with a plot management system) you can
easily create support for this system in EasyCopy s
Add Printer dialog. All you need is a template for
the system s print command. Assume that your
print system is called MySys and that the print
command syntax of this fictive system is
mylpr -Qqueue -Ccopies -nfv
Do the following to create the desired support:
1. Go to the easycopy/(printers/systems
subdirectory.
2. This directory contains a file called Unknown.
Make a copy of that file and call it MySys.
3. Find these two lines:
Description="Unknown"
PrintCommand=""
4. Change them into the following:
Description=" MySys"
PrintCommand="mylpr -Q$PQ -C$NC -nfv"
You can now select MySys in the Print Queue menu,
and have it supported with the correct print
command.

Use Print Queue Processing
If the print queue is created by means of EasyCopy you can enable this switch to
select Print Queue Processing. This enables the filter flag (-v or -op) in the Print
Command.

Select Printer Manufacturer and Model
Select the printer you want to add by means of Manufacturer and Printer Type. Any
printer for which there is a printer description file in the easycopy/system directory can
be selected.
Printer Description File
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The name of the printer description file (EPD, PPD, or PPE file) corresponding to the
selected printer model is highlighted. You can also select printer by selecting the
printer description file. This is for example useful if you added a new PPD file yourself,
and you remember the PPD file name better than you remember the printer type
description. Description
This field displays the text that identifies the printer in the menus and dialogs. A default
description is constructed from the print queue name and the model name retrieved
from the printer description file.
For example "h, Apple Color LaserWriter 12/600" results from selecting the print queue
h and the printer with model name Apple Color LaserWriter 12/600.
You are free to edit the printer description to anything you think is appropriate, for
example "Color Printer in Room 345".
Utility Definition File
Enable this box if printer utilities are defined for the printer, and type the name of the
UDF file.

The default is generic.udf. It defines the generic PostScript level 2 error handler. This
option is by default enabled for PostScript level 2 and 3 printers, and disabled for other
printers. You must prepare the UDF file by a text editor before you add the printer.
Hints
Press Hints to get information and setup hints about the selected printer. This
information is not available for all printers.
Installable Options
This section of the dialog contains menus for all the installable options that are
supported by a printer. The length and the contents of this list are printer specific.
Refer to your printer's documentation to find information about the various installable
options. This section does not appear in the dialog if there are no installable options
defined in the printer description file.
How to Modify Installable Options
After you have installed the printer you may need to modify its installable options, for example if you
upgrade the printer with another paper tray.
You can as System Administrator use the Printer Setup dialog to make the corresponding changes available
in EasyCopy. The Installable options tab is only visible when you have started EasyCopy as System
Administrator.
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OK
Press OK to accept the selected printer and options and close the dialog. The new
printer is now included in the list of available printers in the Printer Selection dialog.

Cancel
Press Cancel to close the dialog without adding a printer.
Copyright © 2003, AGI (autoGraph international), www.augrin.com.
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Remove Printer Dialog
The information provided below applies to the UNIX versions of EasyCopy.

This dialog is only available to the System Administrator.

The Remove Printer dialog is entered when you press the Remove button in the Printer
Selection dialog.
If you are not logged in as root the Remove button just removes the selected printer from your
personal short-list of printers.

The dialog allows you, as system administrator, to remove a printer and a print queue.
Remove Printer
Do not enable Also Remove Print Queue if you want to keep the print queue, but
want to remove only the printer.

Remove Print Queue
Enable Also Remove Print Queue if you want to remove both the printer and the
print queue.
Copyright © 2003, AGI (autoGraph international), www.augrin.com.
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Printer Utilities Dialog
The information provided below applies to the UNIX versions of EasyCopy.

The Printer Utilities dialog is used to send a utility to the current printer. You open the
dialog by pressing Utilities in the Printer Selection dialog.

Select a utility from the list and press the Send button to send the utility job to the
printer.
Only one printer utility is installed automatically, namely a PostScript Error Handler. It
is available for all PostScript printers. It catches PostScript errors and prints a
diagnostic message on the page.
The System Administrator may install other utilities. Refer to the topic Installation of Printer
Utilities.

Copyright © 2003, AGI (autoGraph international), www.augrin.com.
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Installation of Printer Utilities
The information provided below applies to the UNIX versions of EasyCopy.

Only the system administrator can define and install printer utilities.

The system-wide initialization file for each printer includes an entry defining the
printer's Utility Definition File (UDF).
The UDF file is itself an initialization file. It contains only one section: [Printer Utilities].
The UDF file provides the link between the available utility files and the contents of
Available Utilities in the Printer Utilities dialog.

Utility Selection
Before you install a new printer you must decide which printer utilities you will make
available to the users of EasyCopy.

Printer utilities may be available from the printer manufacturer, and are shipped with
the printer. A generic PostScript Level 2 error handler utility is included with EasyCopy;
it can be used if no similar utility for a specific PostScript printer is available, or if you
like the generic error handler better than the one shipped with the printer. You may
also install locally developed printer utilities.
Be aware, that many printer utilities for PostScript printers require a password to the printer's
PostScript engine. Normally, such utilities impose major changes to the state of the engine, and they
are not intended for the general user.

Refer to any available documentation before you decide to install a utility file.

Printer Utility Directory
It is advised that you plan an appropriate directory structure for printer utilities. Follow
these guidelines, adopted as required to your local conventions:

Printer independent utilities are placed in the easycopy/system directory. The
generic PostScript error handler utility is placed here when you install EasyCopy. If
you have other utilities that might potentially be used by all printers or a large
group of printers, place them in the same directory.
Common utilities for a smaller group of printers (for example printers from one
manufacturer) are placed in another directory; they might well have the same
names as printer independent utilities, or utilities for one group might have names
in common with utilities for another group. Place these utility files in a subdirectory
in the easycopy/system directory, and use a directory name reflecting the group,
for example the name of the printer manufacturer.
Specific utilities for one printer are placed in a separate directory; a subdirectory to
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the group directory (if one applies) is a good choice, or create a subdirectory in
the easycopy/system directory and use the printer name as directory name.

Utility Definition Entries
Each entry in the [Printer Utilities] section defines a printer utility, which is available in
the Printer Utilities dialog.

You must prepare the UDF file for each printer by using a text editor and save it in the
easycopy/system directory before you install the printer. Use file names in a consistent
manner; it is good practice to use the printer name or a group name together with the
file name extension .udf, for example acme.udf for a printer group acme. You can use
a common UDF file if the same utilities apply to a group of printers.
A default UDF file for PostScript level 2 and 3 printers, generic.udf, defines an entry for
the generic PostScript error handler. This UDF file is automatically installed.
UDF files must be saved in the easycopy/system directory.
An example of a UDF file for a PostScript printer is shown here:
[Printer Utilities]
ErrorHandler=$SYSDIR/errhand.ps
PrintStartPage=$SYSDIR/acme/pstpg.ps
AutomaticStartPage=$SYSDIR/acme/astp.ps
DisableStartPage=$SYSDIR/acme/nostp.ps
ColorTest=/$ECTOPDIR/test.xwd
Use $ECTOPDIR and $SYSDIR as convenient shorthands for the easycopy directory
and the easycopy/system directory, respectively.
The key name is used to set the name of the utility. EasyCopy inserts a space before
any capitalized letter in the key name, except the first, and uses the resulting string to
describe the utility in the list presented, for example is the key name ErrorHandler
presented as Error Handler in the Printer Utilities dialog. The maximum length of a key
name is 40 characters.

The value associated with the key name defines the full path name of the file
associated with the utility. This is the file that is downloaded to the printer when the
utility is selected and sent. This file must be in a format that the printer can
understand.
The above example defines five utilities:
Error Handler
The generic PostScript error handler.
Print Start Page
Automatic Start Page
Disable Start Page
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Color Test
Print the EasyColor test page test.xwd
The Color Test utility in this example sends an XWD file to the printer. This construction is only
possible if the print queue has been created by EasyCopy so that EasyPrint resides as a filter in the
print queue.

When you install the printer you must enable Utility Definition File and specify the
name of the UDF file in the Add Printer dialog.
Copyright © 2003, AGI (autoGraph international), www.augrin.com.
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SCSI Printers
The information provided below applies to the UNIX versions of EasyCopy.

You will normally need root access to setup a SCSI device.

EasyCopy requires a SCSI driver configured into the UNIX kernel. This driver is
normally preconfigured. The information provided here is for reference and can be
used if you need to modify the setup of a SCSI device.
Refer also to

Printer documentation shipped with the printer.
Hardware and software documentation on SCSI connection from your workstation
manufacturer or SCSI adapter manufacturer.

SCSI Device Address
Normally, you need the following information before you can install and configure a
SCSI printer:
1. The identifier of the SCSI controller. Many workstations only have one controller,
number 0.
2. The target ID of the SCSI device (major number).
3. The logical unit number (LUN or minor number).

The procedures for setting and retrieving this information depend on the platform; refer
to the platform specific information:
Tru64 (Digital UNIX, OSF/1)
HP-UX
IBM AIX 4
Silicon Graphics IRIX
Solaris 2

Device Connection
To connect the printer you must power off the workstation and all connected SCSI
devices. Set the SCSI target ID on the printer (normally a dip-switch on the back of the
printer) to an unused ID. Plug in the SCSI cable with the printer powered off. Power on
all SCSI devices, and finally power on your workstation to let it boot.
Digital UNIX (OSF/1)
EasyCopy uses the SCSI User Agent Driver UAgt included with Digital Unix. The
device used with this driver is independent of the SCSI ID and LUN.
Normally the device is named /dev/cam and is created when you boot the system.
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If the device is not present, you can make a device using the mknod command
(requires root access):
# mknod /dev/cam c 30 0
# chmod 666 /dev/cam
The major number, 30, specifies that the device uses the UAgt driver; the minor
number, 0, is not used.
HP-UX
EasyCopy uses the SCSI device driver sctl included with HP-UX, and tries
automatically to detect the controller and device id.
SCSI devices are located in /dev/scsi. Normally, only devices for logical unit
number zero (LUN = 0) are included. If you need to make your own device, for
example LUN = 3 and SCSI ID = 6, use mknod (requires root access):
# mknod /dev/scsi/scsi63 c 105 0x201630
# chmod 666 /dev/scsi/scsi63
The major number, 105, specifies that the device uses the sctl driver.
The minor number, 0x201630, is constructed from the hardware path for the SCSI
adapter (first three digits, 201) followed by the SCSI ID (6), the LUN (3) and finally
a zero (0). The hardware path for the SCSI adapter may be different on your
system, use the ioscan command (/etc/ioscan) to check this.
Ensure that the SCSI ID do not conflict with other hardware; you can use ioscan to
check this. Refer also to man pages for scsi_ctl, mknod, and ioscan.
IBM AIX 4
EasyCopy uses a generic SCSI driver lad delivered as part of the product.
Proceed as follows to extract the information you need for the printer and lad driver
configuration:
First, check the workstation's SCSI setup:
$ lsparent -C -H -k scsi
This creates a list with one line per SCSI controller, for example:
scsi0 Available 00-00-0S Standard I/O Controller
Next, check which SCSI target ID's are in use:
$ lsdev -C -H -s scsi
You get a list with one line per device, for example:
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name
hdisk0
ive
cd0
rive
rmt0
ve

status
Available

location
00-00-0S-0,0

description
8.0 GB SCSI Disk Dr

Available

00-00-0S-2,0

Multimedia CD-ROM D

Available

00-00-0S-4,0

Other SCSI Tape Dri

In this example there are three devices on controller scsi0; their target ID's are 0,
2, and 4, and the logical unit number is 0 in all cases.
To install the lad driver proceed as follows (requires root access):
First, extract files from the tar archive ladscsi.tar found in the bin/aix4 directory:
# cd /usr/lpp/easycopy/sys/bin/aix4
# tar xvf ladscsi.tar
This creates a subdirectory ladscsi containing scripts for installing and removing the
driver. Change to this directory:
# cd ladscsi
Install the SCSI driver; type for example:
# ./install.scsi 5 0 0
This copies the lad driver executables to the correct system directories, and
configures the device /dev/lad0 for SCSI target ID=5, LUN=0 on the scsi0
controller.
Verify that the lad0 device is properly configured:
# lsattr -E -l lad0
Finally, in order to make the device available after a reboot, you must insert the
following line in /etc/inittab:
ecprint:2:once:/etc/mkdev -l lad0

To change the SCSI target ID on your printer you must power off like when you first
installed it. After reboot reconfigure the lad0 device to the new ID, for example:
$ chdev -l lad0 -a "scsi_id=6"
Power off is not required to change the logical unit number:
$ chdev -l lad0 -a "lun_id=3"
To uninstall the lad driver and remove the lad0 device, use:
# .../bin/aix4/ladscsi/remove.scsi
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Silicon Graphics IRIX
EasyCopy uses the generic SCSI device driver ds included with IRIX and tries
automatically to set the SCSI printer and device.
SCSI devices are located in /dev/scsi.
The generic driver must be linked into the kernel:
Edit the file /usr/sysgen/system and locate the line
USE: ds
If this line is present the driver is already linked into the kernel, and you can
proceed with configuration of ID and LUN.
Otherwise, if the line is commented, you uncomment it by removing the '*'. If it is
not present at all, you add the line. Then relink the kernel by entering the command
# lboot -u /unix.install
Reboot the system (reboot command). The minor number of the generic SCSI
device driver must correspond to the SCSI bus ID and LUN of the printer. The
minor number is calculated as LUN*16+ID, for example (3*16)+6=54 if LUN=3 and
ID=6.
Use the mknod command to make the device (requires root access):
# cd /dev/scsi
# mknod sc0d6l3 c 195 54
# chmod 666 sc0dl3
Solaris 2
EasyCopy uses the generic SCSI device driver sst.
To configure a scanner proceed as follows (root access required):
Edit the template file /opt/easycopy/bin/sun5/sst.conf to reflect the SCSI target ID
and LUN of the printer. Copy the updated sst.conf and the sst driver
into /usr/kernel/drv/.
Add the following entry to /etc/devlink.tab
type=ddi_pseudo;name=sst;minor=character

rsst\A0

The space between character and rsst must be a TAB.

Create links /dev/rsstx,y (where x is the SCSI target ID and y is the LUN of the
printer) for example, create /dev/rsst5,3 as a link
to /devices/sbus@1f,0/SUNW,fas@e,8800000/sst@5,3:character.
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# add_drv sst
Change permissions to give all users access to the devices:
# chmod 666 /devices/sbus@1f,0/SUNW,fas@e,8800000/sst*
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Save As Dialog

The Save As dialog is used to save a captured or imported image.
Use the Save tool

(or the Save As command in the File menu) to open the dialog.

File Type
Specifies the desired image file format. The default is TIFF.
EasyCopy supports export of the file formats listed below.
Options
Press Options to open a File Type Options dialog. The available options depend on the
selected File Type.
Type

File
format

Default
extension

BMP

MS Windows Bitmap

.bmp

File Type Options

182

CALS

CALS Raster Type 1

.cal

File Type Options

CATIA

Catia raster picture

.picture

File Type Options

CGM

CGM cell array

.cgm

File Type Options

GIF

GIF (Compuserve)

.gif

File Type Options

HP STARBASE

HP Starbase

.stb

File Type Options

JPEG

JPEG

.jpg

File Type Options

JPEG 2000

JPEG 2000

.jp2

File Type Options

PCX

PCX

.pcx

File Type Options

PBM (PPM)

Portable Bitmap

.pbm

File Type Options

PDF

Portable Document Format

.pdf

File Type Options

PNG

Portable Network Graphics

.png

File Type Options

RGB (SGI)

Silicon Graphics RGB

.rgb

File Type Options

SUN Raster

SUN Raster

.ras

File Type Options

TARGA

TARGA

.tga

File Type Options

TIFF

TIFF

.tif

File Type Options

XWD

X Window Dump

.xwd

File Type Options

Size
Press Size to open the Image Size dialog to specify the size of image.

Colors
Press Colors to open the Color Options dialog in which you can specify device
independent color modifications to the image before it is saved.

The color options only apply if you have enabled the check box next to Colors.
Color Options apply before File Type Options. For example, if you select Gray Scale in the Color
Options dialog and RGB in the File Type Options dialog, the image is reduced to gray scale, before it
is saved in a 24-bit RGB format. If you select Gray Scale in the File Type Options dialog the image is
reduced to gray scale and (if possible) saved in 8-bit gray scale format.

Stamp
Press Stamp to open the Stamp Options dialog in which you can specify a stamp to be
written diagonally across the saved image.

The stamp only applies if you have enabled the check box next to Stamp.
Label
Press Label to open the Label Options dialog in which you can specify one or more
lines to be written as a label near the edge of the saved image.

The label only applies if you have enabled the check box next to Label.
Convert Capture
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Specifies whether captured images will be saved in the selected image file format or in
the default image format. If this option is enabled a captured image is converted to the
selected format before it is saved. Otherwise, captured images are saved in XWD
format (except for Silicon Graphics systems if GL Mode is selected, in which case
captured images are saved in Silicon Graphics RGB format).

Explicit path and file name can be specified in this box.
The default suggestion for the file name includes a standard extension that depends
on the selected file type. If the original input image included a standard extension this
is stripped off before the new extension is appended.
Examples:
Input file

Saved as CGM

Saved as JPEG

Saved as TIFF

sample.tif

sample.cgm

sample.jpg

sample.tif

sample

sample.cgm

sample.jpg

sample.tif

sample.new

sample.new.cgm

sample.new.jpg

sample.new.tif

The default extension is only a suggestion. You can edit the file name and remove the suggested
extension. You will not get an extension appended behind your back.
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File Type Options Dialog
The File Type Options dialog is entered when you press Options in the Save As dialog
or the Send Attachment dialog. The dialog allows you to specify convert options for the
currently selected image file format.

The available options depend on the file format:
BMP

GIF

PCX

STARBASE

CALS

JPEG

PDF

SUN

CATIA

JPEG 2000

PNG

TARGA

CGM

PBM

RGB

TIFF

XWD
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File Type Options - BMP

The File Type Options dialog is entered when you press Options in the Image Export
dialog or the Send Attachment dialog. The dialog allows you to specify convert options
for the currently selected image file format.

The available options depend on the file format. Here are shown the options for the
BMP file format.
Color Mode
Best Fit
Let EasyCopy determine the best color mode. This is the default. EasyCopy will
choose the optimal color mode for the given image taking other current settings
into account.
RGB
RGB means a 24-bit RGB image ("true color").
Gray
Gray means a gray scale image. If possible a gray scale image using 8 bits per
pixel is written, or a colormap defining 256 shades of gray is used.
Bilevel
Bilevel means a bilevel, black-and-white image.
256
256 means a color mapped image with 256 different colors (8 bits per pixel).
16
16 means a color mapped image with 16 different colors (4 bits per pixel).
n
n Colors means an image containing n colors matching the colors of the input
image as closely as possible. n is the number entered in the field labeled Colors. A
color map of at least n entries is created, and a color map image is written, if this
can be realized. Otherwise, a true color image is written.

Colors
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This field is dimmed if the selected Color Mode is not n Colors. The default is the
maximum possible number of colors. Enter the number of desired colors (>2) in this
field.
Shading
This option specifies the method that applies if the output image contains fewer colors
than the input image. Each output image pixel is always chosen as closely as possible
to the input color of that pixel.
None
Any difference between input and output color is ignored. This may easily result in
"color banding".
Error Diffusion
This is the default. Color differences are distributed to the neighboring pixels.
Normally, this results in a substantially better color rendering, although at the
expense of image details; the sharpness becomes slightly degraded.
Refer also to the topic Image Shading.

Colormap
This is the color map to be used, if the selected Color Mode results in the creation of a
color map of exactly 256 colors.

Standard
Best Fit
A color map that gives the best representation of the input image. If the input
image also is color mapped, the original color map is used. Otherwise, a color map
optimized for the current image is calculated.
A fixed, predefined color map. This option is useful if several images are to appear
side-by-side on a device that can only display 256 colors.
OK
Press OK to accept the selected options and close the dialog.
If you have enabled Save Settings Automatically in the Preferences dialog the selected
options are saved in your initialization file and will apply as default next time you start
EasyCopy. Otherwise, the selected options only apply for the current session of
EasyCopy, unless you press Save.

Cancel
Press Cancel to close the dialog without changing any options.
If you press Save and then Cancel your defaults have been changed, but your current
settings remain unchanged.
Save
Press Save to save the selected options as defaults in your initialization file.
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File Type Options - CALS

The File Type Options dialog is entered when you press Options in the Image Export
dialog or the Send Attachment dialog. The dialog allows you to specify convert options
for the currently selected image file format.

The available options depend on the file format. Here are shown the options for the
CALS Raster Type file format.
Color Mode
Bilevel
Bilevel means a bilevel, black-and-white image. This is the only mode available for
this format.
Shading
This option specifies the method that applies if the output image contains fewer colors
than the input image. Each output image pixel is always chosen as closely as possible
to the input color of that pixel.
None
Any difference between input and output color is ignored. This may easily result in
"color banding".
Error Diffusion
This is the default. Color differences are distributed to the neighboring pixels.
Normally, this results in a substantially better color rendering, although at the
expense of image details; the sharpness becomes slightly degraded.
Refer also to the topic Image Shading.

Save
Press Save to save the selected options as defaults in your initialization file.
The button is dimmed if you have enabled Save Settings Automatically in the
Preferences dialog. In this case options are are always saved when you press OK.

OK
Press OK to accept the selected options and close the dialog.
If you have enabled Save Settings Automatically in the Preferences dialog the selected
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options are saved in your initialization file and will apply as default next time you start
EasyCopy. Otherwise, the selected options only apply for the current session of
EasyCopy, unless you press Save.
Cancel
Press Cancel to close the dialog without changing any options.
If you press Save and then Cancel your defaults have been changed, but your current
settings remain unchanged.
Save
Press Save to save the selected options as defaults in your initialization file.
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File Type Options - CATIA

The File Type Options dialog is entered when you press Options in the Image Export
dialog or the Send Attachment dialog. The dialog allows you to specify convert options
for the currently selected image file format.

The available options depend on the file format.
There are no selectable options for the Catia picture file format. Files are always
written as 24-bit RGB images.
OK
Press OK to accept the selected options and close the dialog.
If you have enabled Save Settings Automatically in the Preferences dialog the selected
options are saved in your initialization file and will apply as default next time you start
EasyCopy. Otherwise, the selected options only apply for the current session of
EasyCopy, unless you press Save.

Cancel
Press Cancel to close the dialog without changing any options.
If you press Save and then Cancel your defaults have been changed, but your current
settings remain unchanged.
Save
Press Save to save the selected options as defaults in your initialization file.
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File Type Options - CGM

The File Type Options dialog is entered when you press Options in the Image Export
dialog or the Send Attachment dialog. The dialog allows you to specify convert options
for the currently selected image file format.

The available options depend on the file format. Here are shown the options for the
CGM file format.
The CGM file format can contain different object types, including graphics, text, and images. An
image saved as CGM in EasyCopy contains a single image object ("cell array").
Note, that you can read any CGM file by means of the licensable option EasyCGM, but CGM files you
read are converted to image format.

Color Mode
Best Fit
Let EasyCopy determine the best color mode. This is the default. EasyCopy will
choose the optimal color mode for the given image taking other current settings
into account.
RGB
RGB means a 24-bit RGB image ("true color").
256
256 means a color mapped image with 256 different colors (8 bits per pixel).
n
n Colors means an image containing n colors matching the colors of the input
image as closely as possible. n is the number entered in the field labeled Colors. A
color map of at least n entries is created, and a color map image is written, if this
can be realized. Otherwise, a true color image is written.

Colors
Enter the number of desired colors (>2) in this field. The field is dimmed if the selected
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Color Mode is not n Colors. The default is the maximum possible number of colors.
Shading
This option specifies the method that applies if the output image contains fewer colors
than the input image. Each output image pixel is always chosen as closely as possible
to the input color of that pixel.
None
Any difference between input and output color is ignored. This may easily result in
"color banding".
Error Diffusion
This is the default. Color differences are distributed to the neighboring pixels.
Normally, this results in a substantially better color rendering, although at the
expense of image details; the sharpness becomes slightly degraded.
Refer also to the topic Image Shading.

Scale Method
Metric
The image is scaled according to the settings in the Image Size dialog and is saved
together with absolute dimensions calculated from the Resolution setting. This is
the default.
Abstract
The image is scaled according to the settings in the Image Size dialog and is saved
without any absolute dimensions (the image is only dimensioned in pixel units).
The image size measured in pixels is the same for these two modes.

Compression
None
Select None to get an uncompressed CGM file. This is the default.
Runlength
Select Runlength to get a compressed file.
Profile
You can specify, that the CGM file is saved with an ATA, CALS, or PIP profile. The
default is ATA.
Color Map
Specifies the color map to be used, if the selected Color Mode results in the creation
of a color map of exactly 256 colors.
Standard
This assigns a fixed, predefined color map to the output image. This option is useful
if several images are to appear side-by-side on a device that can only display 256
colors.
Best Fit
This is the default. It means a color map giving the best representation of the input
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image. If the input image is color mapped, the original color map is used, as far as
possible; otherwise a color map optimized for the current image is calculated.
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File Type Options - GIF

The File Type Options dialog is entered when you press Options in the Image Export
dialog or the Send Attachment dialog. The dialog allows you to specify convert options
for the currently selected image file format.

The available options depend on the file format. Here are shown the options for the
GIF file format.
Color Mode
Best Fit
Let EasyCopy determine the best color mode. This is the default. EasyCopy will
choose the optimal color mode for the given image taking other current settings
into account.
Gray
Gray means a gray scale image. A colormap defining 256 shades of gray is used.
256
256 means a color mapped image with 256 different colors (8 bits per pixel).
64
64 means a color mapped image with 64 different colors (6 bits per pixel).
16
16 means a color mapped image with 16 different colors (4 bits per pixel).
n
n Colors means an image containing n colors matching the colors of the input
image as closely as possible. n is the number entered in the field labeled Colors. A
color map of at least n entries is created, and a color map image is written.

Colors
Enter the number of desired colors (>2) in this field. The field is dimmed if the selected
Color Mode is not n Colors. The default (256) is the maximum possible number of
colors.
Shading
This option specifies the method that applies if the output image contains fewer colors
than the input image. Each output image pixel is always chosen as closely as possible
to the input color of that pixel.
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None
Any difference between input and output color is ignored. This may easily result in
"color banding".
Error Diffusion
This is the default. Color differences are distributed to the neighboring pixels.
Normally, this results in a substantially better color rendering, although at the
expense of image details; the sharpness becomes slightly degraded.
Refer also to the topic Image Shading.

Color Map
Specifies the color map to be used, if the selected Color Mode results in the creation
of a color map of exactly 256 colors.
Standard
This assigns a fixed, predefined color map to the output image. This option is useful
if several images are to appear side-by-side on a device that can only display 256
colors.
Best Fit
This is the default. It means a color map giving the best representation of the input
image. If the input image is color mapped, the original color map is used, as far as
possible; otherwise a color map optimized for the current image is calculated.
OK
Press OK to accept the selected options and close the dialog.
If you have enabled Save Settings Automatically in the Preferences dialog the selected
options are saved in your initialization file and will apply as default next time you start
EasyCopy. Otherwise, the selected options only apply for the current session of
EasyCopy, unless you press Save.

Cancel
Press Cancel to close the dialog without changing any options.
If you press Save and then Cancel your defaults have been changed, but your current
settings remain unchanged.
Save
Press Save to save the selected options as defaults in your initialization file.
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File Type Options - JPEG

The File Type Options dialog is entered when you press Options in the Image Export
dialog or the Send Attachment dialog. The dialog allows you to specify convert options
for the currently selected image file format.

The available options depend on the file format. Here are shown the options for the
JPEG file format.
You should only use JPEG compression for photographic and photorealistic images. The compression
method has been developed and is optimized for photographic images. For other image types
(computer graphics or text images the lossy modes introduce visible artifacts at the edges, and the
lossless mode is less efficient than LZW compression (GIF or TIFF files).

Color Mode
Best Fit
Let EasyCopy determine the best color mode. This is the default. EasyCopy will
choose the optimal color mode for the given image taking other current settings
into account.
RGB
RGB means a 24-bit RGB image ("true color").
RGB is only available together with Lossless compression.

YUV
The YUV color space contains one luminance component (Y) and two chrominance
components (U, V). This color space is used rather than RGB because it yields a
better compression when JPEG is used.
YUV is only available together with the lossy modes of JPEG (Baseline, Sequential. and
Progressinve).

Gray
Gray means a gray scale image (256 shades of gray).
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Compression
JPEG compression modes are Baseline, Sequential, Progressive, and Lossless. JPEG
compression operates on continuous-tone images with one or three components (gray
scale or color). Color mapped images are automatically expanded to RGB before
JPEG compression. Apart from the lossless mode JPEG is a lossy compression
method. A very high compression is achieved at the expense of an exact reproduction
of the original image during decompression. The quality loss, however, is related to
barely visible details, and annoying artifacts are normally only introduced when
extreme high compression ratios are enforced.
Baseline
This is a sequential JPEG compression using the minimal subset of the JPEG
standard. Any JPEG reader must be able to decompress a file using this subset.
Sequential
This mode exploits the full range of capabilities in the standard to produce a file that
is decompressed sequentially.
Progressive
Progressive JPEG mode also exploits the full range of capabilities, but is
decompressed progressively rather than sequentially. That is, each record of
compressed data represents addition of details to the entire image. A major
advantage of progressive decompression is that a version of the image holding
enough details for identification is instantly available from the first few records of
the file.
Lossless
Lossless mode is a highly efficient image compression method for photographic
images. Opposed to the other JPEG modes it is decompressed into an exact
reproduction of the original image.
JPEG Quality
Use the Quality slider to slider to specify the tradeoff between compression ratio and
quality loss. This option applies to the lossy JPEG modes. Otherwise, the slider is
dimmed.
The slider can be set between 1 and 20. A quality of 1 (leftmost slider position) gives
the highest compression at the expense of image quality. A quality of 20 (rightmost
slider position) gives the highest image quality and a lower compression.

The compression ratio depends on the contents and size of the original image. Results
in the range from approximately 50 : 1 (low quality) to 10 : 1 (high quality) can normally
be expected.
Sampling
This menu specifies the sampling ratio for the YUV color mode's chrominance
components. The menu is dimmed for other color modes.
1

Y:U:V = 1:1:1
All components are sampled equally.
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2

Y:U:V = 2:1:1
U and V are subsampled 2:1 horizontally.

4

Y:U:V = 4:1:1
U and V are subsampled 2:1 in both directions (default).

OK
Press OK to accept the selected options and close the dialog.
If you have enabled Save Settings Automatically in the Preferences dialog the selected
options are saved in your initialization file and will apply as default next time you start
EasyCopy. Otherwise, the selected options only apply for the current session of
EasyCopy, unless you press Save.

Cancel
Press Cancel to close the dialog without changing any options.
If you press Save and then Cancel your defaults have been changed, but your current
settings remain unchanged.
Save
Press Save to save the selected options as defaults in your initialization file.
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File Type Options - JPEG 2000

The File Type Options dialog is entered when you press Options in the Image Export
dialog or the Send Attachment dialog. The dialog allows you to specify convert options
for the currently selected image file format.

The available options depend on the file format. Here are shown the options for the
JP2 file format.
Color Mode
Best Fit
Let EasyCopy determine the best color mode. This is the default. EasyCopy will
choose the optimal color mode for the given image taking other current settings
into account.
RGB
RGB means a 24-bit RGB image ("true color").
Gray
Gray means a gray scale image.
Compression
JPEG 2000 is based on wavelet compression. Images can be compressed in two
modes:
Reversible
This is a lossless compression. When the image is decompressed you get an exact
copy of the original image. You can expect to achieve compression rates between
1:5 and 1:2 in this mode.
Irreversible
This is the default. The original image cannot be reconstructed exactly during
decompression, but the compression method strives to avoid visible artifacts.
When you choose this mode you can specify a target compression rate between
1:1 and 1:100 (se below).
Target Rate
Use the slider to specify a target compression rate between 1:1 and 1:100. 1:1 gives
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almost the same result as Reversible compression. When the slider is dragged to the
right the compression is improved, but some details are lost. If you choose 1:100 you
can save an RGB image of, say 1600x1200 pixels, in only 56 K bytes (the
uncompressed image takes 5.6 MB), and the visible quality loss will be unimportant for
many purposes.
OK
Press OK to accept the selected options and close the dialog.
If you have enabled Save Settings Automatically in the Preferences dialog the selected
options are saved in your initialization file and will apply as default next time you start
EasyCopy. Otherwise, the selected options only apply for the current session of
EasyCopy, unless you press Save.

Cancel
Press Cancel to close the dialog without changing any options.
If you press Save and then Cancel your defaults have been changed, but your current
settings remain unchanged.
Save
Press Save to save the selected options as defaults in your initialization file.
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File Type Options - PBM

The File Type Options dialog is entered when you press Options in the Image Export
dialog or the Send Attachment dialog. The dialog allows you to specify convert options
for the currently selected image file format.

The available options depend on the file format. Here are shown the options for the
Portable Bitmap file format.
PBM files are always saved as Portable Pixel Map (PPM).

Color Mode
Best Fit
Let EasyCopy determine the best color mode. This is the default. EasyCopy will
choose the optimal color mode for the given image taking other current settings
into account.
RGB
RGB means a 24-bit RGB image ("true color").
n
n Colors means an image containing n colors matching the colors of the input
image as closely as possible. n is the number entered in the field labeled Colors.

Colors
Enter the number of desired colors (>2) in this field. The field is dimmed if the selected
Color Mode is not n Colors. The default is the maximum possible number of colors.
Shading
This option specifies the method that applies if the output image contains fewer colors
than the input image. Each output image pixel is always chosen as closely as possible
to the input color of that pixel.
None
Any difference between input and output color is ignored. This may easily result in
"color banding".
Error Diffusion
This is the default. Color differences are distributed to the neighboring pixels.
Normally, this results in a substantially better color rendering, although at the
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expense of image details; the sharpness becomes slightly degraded.
Refer also to the topic Image Shading.

OK
Press OK to accept the selected options and close the dialog.
If you have enabled Save Settings Automatically in the Preferences dialog the selected
options are saved in your initialization file and will apply as default next time you start
EasyCopy. Otherwise, the selected options only apply for the current session of
EasyCopy, unless you press Save.

Cancel
Press Cancel to close the dialog without changing any options.
If you press Save and then Cancel your defaults have been changed, but your current
settings remain unchanged.
Save
Press Save to save the selected options as defaults in your initialization file.
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File Type Options - PCX

The File Type Options dialog is entered when you press Options in the Image Export
dialog or the Send Attachment dialog. The dialog allows you to specify convert options
for the currently selected image file format.

The available options depend on the file format. Here are shown the options for the
PCX file format.
Color Mode
Best Fit
Let EasyCopy determine the best color mode. This is the default. EasyCopy will
choose the optimal color mode for the given image taking other current settings
into account.
Gray
Gray means a gray scale image.
Bilevel
Bilevel means a bilevel, black-and-white image.
256
256 means a color mapped image with 256 different colors (8 bits per pixel).
16
16 means a color mapped image with 16 different colors (4 bits per pixel).
n
n Colors means an image containing n colors matching the colors of the input
image as closely as possible. n is the number entered in the field labeled Colors. A
color map of at least n entries is created, and a color map image is written, if this
can be realized. Otherwise, a true color image is written.

Colors
Enter the number of desired colors (>2) in this field. The field is dimmed if the selected
Color Mode is not n Colors. The default is the maximum possible number of colors.
Shading
This option specifies the method that applies if the output image contains fewer colors
than the input image. Each output image pixel is always chosen as closely as possible
to the input color of that pixel.
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None
Any difference between input and output color is ignored. This may easily result in
"color banding".
Error Diffusion
This is the default. Color differences are distributed to the neighboring pixels.
Normally, this results in a substantially better color rendering, although at the
expense of image details; the sharpness becomes slightly degraded.
Refer also to the topic Image Shading.

Color Map
Specifies the color map to be used, if the selected Color Mode results in the creation
of a color map of exactly 256 colors.
Standard
This assigns a fixed, predefined color map to the output image. This option is useful
if several images are to appear side-by-side on a device that can only display 256
colors.
Best Fit
This is the default. It means a color map giving the best representation of the input
image. If the input image is color mapped, the original color map is used, as far as
possible; otherwise a color map optimized for the current image is calculated.
OK
Press OK to accept the selected options and close the dialog.
If you have enabled Save Settings Automatically in the Preferences dialog the selected
options are saved in your initialization file and will apply as default next time you start
EasyCopy. Otherwise, the selected options only apply for the current session of
EasyCopy, unless you press Save.

Cancel
Press Cancel to close the dialog without changing any options.
If you press Save and then Cancel your defaults have been changed, but your current
settings remain unchanged.
Save
Press Save to save the selected options as defaults in your initialization file.
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File Type Options - PDF

The File Type Options dialog is entered when you press Options in the Image Export
dialog or the Send Attachment dialog. The dialog allows you to specify convert options
for the currently selected image file format.

The available options depend on the file format. Here are shown the options for the
PDF file format.
The PDF file format can contain different object types, including graphics, text, and images. An image
saved as PDF in EasyCopy contains a single image object.
Note, that you can read any PDF file, but PDF files you read are converted to image format.

Color Mode
Best Fit
Let EasyCopy determine the best color mode. This is the default. EasyCopy will
choose the optimal color mode for the given image taking other current settings
into account.
RGB
RGB means a 24-bit RGB image ("true color").
Gray
Gray means a gray scale image.
Bilevel
Bilevel means a bilevel, black-and-white image.
Compression
None
Select None to get an uncompressed PDF file.
JPEG Baseline
This is JPEG compression embedded in the PDF format. JPEG compression
operates on continuous-tone images with one or three components (gray scale or
color). Baseline is a sequential JPEG compression using a subset of the JPEG
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standard.
Deflate
Defalte is an efficient compression method for almost all image types.
CCITT Group 4
This is a CCITT facsimile compression.
CCITT compression is only available for bilevel images. If you select this compression it implies
a color mode of bilevel

Shading
This option specifies the method that applies if the output image contains fewer colors
than the input image. Each output image pixel is always chosen as closely as possible
to the input color of that pixel.
None
Any difference between input and output color is ignored. This may easily result in
"color banding".
Error Diffusion
This is the default. Color differences are distributed to the neighboring pixels.
Normally, this results in a substantially better color rendering, although at the
expense of image details; the sharpness becomes slightly degraded.
Refer also to the topic Image Shading.

OK
Press OK to accept the selected options and close the dialog.
If you have enabled Save Settings Automatically in the Preferences dialog the selected
options are saved in your initialization file and will apply as default next time you start
EasyCopy. Otherwise, the selected options only apply for the current session of
EasyCopy, unless you press Save.

Cancel
Press Cancel to close the dialog without changing any options.
If you press Save and then Cancel your defaults have been changed, but your current
settings remain unchanged.
Save
Press Save to save the selected options as defaults in your initialization file.
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File Type Options - PNG

The File Type Options dialog is entered when you press Options in the Image Export
dialog or the Send Attachment dialog. The dialog allows you to specify convert options
for the currently selected image file format.

The available options depend on the file format. Here are shown the options for the
PNG file format.
Color Mode
Best Fit
Let EasyConvert determine the best color mode. This is the default. EasyConvert
will choose the optimal color mode for the given image taking other current settings
into account.
RGB
RGB means a 24-bit RGB image ("true color").
Gray
Gray means a gray scale image. If possible a gray scale image using 8 bits per
pixel is written, or a colormap defining 256 shades of gray is used.
Bilevel
Bilevel means a bilevel, black-and-white image.
256
256 means a color mapped image with 256 different colors (8 bits per pixel).
16
16 means a color mapped image with 16 different colors (4 bits per pixel).
n
n Colors means an image containing n colors matching the colors of the input
image as closely as possible. n is the number entered in the field labeled Colors. A
color map of at least n entries is created, and a color map image is written, if this
can be realized. Otherwise, a true color image is written.

Colors
Enter the number of desired colors (>2) in this field. The field is dimmed if the selected
Color Mode is not n Colors. The default is the maximum possible number of colors.
Shading
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This option specifies the method that applies if the output image contains fewer colors
than the input image. Each output image pixel is always chosen as closely as possible
to the input color of that pixel.
None
Any difference between input and output color is ignored. This may easily result in
"color banding".
Error Diffusion
This is the default. Color differences are distributed to the neighboring pixels.
Normally, this results in a substantially better color rendering, although at the
expense of image details; the sharpness becomes slightly degraded.
Refer also to the topic Image Shading.

Color Map
Specifies the color map to be used, if the selected Color Mode results in the creation
of a color map of exactly 256 colors.
Standard
This assigns a fixed, predefined color map to the output image. This option is useful
if several images are to appear side-by-side on a device that can only display 256
colors.
Best Fit
This is the default. It means a color map giving the best representation of the input
image. If the input image is color mapped, the original color map is used, as far as
possible; otherwise a color map optimized for the current image is calculated.
OK
Press OK to accept the selected options and close the dialog.
If you have enabled Save Settings Automatically in the Preferences dialog the selected
options are saved in your initialization file and will apply as default next time you start
EasyCopy. Otherwise, the selected options only apply for the current session of
EasyCopy, unless you press Save.

Cancel
Press Cancel to close the dialog without changing any options.
If you press Save and then Cancel your defaults have been changed, but your current
settings remain unchanged.
Save
Press Save to save the selected options as defaults in your initialization file.
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File Type Options - RGB

The File Type Options dialog is entered when you press Options in the Image Export dialog or the Send
Attachment dialog. The dialog allows you to specify convert options for the currently selected image file
format.

The available options depend on the file format. Here are shown the options for Silicon Graphics' RGB
file format.
Color Mode
Best Fit
Let EasyCopy determine the best color mode. This is the default. EasyCopy will choose the optimal
color mode for the given image taking other current settings into account.
RGB
RGB means a 24-bit RGB image ("true color").
Gray
Gray means a gray scale image. If possible a gray scale image using 8 bits per pixel is written, or a
colormap defining 256 shades of gray is used.
n
n Colors means an image containing n colors matching the colors of the input image as closely as
possible. n is the number entered in the field labeled Colors. A color map of at least n entries is
created, and a color map image is written, if this can be realized. Otherwise, a true color image is
written.

Colors
Enter the number of desired colors (>2) in this field. The field is dimmed if the selected Color Mode is
not n Colors. The default is the maximum possible number of colors.
Shading
This option specifies the method that applies if the output image contains fewer colors than the input
image. Each output image pixel is always chosen as closely as possible to the input color of that pixel.
None
Any difference between input and output color is ignored. This may easily result in "color banding".
Error Diffusion
This is the default. Color differences are distributed to the neighboring pixels. Normally, this results
in a substantially better color rendering, although at the expense of image details; the sharpness
becomes slightly degraded.
Refer also to the topic Image Shading.

OK
Press OK to accept the selected options and close the dialog.
209

If you have enabled Save Settings Automatically in the Preferences dialog the selected options are
saved in your initialization file and will apply as default next time you start EasyCopy. Otherwise, the
selected options only apply for the current session of EasyCopy, unless you press Save.

Cancel
Press Cancel to close the dialog without changing any options.
If you press Save and then Cancel your defaults have been changed, but your current settings remain
unchanged.
Save
Press Save to save the selected options as defaults in your initialization file.
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File Type Options - HP Starbase

The File Type Options dialog is entered when you press Options in the Image Export
dialog or the Send Attachment dialog. The dialog allows you to specify convert options
for the currently selected image file format.

The available options depend on the file format. Here are shown the options for the HP
Starbase file format.
Color Mode
Best Fit
Let EasyCopy determine the best color mode. This is the default. EasyCopy will
choose the optimal color mode for the given image taking other current settings
into account.
RGB
RGB means a 24-bit RGB image ("true color").
Gray
Gray means a gray scale image. If possible a gray scale image using 8 bits per
pixel is written, or a colormap defining 256 shades of gray is used.
256
256 means a color mapped image with 256 different colors (8 bits per pixel).
n
n Colors means an image containing n colors matching the colors of the input
image as closely as possible. n is the number entered in the field labeled Colors. A
color map of at least n entries is created, and a color map image is written, if this
can be realized. Otherwise, a true color image is written.

Colors
Enter the number of desired colors (>2) in this field. The field is dimmed if the selected
Color Mode is not n Colors. The default is the maximum possible number of colors.
Shading
This option specifies the method that applies if the output image contains fewer colors
than the input image. Each output image pixel is always chosen as closely as possible
to the input color of that pixel.
None
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Any difference between input and output color is ignored. This may easily result in
"color banding".
Error Diffusion
This is the default. Color differences are distributed to the neighboring pixels.
Normally, this results in a substantially better color rendering, although at the
expense of image details; the sharpness becomes slightly degraded.
Refer also to the topic Image Shading.

Color Map
Specifies the color map to be used, if the selected Color Mode results in the creation
of a color map of exactly 256 colors.
Standard
This assigns a fixed, predefined color map to the output image. This option is useful
if several images are to appear side-by-side on a device that can only display 256
colors.
Best Fit
This is the default. It means a color map giving the best representation of the input
image. If the input image is color mapped, the original color map is used, as far as
possible; otherwise a color map optimized for the current image is calculated.
OK
Press OK to accept the selected options and close the dialog.
If you have enabled Save Settings Automatically in the Preferences dialog the selected
options are saved in your initialization file and will apply as default next time you start
EasyCopy. Otherwise, the selected options only apply for the current session of
EasyCopy, unless you press Save.

Cancel
Press Cancel to close the dialog without changing any options.
If you press Save and then Cancel your defaults have been changed, but your current
settings remain unchanged.
Save
Press Save to save the selected options as defaults in your initialization file.
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File Type Options - SUN Raster

The File Type Options dialog is entered when you press Options in the Image Export
dialog or the Send Attachment dialog. The dialog allows you to specify convert options
for the currently selected image file format.

The available options depend on the file format. Here are shown the options for the
SUN raster file format.
Color Mode
Best Fit
Let EasyCopy determine the best color mode. This is the default. EasyCopy will
choose the optimal color mode for the given image taking other current settings
into account.
RGB
RGB means a 24-bit RGB image ("true color").
Gray
Gray means a gray scale image. If possible a gray scale image using 8 bits per
pixel is written, or a colormap defining 256 shades of gray is used.
Bilevel
Bilevel means a bilevel, black-and-white image.
256
256 means a color mapped image with 256 different colors (8 bits per pixel).
n
n Colors means an image containing n colors matching the colors of the input
image as closely as possible. n is the number entered in the field labeled Colors. A
color map of at least n entries is created, and a color map image is written, if this
can be realized. Otherwise, a true color image is written.

Colors
Enter the number of desired colors (>2) in this field. The field is dimmed if the selected
Color Mode is not n Colors. The default is the maximum possible number of colors.
Shading
This option specifies the method that applies if the output image contains fewer colors
than the input image. Each output image pixel is always chosen as closely as possible
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to the input color of that pixel.
None
Any difference between input and output color is ignored. This may easily result in
"color banding".
Error Diffusion
This is the default. Color differences are distributed to the neighboring pixels.
Normally, this results in a substantially better color rendering, although at the
expense of image details; the sharpness becomes slightly degraded.
Refer also to the topic Image Shading.

Color Map
Specifies the color map to be used, if the selected Color Mode results in the creation
of a color map of exactly 256 colors.
Standard
This assigns a fixed, predefined color map to the output image. This option is useful
if several images are to appear side-by-side on a device that can only display 256
colors.
Best Fit
This is the default. It means a color map giving the best representation of the input
image. If the input image is color mapped, the original color map is used, as far as
possible; otherwise a color map optimized for the current image is calculated.
OK
Press OK to accept the selected options and close the dialog.
If you have enabled Save Settings Automatically in the Preferences dialog the selected
options are saved in your initialization file and will apply as default next time you start
EasyCopy. Otherwise, the selected options only apply for the current session of
EasyCopy, unless you press Save.

Cancel
Press Cancel to close the dialog without changing any options.
If you press Save and then Cancel your defaults have been changed, but your current
settings remain unchanged.
Save
Press Save to save the selected options as defaults in your initialization file.
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File Type Options - Targa

The File Type Options dialog is entered when you press Options in the Image Export
dialog or the Send Attachment dialog. The dialog allows you to specify convert options
for the currently selected image file format.

The available options depend on the file format. Here are shown the options for the
Targa file format.
Color Mode
Best Fit
Let EasyCopy determine the best color mode. This is the default. EasyCopy will
choose the optimal color mode for the given image taking other current settings
into account.
RGB
RGB means a 24-bit RGB image ("true color").
Gray
Gray means a gray scale image.
256
256 means a color mapped image with 256 different colors (8 bits per pixel).
n
n Colors means an image containing n colors matching the colors of the input
image as closely as possible. n is the number entered in the field labeled Colors. A
color map of at least n entries is created, and a color map image is written, if this
can be realized. Otherwise, a true color image is written.

Colors
Enter the number of desired colors (>2) in this field. The field is dimmed if the selected
Color Mode is not n Colors. The default is the maximum possible number of colors.
Shading
This option specifies the method that applies if the output image contains fewer colors
than the input image. Each output image pixel is always chosen as closely as possible
to the input color of that pixel.
None
Any difference between input and output color is ignored. This may easily result in
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"color banding".
Error Diffusion
This is the default. Color differences are distributed to the neighboring pixels.
Normally, this results in a substantially better color rendering, although at the
expense of image details; the sharpness becomes slightly degraded.
Refer also to the topic Image Shading.

Color Map
Specifies the color map to be used, if the selected Color Mode results in the creation
of a color map of exactly 256 colors.
Standard
This assigns a fixed, predefined color map to the output image. This option is useful
if several images are to appear side-by-side on a device that can only display 256
colors.
Best Fit
This is the default. It means a color map giving the best representation of the input
image. If the input image is color mapped, the original color map is used, as far as
possible; otherwise a color map optimized for the current image is calculated.
OK
Press OK to accept the selected options and close the dialog.
If you have enabled Save Settings Automatically in the Preferences dialog the selected
options are saved in your initialization file and will apply as default next time you start
EasyCopy. Otherwise, the selected options only apply for the current session of
EasyCopy, unless you press Save.

Cancel
Press Cancel to close the dialog without changing any options.
If you press Save and then Cancel your defaults have been changed, but your current
settings remain unchanged.
Save
Press Save to save the selected options as defaults in your initialization file.
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File Type Options - TIFF

The File Type Options dialog is entered when you press Options in the Image Export
dialog or the Send Attachment dialog. The dialog allows you to specify convert options
for the currently selected image file format.

The available options depend on the file format. Here are shown the options for the
TIFF file format.
Color Mode
Best Fit
Let EasyCopy determine the best color mode. This is the default. EasyCopy will
choose the optimal color mode for the given image taking other current settings
into account.
RGB
RGB means a 24-bit RGB image ("true color").
YUV
The YUV color space contains one luminance component (Y) and two chrominance
components (U, V).
YUV is only available together when you choose (Baseline (JPEG) compression. This color space
is used rather than RGB because it yields a better compression when JPEG is used.

Gray
Gray means a gray scale image. If possible a gray scale image using 8 bits per
pixel is written, or a colormap defining 256 shades of gray is used.
Bilevel
Bilevel means a bilevel, black-and-white image.
256
256 means a color mapped image with 256 different colors (8 bits per pixel).
16
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n

16 means a color mapped image with 16 different colors (4 bits per pixel).
n Colors means an image containing n colors matching the colors of the input
image as closely as possible. n is the number entered in the field labeled Colors. A
color map of at least n entries is created, and a color map image is written, if this
can be realized. Otherwise, a true color image is written.

Colors
Enter the number of desired colors (>2) in this field. The field is dimmed if the selected
Color Mode is not n Colors. The default is the maximum possible number of colors.
Compression
None
Select None to get an uncompressed TIFF file.
PackBits
This is a runlength compression method.
LZW
LZW is an efficient compression method for almost all image types.
JPEG Baseline
This is JPEG compression embedded in the TIFF format. JPEG compression
operates on continuous-tone images with one or three components (gray scale or
color). Baseline is a sequential JPEG compression using a subset of the JPEG
standard.
JPEG Lossless
This is lossless JPEG compression embedded in the TIFF format. This is an
efficient image compression method for photographic images.
CCITT Group 3
CCITT Group 4
Modified Huffman
These are CCITT facsimile compressions.
Facsimile compression is only available for bilevel images.

JPEG Quality
This option applies to Baseline (JPEG) compression. For other compressions the slider is dimmed.

Use the Quality slider to slider to specify the tradeoff between compression ratio and
quality loss.
The slider can be set between 1 and 20. A quality of 1 (leftmost slider position) gives
the highest compression at the expense of image quality. A quality of 20 (rightmost
slider position) gives the highest image quality and a lower compression.
218

The compression ratio depends on the contents and size of the original image. Results
in the range from approximately 50 : 1 (low quality) to 10 : 1 (high quality) can normally
be expected.
Sampling
This option applies to Baseline (JPEG) compression. For other compressions the menu is dimmed.

The menu specifies the sampling ratio for the YUV color mode's chrominance
components.
1

Y:U:V = 1:1:1
All components are sampled equally.

2

Y:U:V = 2:1:1
U and V are subsampled 2:1 horizontally.

4

Y:U:V = 4:1:1
U and V are subsampled 2:1 in both directions (default).

Shading
This option specifies the method that applies if the output image contains fewer colors
than the input image. Each output image pixel is always chosen as closely as possible
to the input color of that pixel.
None
Any difference between input and output color is ignored. This may easily result in
"color banding".
Error Diffusion
This is the default. Color differences are distributed to the neighboring pixels.
Normally, this results in a substantially better color rendering, although at the
expense of image details; the sharpness becomes slightly degraded.
Refer also to the topic Image Shading.

Color Map
Specifies the color map to be used, if the selected Color Mode results in the creation
of a color map of exactly 256 colors.
Standard
This assigns a fixed, predefined color map to the output image. This option is useful
if several images are to appear side-by-side on a device that can only display 256
colors.
Best Fit
This is the default. It means a color map giving the best representation of the input
image. If the input image is color mapped, the original color map is used, as far as
possible; otherwise a color map optimized for the current image is calculated.
OK
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Press OK to accept the selected options and close the dialog.
If you have enabled Save Settings Automatically in the Preferences dialog the selected
options are saved in your initialization file and will apply as default next time you start
EasyCopy. Otherwise, the selected options only apply for the current session of
EasyCopy, unless you press Save.

Cancel
Press Cancel to close the dialog without changing any options.
If you press Save and then Cancel your defaults have been changed, but your current
settings remain unchanged.
Save
Press Save to save the selected options as defaults in your initialization file.
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File Type Options - XWD

The File Type Options dialog is entered when you press Options in the Image Export
dialog or the Send Attachment dialog. The dialog allows you to specify convert options
for the currently selected image file format.

The available options depend on the file format. Here are shown the options for the
XWD file format.
Color Mode
Best Fit
Let EasyCopy determine the best color mode. This is the default. EasyCopy will
choose the optimal color mode for the given image taking other current settings
into account.
RGB
RGB means a 24-bit RGB image ("true color").
Gray
Gray means a gray scale image. If possible a gray scale image using 8 bits per
pixel is written, or a colormap defining 256 shades of gray is used.
Bilevel
Bilevel means a bilevel, black-and-white image.
256
256 means a color mapped image with 256 different colors (8 bits per pixel).
64
64 means a color mapped image with 64 different colors (6 bits per pixel).
16
16 means a color mapped image with 16 different colors (4 bits per pixel).
n
n Colors means an image containing n colors matching the colors of the input
image as closely as possible. n is the number entered in the field labeled Colors. A
color map of at least n entries is created, and a color map image is written, if this
can be realized. Otherwise, a true color image is written.

Colors
Enter the number of desired colors (>2) in this field. The field is dimmed if the selected
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Color Mode is not n Colors. The default is the maximum possible number of colors.
Shading
This option specifies the method that applies if the output image contains fewer colors
than the input image. Each output image pixel is always chosen as closely as possible
to the input color of that pixel.
None
Any difference between input and output color is ignored. This may easily result in
"color banding".
Error Diffusion
This is the default. Color differences are distributed to the neighboring pixels.
Normally, this results in a substantially better color rendering, although at the
expense of image details; the sharpness becomes slightly degraded.
Refer also to the topic Image Shading.

Color Map
Specifies the color map to be used, if the selected Color Mode results in the creation
of a color map of exactly 256 colors.
Standard
This assigns a fixed, predefined color map to the output image. This option is useful
if several images are to appear side-by-side on a device that can only display 256
colors.
Best Fit
This is the default. It means a color map giving the best representation of the input
image. If the input image is color mapped, the original color map is used, as far as
possible; otherwise a color map optimized for the current image is calculated.
OK
Press OK to accept the selected options and close the dialog.
If you have enabled Save Settings Automatically in the Preferences dialog the selected
options are saved in your initialization file and will apply as default next time you start
EasyCopy. Otherwise, the selected options only apply for the current session of
EasyCopy, unless you press Save.

Cancel
Press Cancel to close the dialog without changing any options.
If you press Save and then Cancel your defaults have been changed, but your current
settings remain unchanged.
Save
Press Save to save the selected options as defaults in your initialization file.
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Image Size Dialog

The Image Size dialog is entered when you press the Size button in the Image Export
dialog or the Send Attachment dialog. The dialog allows you to specify the size of a
converted image. By default a converted image has the same pixel dimensions as the
original image.

You can deal with image size either as pixel dimensions or as a metric image size,
for example in units of inches.
The most convenient concept normally depends on how you intend to use the image
later.
You will probably care more about pixel dimensions if you want to e-mail the image or
publish it on the internet, whereas the metric size is important if you plan to take the
image into a DTP application and use it as an illustration.
Pixel dimensions and metric size are connected through the resolution which is
specified as Pixels/Inch or Pixels/Centimeter.

(Metric) Image Size
You can enter the metric image size in the upper part of the dialog.
Width and Height
Enter the desired dimensions in your preferred unit. Choose any of these units:
Percent (of original image), Inches, Centimeters, Millimeters, or Points (1/72").
Width and Height cannot be entered independently of each other unless you disable
Maintain Aspect Ratio.
Resolution
Enter the resolution in Pixels/Inch or Pixels/Centimeter. Resolution and the metric size
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cannot be entered independently of each other unless you enable Resample Image.
The default resolution is the resolution of the input image. If the input image does not
contain resolution information a default of 72 dpi applies.
The resolution you specify is saved in the output file only if the output format
supports resolution information. In order to get consistent results also when the
output format does not support resolution it is normally safe to use 72 dpi. Most
desktop applications assume a default resolution of 72 or 75 dpi.

Pixel Dimensions
You can enter the pixel dimensions in the lower part of the dialog provided that you
have enabled Resample Image.

The size of the image (assuming a raw, uncompressed format) is displayed at the top
of this box.

Options
Enable or disable Resample Image to control if you will allow resampling in order to
satidfy your image size requests.
If you enable resampling you can choose the resampling method. Select Replication,
Bilinear, or Averaging (default). These methods are explained in the topic Image
Scaling.

Maintain Aspect Ratio
Keep this box checked to maintain the aspect ratio of the input image. Width and
Height cannot be entered independently on each other; if one is entered the other is
automatically updated. If you want to set Width and Height independently you must
disable Maintain Aspect Ratio.

Quick Zoom
These buttons can only be used if Resample Image is enabled.
1:1
Press this button to reset the original pixel dimensions and resolution.
/2 and x2
Press /2 to zoom out to half the current image size, or x2 to zoom in to twice the
current image size.
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Send Attachment Dialog

The Send Attachment dialog is used to send a captured or imported image as an
e-mail attachment.
Use the Send To command in the File menu) to open the dialog.

File Type
Specifies the desired image file format. The default is BMP.
EasyCopy supports export of the file formats listed below.
Options
Press Options to open a File Type Options dialog. The available options depend on the
selected File Type.
Type

File
format

Default
extension

BMP

MS Windows Bitmap

.bmp

File Type Options

CALS

CALS Raster Type 1

.cal

File Type Options

CATIA

Catia raster picture

.picture

File Type Options

CGM

CGM cell array

.cgm

File Type Options

GIF

GIF (Compuserve)

.gif

File Type Options

HP STARBASE

HP Starbase

.stb

File Type Options

JPEG

JPEG

.jpg

File Type Options

JPEG 2000

JPEG 2000

.jp2

File Type Options
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PCX

PCX

.pcx

File Type Options

PBM (PPM)

Portable Bitmap

.pbm

File Type Options

PDF

Portable Document Format

.pdf

File Type Options

PNG

Portable Network Graphics

.png

File Type Options

RGB (SGI)

Silicon Graphics RGB

.rgb

File Type Options

SUN Raster

SUN Raster

.ras

File Type Options

TARGA

TARGA

.tga

File Type Options

TIFF

TIFF

.tif

File Type Options

XWD

X Window Dump

.xwd

File Type Options

Size
Press Image Size to open the Image Size dialog to specify the size of image.

Colors
Press Colors to open the Color Options dialog in which you can specify device
independent color modifications to the image before it is sent.

The color options only apply if you have enabled the check box next to Colors.
Color Options apply before File Type Options. For example, if you select Gray Scale in the Color
Options dialog and RGB in the File Type Options dialog, the image is reduced to gray scale, before it
is saved in a 24-bit RGB format. If you select Gray Scale in the File Type Options dialog the image is
reduced to gray scale and (if possible) saved in 8-bit gray scale format.

Stamp
Press Stamp to open the Stamp Options dialog in which you can specify a stamp to be
written diagonally across the image you send.

The stamp only applies if you have enabled the check box next to Stamp.
Label
Press Label to open the Label Options dialog in which you can specify one or more
lines to be written as a label near the edge of the image you send.

The label only applies if you have enabled the check box next to Label.
Attachment file name
An explicit file name to be used for the attachment can be specified in this box.
The default suggestion for the file name includes a standard extension that depends
on the selected file type. If the original input image included a standard extension this
is stripped off before the new extension is appended.
Examples:
Input file

Saved as CGM

Saved as JPEG

Saved as TIFF

sample.tif

sample.cgm

sample.jpg

sample.tif
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sample

sample.cgm

sample.jpg

sample.tif

sample.new

sample.new.cgm

sample.new.jpg

sample.new.tif

The default extension is only a suggestion. You can edit the file name and remove the suggested
extension. You will not get an extension appended behind your back.

Send
When you press the Send button these actions take place;
1. The image is converted to the format you have chosen. All options you have
selected in this dialog, in the File Type Options dialog or in the Image Size dialog
apply.
2. Your default e-mail program is opened, ready to create a new message. The
converted image has automatically been included as an attachment to this
message. All you have to do is to complete the To: and Subject: fields and type
the message body.
Example:

3. The Send Attachment dialog is closed when you have sent the message and
closed the e-mail program.
Copyright © 2003, AGI (autoGraph international), www.augrin.com.
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Mail Options Dialog
The information provided below applies to the UNIX versions of EasyCopy.

The Mail Options dialog is used to specify E-mail defaults. You need to set these
options before you can use the Send To dialog. Use the Mail command in the Options
menu to open the dialog.

Name and E-mail Address
This information is used in the "From" header created as part of a message. Supply
the information exactly as you specified it in the setup of your normal mail client
program, for example Netscape Mail.
Mail Server
Specify the host name or IP address of the server for outgoing mail (SMTP server).
The system administrator has normally specified a default mail server as an installation
task.
Copyright © 2003, AGI (autoGraph international), www.augrin.com.
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EasyCopy Montage
Montage is available with EasyCopy Gold

The Montage package extends EasyCopy to a tool for markup, annotation, and slide
preparation. You can add text and graphics to your image files or screen captures, and
you can mount several images on one page.
Topics

Main Window
Canvas
Objects
Zoom
Line Drawing
Filled Areas
Images
Crop
Color Replacement
Texts
Output from Montage
Save and restore a layout

How to Open Montage
You open Montage by clicking the Montage tool
of the Montage command in the File menu.

in EasyCopy's toolbar or by means

You may have an open image or screen capture in EasyCopy when you switch to
Montage; this image will then be present on the Montage canvas. You can, however,
treat this image like any other object on the canvas. You may, for example, delete it,
and it will disappear from the canvas, but it will still be open in EasyCopy when you
switch back.
How to Close Montage
You close the Montage session and return to EasyCopy by means of the Close
Montage command (or by closing the window ).

The Main Window in Montage
The main window contains these items:

Menu bar
Tool bar at the top
Tool boxes to the left
Canvas with rulers and optional Grid
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Status bar at the bottom

Menu Bar
The menu bar in Montage contains these menus:
File menu

New Layout
Open
Open Image
Open Layout
Capture
Window
Region
Screen
Repeat
Save
Save Layout
Save As Image
Selected Objects
Save As
Print
Send
Page Setup
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Printers
Printer Setup
Print
Send
Close Montage

Edit menu

Undo
Group
Ungroup
Duplicate
Order
Top
Up
Down
Bottom
Delete
Select All
Invert Selection
Select Next
Select Previous
Align
Left
Center
Right
Top
Middle
Bottom
Horizontal Mirror
Vertical Mirror
Transparency
Hide
Show Hidden
Lock
Unlock All

View menu

Zoom In
Zoom Out
No Zoom
Tool Bars
All
None
File Tools
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Draw Tools
Zoom Tools
Crop Tools
Text Tools
Help Tools
Tool Boxes
All
None
Edit Text
Line Options
Fill Options
Image Color
Rulers
Grid
Layout Status

Draw menu

Line Options
Fill Options
Line
Open Curve
Box
Ellipse
Polygon
Closed Curve
Change to
Open
Closed
Pick
Rubberband

Image menu

Colors
Layout
Replace Colors
1) Pick Old Color
2) Specify New Color
Go to
Crop
Uncrop
Information

Text menu

Add Text
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Add Symbol
Edit Text
Font
Color
Adjust
Left
Center
Right

Preferences menu

Units
Inches
Millimeters
Points
Dots
Capture
Grid

Help menu

Help Topics
AGI Web Site
License Server
About EasyCopy

Keyboard Accelerators
The Montage package supports these keyboard accelerators:
Left Arrow

Move the selected object(s) to the left

Right Arrow

Move the selected object(s) to the right

Up Arrow

Move the selected object(s) upwards

Down Arrow

Move the selected object(s) downwards

Delete

Delete the selected objects

BackSpace

Delete the selected objects

F1

Display Online Help for the Montage dialog

F12

Save the canvas as image

Tab

Select Next object

Tab

Select Previous object

+

Increase priority of the selected object

ALT

+

Give top priority to the selected object

CTRL

+

Zoom In (select Zoom cursor)

SHIFT
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-

Decrease priority of the selected object

ALT

-

Give bottom priority to the selected object

CTRL

-

Zoom Out

CTRL

*

No Zoom

CTRL

A

Select All

ALT

B

Bottom align the selected object

ALT

C

Center align the selected object

CTRL

E

Send the canvas as E-mail

CTRL

D

Duplicate the selected objects

CTRL

G

Group the selected objects

CTRL

I

Open an image

CTRL

K

Adjust image colors

ALT

L

Left align the selected object

CTRL

L

Adjust image layout

ALT

M

Middle align the selected object

CTRL

N

Open a new layout

CTRL

O

Open a layout and add it to the canvas

CTRL

P

Print the canvas

CTRL

Q

Close Montage

ALT

R

Right align the selected object

CTRL

S

Save the layout

ALT

T

Top align the selected object

CTRL

U

Ungroup the selected group

CTRL

Z

Undo previous change to the layout

Tool Bar
The tool bar is placed at the top of the dialog under the menu bar.
It is divided into these sections:
File
tools
Menu command

Keyboard

File > New Layout

CTRL+N

Create a new, empty canvas.

File > Open > Open Layout

CTRL+O

Insert a previously saved layout on the canvas.
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File > Open > Open Image

CTRL+I

Insert a previously saved layout on the canvas.

File > Save > Save Layout

CTRL+S

Save the current layout.

File > Print

CTRL+P

Print the current layout.

Repeat previous capture.

File > Capture > Repeat

Draw
tools
Menu command

Keyboard

Draw > Pick

Select pick mode to select one or more objects.

Draw > Line

Draw a polyline.

Draw > Open Curve

Draw an open curve.

Draw > Box

Draw a rectangular (or square) box.

Draw > Ellipse

Draw an ellipse (or a circle).

Draw > Polygon

Draw a closed polygon.

Draw > Closed Curve

Draw a closed curve.

Zoom
tools
Menu command

Keyboard

View > Zoom In

CTRL++

Select the zoom cursor

View > Zoom Out

CTRL+-

Return to the previous zoom level.

View > No Zoom

CTRL+*

Return to the original unzoomed canvas view.

Menu command

Keyboard

to drag a zoom area.

Crop
tools

Draw > Rubberband

Select the cross cursor to drag a rubberband
to be used for image crop.

Image > Crop

Crop the selected image to the area within the
rubberband.

Image > Uncrop

Restore the full image after it has been cropped.
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Text
tools
Menu command

Keyboard

Text > Add Text

Draw a text.

(font)

Text > Font

Select the text font.

(size)

Text > Font

Select the point size.

(color)

Text > Color

Select the text color.

Text > Font

Select bold text.

Text > Font

Select italic text.

Text > Font

Select underlined text.

Text > Adjust > Left

Select left adjusted text.

Text > Adjust > Center

Select centered text.

Text > Adjust > Right

Select right adjusted text.

Help
tool
Menu command

Keyboard

Help > Help Topics

CTRL+H

Display online help about the Montage Dialog.

If your display is less than 900 pixels wide the text tools will be placed below the other
tools.

Hiding the Tool Bar or Some of its Sections
You may hide the tool bar or some of its sections. This means that these parts do not
occupy space on your desktop, but also that you can no longer use the hidden tools.
You must then use their menu command or keyboard equivalents (if any).
To hide all parts of the Tool Bar do the following:
Click on View in the Menu Bar, select Tool Bars, select None.

To hide a section of the Tool Bar do the following:
Click on View in the Menu Bar, select Tool Bars. If the section you want to hide is
not already hidden its name is checked. Click on the name to hide that section.

To show all parts of the Tool Bar do the following:
Click on View in the Menu Bar, select Tool Bars, select All.

To show a section of the Tool Bar do the following:
Click on View in the Menu Bar, select Tool Bars. If the section you want to show is
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not already visible its name is not checked. Click on the name to show that section.

Tool Boxes
The tool boxes in the left side of the Montage dialog provide shotcuts for common
tasks.

You can setup which toolboxes are shown by means of the Tool Boxes commands in
the View menu.

By default all toolboxes are shown.
If you have hidden a toolbox you must use the corresponding menu commands.

Edit Text
When you add a new text or select a text object the contents of the text string is
shown in the edit box.

To edit the contents of the text you can do this in the edit box.
The edit box corresponds to the Edit Text dialog, except that it is smaller and not so
well suited for large amounts of text.

Line Options
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Fill Options

Image Options

Tranparency

Montage Canvas

The default canvas contains the current image open in EasyCopy scaled and
positioned according to the settings in the Layout dialog.

If you start Montage without an image you get an empty canvas.
The initial size of the canvas correspond to the current page size; this means, that it
depends on the current printer and the printer setup. The orientation of the canvas
corresponds to the setting in the Layout dialog.

Rulers
The canvas is shown with rulers to assist you when you position and resize objects.
The rulers are shown using the unit you have chosen in the Preferences menu. You
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may choose to hide the rulers by disabling Rulers in the View menu.

Grid
You can specify that the objects you place on the canvas should snap to a grid:

Use the Grid dialog to specify the distance between grid points, and to enable or
disable the "snap to grid" function.

The grid may be visible or invisible. You can set View Grid on or off either in the Grid
dialog or in the View menu.

When "snap to grid" is enabled it means that when you draw, move, resize, or edit an
object, the mouse will snap to the nearest grid point when you press or release a
butten. Also, when you move objects in steps by means of the arrow keys, the
object(s) will move to the nearest grid point in the desired direction.

When you enable "snap to grid" or if you change the grid distance it will not affect any
previously drawn objects (until you move, resize, or edit them). This will also be the
case when you import a previously saved layout.

How to Change Size or Orientation of the Canvas
You set the canvas size and orientation in the Page Setup dialog.

If you enable Set from Printer in the Page Setup dialog the canvas size will also
change

1. if you change printer (reflecting the actual page size of the new printer);
2. if you change page size in a Printer Setup dialog.

You can change the canvas orientation in two different ways:
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1. set the canvas orientation in the Page Setup dialog;
2. you may also change orientation in the Layout dialog.
When you change size or orientation of the canvas it may also change the relative size and position
of all the objects on the canvas, and you may have to rearrange the complete layout.
Use the "Scale objects ..." toggle at the bottom ofthe Page Setup dialog to get control over what
happens when you change the canvas size.

Copyright © 2004, AGI (autoGraph international), www.augrin.com.
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Montage File Menu

The File menu contains these commands:
New Layout
Use this command to create a new, empty canvas.
You can use the New Layout toolbutton
as equivalents to this command.

or the keyboard accelerator CTRL+N

The new layout will be created with the same page size as the previous layout. You
can change the page size of the canvas at any time by means of the Page Setup
command.

If your existing layout is unsaved when you ask for an empty canvas you get a
reminder:

Say Yes to open the Save Layout dialog, say No to continue and accept that the
previous layout is lost, or say Cancel to interrupt the creation of a new page and
return to the previous layout.

Open
Put the mouse on this command, and the side menu is unfolded:
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> Open Image
Use this command to open an image file and insert the image in your layout.
You can use the Open Image toolbutton
equivalents to this command.

or the keyboard accelerator CTRL+I as

The command opens the Open Image dialog to let you select an image.

> Open Layout
Use this command to open a previously saved layout and add its contents to the
current layout.
You can use the Open Layout toolbutton
as equivalents to this command.

or the keyboard accelerator CTRL+O

The command opens the Open Layout dialog to let you select a layout.

The result of inserting a layout depends on the current state of the canvas:

If the canvas is empty, the page size and orientation is changed according to
the size and orientation of the layout you insert.
If the canvas is not empty, the page size and orientation remains unchanged,
and the objects in the layout you insert are added to the current layout. All the
inserted objects become immediately selected (unless they are locked or
hidden).

Capture
Put the mouse on this command, and the side menu is unfolded:

> Window
Use this command to capture a single window.
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Move the mouse pointer to the desired window and click a mouse button.
What is captured depends on the way you point at the window.
Point inside the window
Capture window, excluding its frame.
Point at the window's frame
Capture window, including its frame.
Point at the desktop
Capture the full screen.
The selected window is captured and inserted as an image on the canvas.
> Region
Use this command to capture an arbitrary rectangle of the screen.
1. Move the mouse pointer to one corner of desired region and click a mouse
button.
2. Move the mouse pointer to the other corner of the region and click a mouse
button.
The selected region is captured and inserted as an image on the canvas.
> Full Screen
Use this command to capture the full screen. It is inserted as an image on the
canvas.
> Repeat
Use this command to repeat the previous capture operation.
The Capture Toolbutton

is an equvalent to this command.

Save
Put the mouse on this command, and the side menu is unfolded:

> Save Layout
Use this command to save the contents of the canvas as a layout file.
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You can use the Save Toolbutton
equvalents to this command.

or the keyboard accelerator CTRL+S as

The command opens the Save Layout dialog to let you specify the layout file.

> Save As Image
Use this command to save the contents of the canvas as an image file.
You can use the keyboard accelerator F12 as an equvalent to this command.

The command opens the Save Image dialog to let you specify the image file, then
image file format, its options, and the size of the image.

The image includes the complete canvas area, including the background space
around the objects. Use Selected Objects if you only want to save selected parts of
the canvas.

Selected Objects
Put the mouse on this command, and the side menu is unfolded:

> Save As
Use this command to save the selected objects on the canvas as an image file.
The command opens the Save Image dialog to let you specify the image file, then
image file format, its options, and the size of the image.

The image includes only the currently selected objects (as opposed to the
Save > Save As Image command which takes the whole canvas).

> Print
Use this command to print the selected objects on the canvas to the current
printer.
The command opens the Print dialog in which you get preview of the print page. It
also allows that you modify the page layout and color options before you start the
print job. to let you specify the number of copies.

The printed image includes only the currently selected objects (as opposed to the
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Print command which takes the whole canvas).

> Send
Use this command to to create an image of the selected objects on the canvas and
send it as an E-mail attachment.
The command opens the Send Attachment dialog to let you specify the image file
format, its options, and the size of the image.

The image includes only the currently selected objects (as opposed to the Send
command which takes the whole canvas).

Page Setup
Use this command to setup the size and orientation of the canvas.
The command opens the Page Setup dialog.

Printers
Use this command to select a printer.
The command opens the Printer Selection dialog.

Printer Setup
Use this command to specify printer specific options.
The command opens the Printer Setup dialog in which you can specify the printer
specific options.

Print
Use this command to print the contents of the canvas to the current printer.
You can use the Print Toolbutton
equvalents to this command.

or the keyboard accelerator CTRL+P as

The command opens the Print dialog in which you get preview of the print page. It
also allows that you modify the page layout and color options before you start the
print job. to let you specify the number of copies.

The image includes the complete canvas area, including the background space
around the objects. Use Selected Objects if you only want to save selected parts of
the canvas.

Send
Use this command to create an image of the canvas area and send it as an E-mail
attachment.
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You can use the keyboard accelerator CTRL+E as an equvalent to this command.

The command opens the Send Attachment dialog to let you specify the image file
format, its options, and the size of the image.

Windows users: You need a MAPI32 compliant E-mail client to use the Send
command.

UNIX users: You need a connection to a mail server to use the Send command.
Use the Options > Mail command in EasyCopy's Main window to do this.

The image includes the complete canvas area, including the background space
around the objects. Use Selected Objects if you only want to send selected parts of
the canvas.

Close Montage
Use this command to close the montage dialog.
You can use the keyboard accelerator CTRL+Q as an equvalent to this command.
If your existing layout is unsaved when you want to close Montage you get a
reminder:

Say Yes to open the Save Layout dialog, say No to continue and accept that the
layout is lost, or say Cancel to interrupt the command and stay in Montage.

Copyright © 2003, AGI (autoGraph international), www.augrin.com.
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Montage Edit Menu

The Edit menu contains these commands:
Undo
Use this command to undo the latest change to the layout (an unintended move
operation, for instance). Undo is only available in one level, and it is not
implemented for all operations. For example, an object you draw cannot be undone
(but on the other hand you may easily delete it again).
You can use the keyboard accelerator CTRL+Z as an equvalent to this command.

Group
Use this command to create a group containing all currently selected objects.

You can use the keyboard accelerator CTRL+G as an equvalent to this command.

The command is only available when you have at least two objects selected.
The group is treated as one single object. This means that you can no longer select
its member objects individually.
Use the Ungroup command if you want to break down the group and get the
individual objects back.
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Ungroup
Use this command to break a group down into its member objects.
You can use the keyboard accelerator CTRL+U as an equvalent to this command.

The command is only available when you have selected one group and no other
objects.
The group members are no longer treated as one object. You can now select its
member objects individually.
Duplicate
Use this command to duplicate one or more objects.
You can use the keyboard accelerator CTRL+D as an equvalent to this command.

The command is only available when you have at least one object selected.
The duplicates are created with a small offset relative to the original objects. The
original objects are no longer selected. In stead the selection is changed to include
the duplicates. This makes it easy to produce multiple duplicates: just press
CTRL+D as many times as you want another duplicate.
Order
The Order commands are used to change the drawing priority.
They are available when there is only one selected object.
Put the mouse on the command, and the side menu is unfolded:

> Top
Use this command to put the selected object on top of any other object.
You can use the keyboard accelerator ALT++ (press the keys ALT and +
simultaneously) as an equvalent to this command. (You may use ALT and the +
key in the numeric key pad in the right side of the keyboard if you have enabled the
NumLock key).
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The object on the top is drawn last.
> Up
Use this command to increase the drawing prioruty of an object by one.
You can use the keyboard accelerator + as an equvalent to this command. (You
may use the + key in the numeric key pad in the right side of the keyboard if you
have enabled the NumLock key).

> Down
Use this command to decrease the drawing prioruty of an object by one.
You can use the keyboard accelerator - as an equvalent to this command. (You
may use the - key in the numeric key pad in the right side of the keyboard if you
have enabled the NumLock key).

> Bottom
Use this command to put the selected object on the bottom of the priority list.
You can use the keyboard accelerator ALT+- as an equvalent to this command.
(You may use ALT and the - key in the numeric key pad in the right side of the
keyboard if you have enabled the NumLock key).

The object at the bottom is drawn first.
Delete
Use this command to delete one or more objects.
You can use the Del key as a keyboard accelerator for this command.

The command is only available if you have one or more objects selected.
Select All
Use this command to select all selectable objects on the canvas.
Hidden and locked objects are not selectable.
Invert Selection
Use this command to invert the current selection. This means that all selected
objects become unselected, and all selectable objects that were not selected now
become selected.
The command is only available if you have one or more objects selected (otherwise
use Select All).
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Select Next
Use this command to select the next selectable object in sequence of priority.
You can use the Tab key as a keyboard accelerator for this command.

If no object is selected when you use this command the first object (the one with
top priority) will be selected. Otherwise the command will select the object after the
one with highest priority among the selected objects. The sequence is cyclic, so of
the last object (the one with bottom priority) is selected the next object is the first
object.
Select Previous
Use this command to select the previous selectable object in sequence of priority.
You can use SHIFT+Tab as a keyboard accelerator for this command.

The command works like Select Next, except that it steps backwards through the
objects.

Align
The Align commands are used to align objects.
They are available when there are at least two selected objects.
Put the mouse on the command, and the side menu is unfolded:

> Left
You can use ALT+L as a keyboard accelerator for this command.
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> Center
You can use ALT+C as a keyboard accelerator for this command.

> Right
You can use ALT+R as a keyboard accelerator for this command.

> Top
You can use ALT+T as a keyboard accelerator for this command.

> Middle
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You can use ALT+M as a keyboard accelerator for this command.

> Bottom
You can use ALT+B as a keyboard accelerator for this command.

Horizontal Mirror
Use this command to mirror one or more objects horizontally.
The command is only available if you have one or more objects selected.
Vertical Mirror
Use this command to mirror one or more objects vertically.
The command is only available if you have one or more objects selected.
Transparency
Use this command to specify transparency of the selected object on the canvas.
The command is available if you have selected a single object (not a group).
The command opens the Transparency dialog in which you can specify the
transparency.

Hide
Use this command to hide one or more objects.
The command is only available if you have one or more objects selected.
Hidden objects are no longer visible on the canvas, they are not printed, they are
not visible if you save or send the layout as an image. They are, however, saved if
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you save the Layout, but still invisible when the saved layout is restored.

Use Show Hidden to make the hidden objects visible (and selectable) again.

The purpose of hidden objects is to make certain objects temporarly invisible. This
gives you an easy switch between two versions of a layout, for example a map or
an aerial photo with or without annotation.

Version without hidden objects

Version with some hidden objects
Show Hidden
Use this command to make hidden objects visible and selectable.

Note, that there is no way to select just one hidden object and make that object
visible. This is because a hidden object cannot be selected as long as it is hidden.

It may be a good idea to group objects before they are hidden. This makes it much
easier to manage the situation if you need to make only some of the hidden objects
visible: Use Show Hidden, select the group you want, use Invert Selection, and
then hide the unwanted groups.
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Lock
Use this command to lock one or more objects.
The command is only available if you have one or more objects selected.
Locked objects are visible, but not selectable.
Use Unlock All to make the locked objects selectable.

The purpose of locked objects is to secure them against being selected and
modified by mistake. If you want to make a sequence of layouts with a common
"template" you can first create the "template". Then Select All, Lock, and Save
Layout. You can now add the objects that you want for the first layout. When you
have saved the first layout you can use Select All and Delete to wipe out everything
except the common "template". You can also create new layouts to the sequence
in a later Montage session if you start by selecting the saved "template" in Open
Layout.

You can also use a saved layout with locked objects as a fixed overlay that you add
as a "top layer" by inserting it before you print your canvas.
Unlock All
Use this command to unlock any locked objects and make them selectable again.
There is no way to unlock just one locked object. This is because a locked object is
not selectable, so when an object is locked the key is thrown away. Unlock All is the
only option for unlocking. The remarks given for Show Hidden are also relevant for
Unlock All.
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Montage View Menu

The View menu contains these commands:
Zoom In
Use this command to select the zoom cursor

to zoom in the canvas view.

or the keyboard accelerator CTRL++
You can use the Zoom In toolbutton
(press the keys CTRL an + simultaneously) as equivalents to this command. (You
may use CTRL and the + key in the numeric key pad in the right side of the
keyboard if you have enabled the NumLock key).

When you have a zoomed view there will be scroll bars at the bottom at to the right
of the canvas, so you can still navigate to any point of the canvas.
There are two modes of zoom: stepwise or area zoom.
Stepwise Zoom:
move it to the position you want as
When you have selected the zoom cursor
center for the zoomed view and click the left mouse button.

This will zoom in by a factor of 2:
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Area Zoom
When you have selected the zoom cursor
one corner of the zoomed view.

move it to the position you want as

Press the left mouse button, and keep it pressed as you drag a rectangle.

When the mouse button is released you zoom into the selected area:
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The zoom factor depends on the size of the rectangle.
You cannot zoom in by a factor > 16. This is because larger zoom factors would
require so much system memory that it might slow down your system to an
unacceptable level, or even kill it.
You may zoom in in succesive steps, but the net zoom factor must still not exceed
16.
Zoom Out
Use this command to zoom out to the previous zoom level.

or the keyboard accelerator CTRL+You can use the Zoom Out toolbutton
(press the keys CTRL and - simultaneously) as equivalents to this command. (You
may use CTRL and the - key in the numeric key pad in the right side of the
keyboard if you have enabled the NumLock key).

This command is only available if you have a zoomed view.
No Zoom
Use this command to zoom out to an unzoomed view.
You can use the No Zoom toolbutton
equivalents to this command.

or the keyboard accelerator CTRL+* as

This command is only available if you have a zoomed view.
Tool Bars
These commands determine which sections of the Tool Bar are shown.

Put the mouse on the command, and the side menu is unfolded:
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> All
Use this command to show all tool bar sections. This is the default.
> None
Use this command to hide all tool bar sections.
When a tool bar is hidden you must use the menu command(s) for which the
desired tools are shortcuts. Refer to the description of the tool bar.

> File Tools
Use this command to toggle the File tools off or on.

> Draw Tools
Use this command to toggle the Draw tools off or on.

> Zoom Tools
Use this command to toggle the Zoom tools off or on.

> Crop Tools
Use this command to toggle the Crop tools off or on.

> Text Tools
Use this command to toggle the Text tools off or on.
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> Help Tool
Use this command to toggle the Help tool off or on.

Tool Boxes
These commands determine which Tool Boxes are shown

Put the mouse on the command, and the side menu is unfolded:

> All
Use this command to show all tool boxes. This is the default.
> None
Use this command to hide all tool boxes.
When a tool box is hidden you must use the menu command(s) for which the
desired tools are shortcuts. Refer to the description of the tool boxes.

> Edit Text
Use this command to toggle the box for text editing off or on.

> Line Options
Use this command to toggle the Line Options box off or on.
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> Fill Options
Use this command to toggle the Fill Options box off or on.

> Image Color
Use this command to toggle the Image Color box off or on.

Rulers
Use this command to hide or show the rulers at the top and to the left of the
canvas. The rulers are shown by default.

Grid
Use this command to hide or show the grid on the canvas. The grid is hidden by
default.

Layout Status
Use this command to hide or show the Status Display.
It is hidden by default.

This display may be useful if you have many objects and the canvas behaviour is
different from what you expect. The explanation might be that some objects are
locked or hidden, or you may have grouped objects.
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The display only counts "top level" objects. This means that a group of objects
count as one object, no matter how many objects or nested groups are in the
group.
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Montage Draw Menu

The Draw menu contains these commands:
Line Options
Use this command to specify options for lines and curves.
The command opens the Line Options dialog.

The most commonly used line options can also be set in the Line Options tool box.

Fill Options
Use this command to specify options for filled areas.
The command opens the Fill Options dialog.

The most commonly used fill options can also be set in the Fill Options tool box.

Line
Use this command to initiate the drawing of a polyline.
The Line Toolbutton

is an equvalent to this command.

The cursor changes into a cross . Move the cursor into the canvas and click to
set the first point of the line. Move it to a new position and click to set the next
point. A click on the left mouse button means, that you intend to add more points.
Use the right mouse button to set the last point.
The line will inherit the current line property settings.
Open Curve
Use this command to initiate the drawing of an open Bezier curve.
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The Curve Toolbutton

is an equvalent to this command.

The cursor changes into a cross . Move the cursor into the canvas and click to
set the first point of the curve. Move it to a new position and click to set the
direction of the curve tangent in the first point. Then move it to a new position and
click to set the next point. Repeat this sequence of direction/point operations to add
more points. A click on the left mouse button means, that you intend to add more
points. Use the right mouse button to set the last point.
The curve will inherit the current line property settings.
Box
Use this command to initiate the drawing of a rectangular box.
The Box Toolbutton

is an equvalent to this command.

The cursor changes into a cross . Move the cursor into the canvas and click to
set one corner of the box. Move it to a new position and right click to set the
opposite corner.
Keep the SHIFT button pressed when you drag the box to force the box to be
square.
The box will inherit the current fill property settings for the interior and the current
line property settings for the edge (arrow head and tail settings are ignored).
Ellipse
Use this command to initiate the drawing of an ellipse.
The Ellipse Toolbutton

is an equvalent to this command.

The cursor changes into a cross . Move the cursor into the canvas and click to
set one corner of the bounding box of the ellipse. Move it to a new position and
right click to set the opposite corner.
Keep the SHIFT button pressed when you drag the bounding box to force a circle.

The ellipse will inherit the current fill property settings for the interior and the current
line property settings for the edge (arrow head and tail settings are ignored).
Polygon
Use this command to initiate the drawing of a closed polygon.
The Polygon Toolbutton

is an equvalent to this command.

The cursor changes into a cross . Move the cursor into the canvas and click to
set the first corner of the polygon. Move it to a new position and click to set the
next corner. A click on the left mouse button means, that you intend to add more
263

points. Use the right mouse button to set the last point. The last point you set need
not be identical to the first point. The polygon is closed automatically by adding the
last part of the boundary.
The polygon will inherit the current fill property settings for the interior and the
current line property settings for the edge (arrow head and tail settings are
ignored).
Closed Curve
Use this command to initiate the drawing of a closed Bezier curve.
The Closed Curve Toolbutton

is an equvalent to this command.

The cursor changes into a cross . Move the cursor into the canvas and click to
set the first point of the curve. Move it to a new position and click to set the
direction of the curve tangent in the first point. Then move it to a new position and
click to set the next point. Repeat this sequence of direction/point operations to add
more points. A click on the left mouse button means, that you intend to add more
points. Use the right mouse button to set the last point. The last point you set need
not be identical to the first point. The curve is closed automatically by adding the
last part of the boundary.
The curve will inherit the current fill property settings for the interior and the current
line property settings for the edge (arrow head and tail settings are ignored).
Change to
Put the mouse on this command, and the side menu is unfolded:

> Open
This command is available if you have selected a polygon or a closed curve. It
changes the object into a polyline or an open curve.
The line properties (the edge of the closed object) are retained. The fill properties
are suspended. However, if you later change it back into a closed object the
previous fill properties are restored.
If the object previously in its life cycle has been open, its previous arrow properties
are restored.
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> Closed
This command is available if you have selected a polyline or an open curve. It
changes the object into a polygon or a closed curve.
The line properties are retained and used for the edge of the closed object. Arrow
head and tail are suspended. However, if you later change it back into an open
object the previous arrow properties are restored.
The fill properties are inherited from the current settings, unless the object
previously in its life cycle has been closed, in which case its previous fill properties
are restored.
Pick
Use this command to return to pick mode.
The Pick Toolbutton

is an equvalent to this command.

Pick is the normal mode. The cursor is the arrow
objects.

which you can use to select

Rubberband
Use this command to draw a rubberband.
The Rubberband Toolbutton

is an equvalent to this command.

The rubberband is used for image crop. You must therefore have a single image
object selected before you can use the rubberband. It is possible to draw the
rubberband and select the image afterwards.
Refer to the topic image crop for more information.
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Montage Image Menu

The Image menu contains these commands:
Colors
Use this command to specify color adjustment or special color options to an image.
You can use the keyboard accelerator CTRL+K as an equivalent to this command.

The command is available if you have selected a single image object.
The command opens the Color Options dialog in which you can adjust colors,
remove background colors, or set special options.
If you have applied color replacement to the selected image the results of using Color Options
may be surprising. The Color Options dialog does not take color replacement into account, so it
will preview your original image, and the options you specify may conflict with the previously
specified replacements.

If you need both color options and color replacement you should specify color options before
color replacement to get consistent results.

Layout
Use this command to specify scale and position of the selected image on the
canvas.
You can use the keyboard accelerator CTRL+L as an equivalent to this command.

The command is available if you have selected a single image object.
The command opens the Image Layout dialog in which you can specify image scale
and position.

Replace Color
Use this command to perform color replacement.
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You can also use the Image Color toolbox. This will often be more convenient. The
command is available for the case that you have hidden the toolbox.

Put the mouse on the command, and the side menu is unfolded:

> 1) Pick Old Color
This first step is used to pick the color you want to replace in an image. The cursor
is changed into a cross . Move it to point at an image pixel with the color you
want to replace. If the image is not already selected it will be selected, but nothing
else happens, until you have completed step 2.

> 2) Specify New Color
This second step is used to specify the new color. It opens the Color Selection
dialog in which you specify any RGB color you want to use as replacement.

All pixels in the image that have the color picked in step 1 will now be replaced by
the color selected in step 2.
You cannot select transparency by means of the menu. You must use the Image Color toolbox if
you want transparency.

Go To
Use this command to go to another page of a multipage image file.
The command is available if you have selected a single image object, and this is a
multipage image. The command opens the Go To dialog in which you can select
another page.

Crop
Use this command to crop an image to a rubberband.
You can use the Crop toolbutton

as an equivalent to this command.

The command is available if you have selected a single image object.
Refer to the topic Image Crop in Montage for further details about image crop.

Uncrop
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Use this command to uncrop an image, that is change it back to its original extent.
You can use the Uncrop toolbutton

as an equivalent to this command.

The command is available if you have selected a single image object, and this has
been cropped.
Refer to the topic Image Crop for further details about image crop.

Information
Use this command to display information about an image.
The command is available if you have selected a single image object.
The command opens the Image Information dialog which contains available
information about the selected image.
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Montage Text Menu

The Text menu contains these commands:
Add Text
Use this command to put a text on the canvas.
You can use the Text toolbutton

as an equivalent to this command.

The cursor changes into a text entry cursor . Move it to the position where you
want to start the text, click the left mouse button, and begin typing. The text is
created using the current font, text color, point size, and adjustment.
Add Symbol
Use this command to put a single symbol on the canvas. This is basically the same
as adding a text containing only one character. It is used when the character
cannot easily be entered from the keyboard.
The command will first open the Symbols dialog in which you can select the font
that contains the symbol and the symbol itself.

When you have selected a symbol amd closed the dialog the cursor changes into a
text entry cursor . Move it to the position where you want to put the symbol, and
click the left mouse button. The symbol is created using the selected font, text
color, and point size.

Edit Text
Use this command to edit the contents of the selected text object.
The command is available when you have selected a single text object.
The command opens the Text Edit dialog in which you can modify the contents of
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the text or add more text to the object.
You will normally only use this command if you have hidden the Text Edit toolbox or
if you have a relatively large amount of text. The Text Edit toolbox will in most
cases be faster to use than the dialog.

Font
Use this command to specify the font to be used.
The command opens the Font dialog in which you can select the font and its size
and style options.

These selections are also available in the Text toolbar, so you would normally only
use the dialog if you have hidden the toolbar.

The font specification will be used for text objects you add to the layout.
It will also apply to any text objects you have selected at the time the font is
changed as well as text objects in selected groups.
Color
Use this command to specify the text color.
The command opens the Color Selection dialog in which you specify any RGB color
you want.

Text color selection is also available in the Text toolbar which in many cases
provides an easier way to change text color. However, the toolbar may be hidden in
which case you only have this command.

The color selection will be used for text objects you add to the layout.
It will also apply to any text objects you have selected at the time the font is
changed as well as text objects in selected groups.
Adjust
Put the mouse on this command, and the side menu is unfolded:

> Left
Left adjust the text. The Left Adjust toolbutton
command.

is an equivalent to this
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> Center
Center the text. The Center toolbutton

is an equivalent to this command.

> Right
Right adjust the text. The Right Adjust toolbutton
command.

is an equivalent to this
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Montage Preferences Menu

The Preferences menu contains these commands:
Units
Use this command to select your preferred Units of Measurement.
Put the mouse on this command, and the side menu is unfolded:

Choose among these units:
Inches
Millimeters
Points
We define a point "the PostScript way", namely 1/72 inch. This is almost the
same as a traditional "typographical" point.
Dots
This will give a measure in units of dots for the currently selected printer.
The selected units are used to layout the rulers and will also be the default unit in
the Image Layout dialog, the Page Setup dialog, and other places where you can
specify a measure.

Capture
Use this command to setup your screen capture preferences.
The command opens the Capture Options dialog.

Grid
Use this command to specify options for the grid.
The command opens the Grid dialog.

Pen Assignment
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Montage Help Menu

The Help menu contains these commands:
Help Topics
Use this command to display online help about the Montage Dialog.

You can use the Help toolbutton
to this command.

or the keyboard accelerator F1 as equivalents

The Help Viewer gives you easy access to any other page of the online
documentation by means of

Hyper links
The Table of Contents
The alpabetical Index
UNIX users: The online help is shown in a Web browser window, and work best with Netscape.
The interface to Netscape or another browser must be configured when EasyCopy is installed.
273

AGI Web Site
Use this command to open AGI's home page www.augrin.com (if you have access
to the internet). in your default Web browser.
Windows users: EasyCopy will automatically select your default Web browser.

UNIX users: The interface to a Web browser must be configured when EasyCopy is installed.

License Server
Use this command to display the output from the eclic program in a command
prompt window.
Windows 98 and Windows NT 4.0: The command prompt window is limited to 24 lines. If the
message from the license server exceeds 24 lines you will only see the last 24 lines. (This
problem does not exist in Windows 2000 and Windows XP as the command prompt window
has a scrollbar).

UNIX users: This command is not available in the user interface. You may start eclic by typing
the eclic command in a console or terminal window.

About EasyCopy
Use this command to display the About EasyCopy information box.
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Color Selection Dialog

This dialog is used to select a specific color to be used as line color, fill color, text color
or image color.
It defines 48 "basic colors" shown in the upper left part. Click on one of these to select
that color.
You can also select a color in the color diagram in upper right part. The horizontal axis
of this diagram is hue, the vertical is saturation. Colors at the top of the diagram are
thus fully color saturated and colors at the bottom are gray. The horizontal slider to the
right of the diagram is used to adjust the brightness. At the bottom of the slider
(brightness = 0) any combination of hue and saturation become black. At the top you
get bright colors.
This dialog employs the HSV color model (V means brightness!). It differs from the HLS color model
used in many other contexts by the definition of range for brightness and the interdependency
between brightness and saturation.

You may specify HSV values explicitly by typing numbers in the fields Hue, Saturation,
and Value (range 0-255).
The color may also be specified as RGB values typed into Red, Green, and Blue.
In the lower left part of the dialog there are 16 slots for "Custom Colors". When you
have selected a color (which is not already a basic color) and want to have this color
available later for reuse, you can on the slot in which you want to put the color and the
press the buttom Add to Custom Colors.
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If you click Add to Custom Colors before you have selected a slot the color will go into the first slot
and may thus overwrite one of your previously saved custom colors.

Unlike the colors in the color popup panels in the tool boxes the custom colors are one
common pool, no matter what type of object the color is selected for.
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Page Setup Dialog
Use this dialog to specify the size and orientation of the canvas.

You open this dialog by means of the Page Setup command in the File menu.

Orientation
Choose between Portrait and Landscape.
Canvas Size
You can specify the size of the canvas by several methods:
(1) Standard Format
Select a page size from a list of approximately 30 standard formats in the
drop-down menu.
The standard format called Slide is is useful if you want to produce 24x36 mm film slides. It is
defined as 11 inches wide and an aspect ratio of 2:3 (7.33 inches high). This format is accepted
by most film recorders.

(2) Set from Printer
Enable this option to set a canvas size that matches the paper size selection in
the current printer setup. This selection will also set canvas margins that reflect
the printer setup. It is useful if you want to make a layout that should print to a
given scale on a given printer.
In order to ensure that you print exactly what you see on the canvas you should verify that scale is
1:1 in the Page Layout dialog (press Page Layout when you enter the Print dialog.

If the current printer setup specifies a standard paper size known in the list of
formats mentioned above, the drop-down menu changes to display that format.
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Otherwise it changes to display Custom.
The canvas size will automatically be changed to match a new paper size if you
later change the printer setup, and Set from printer is enabled.
If you disable the Set from printer option you will keep the selected size, but the
margins will default to zero.
(3) Set from Image
This option is available if you had selected a single image object when you
opened the dialog. Enable this option to make the canvas fit the metric size of
the selected image.
The image will thus become the background of the canvas. This is for instance
useful if you intend to save an annotated image.
It is a good idea afterwards to force the image to the bottom and to lock the image.

(4) Custom Size
You can specify any size you want by typing the dimensions into the fields
Width and Heigth.
The dimensions are by default displayed in the units you have selected in the
Preferences menu. However, you may type the dimensions in any of these
units:

in (inches)
cm (centimeters)
mm (millimeters)
pt (points)
Specification of a non-default unit in this place will not affect the default, so next
time you enter the dialog the dimensions will be shown in the default unit no
matter how they were specified.
Margins
You can specify the canvas size with or without margins. The margins have no
functional meaning, they only serve the purpose of guide lines. The layout is only
clipped along the margins if they correspond to actual printer margins and you print
the layout.
The margins will be set as reported by the printer driver if your canvas size is
inherited from a printer setup. This enables you to see if any of your objects exceed
the margins.
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Scale Objects
Keep the checkbox enabled

if you want to scale all objects (including hidden and locked objects) proportionally
to fit the new canvas size.
This is useful, for example if your layout is created using A4, and you want to print
a poster in A0 size.

Unused space to the right and below all objects is ignored if you scale the page and
also switch between Portrait and Landscape.
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Grid Dialog
The Grid dialog is used to set grid options.

Horizontal Density and
Vertical Density
The distance between grid points. The values are displayed in the unit you have
chosen in the Preferences menu. However, you may type the dimensions in any of
these units:

in (inches)
cm (centimeters)
mm (millimeters)
pt (points)
Same in both Directions
If this checkbox is enabled the vertical density will be identical to the horizontal
density. You must disable the checkbox to enter the values independently.
Snap to Grid
The grid settings are only in effect when this checkbox is enabled.
View Grid
Determines whether the grid points on the canvas are visible or not. You may also
toggle View Grid in the View menu.
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Montage Objects
The graphics objects are lines, curves, filled areas, texts and images. In order to
perform operations on one or more objects you must select the objects.

Select Objects
Any operation you specify in the Montage dialog will always apply to the selected
object(s).
You select an object by clicking on it with the Pick tool . You can see that the object
is selected when its bounding box is shown:

To select more than one object you can click on each of them while keeping the Shift
key down. You may also drag a rectangle (keep left mouse button down) to fence the
objects you want to select.

You can add more objects to the selection when you click with the Shift key down;
otherwise any previous selection is released when you make a new selection.
If you click outside any objects all selected objects are released.
You can select all objects (except hidden or locked objects by means of the Select All
command in the Edit menu.

You can invert your selection (release all selected objects and select all unselected
objects) by means of the Invert Selection command in the Edit menu. This can be
useful if you want to select all objects, except one or a few. Then you start by selecting
the objects you not want to select, and then apply Invert Selection.

You can step cyclicly through the available objects by means of the Tab key (forward)
or SHIFT+Tab (backwards). The commands Select Next and Select Previous in the
Edit menu have the same effect.
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Move Objects
When the cursor is over a selected object it changes into a Move tool . If you keep
the left mouse button pressed you can move the object with the cursor.

If you have selected more than one object you can move them in one operation. The
cursor is shown when the cursor is inside the bounding box of the selection.
You can also move objects in steps of 5 points by means of the arrow keys.

Object Alignment
You can align two or more objects vertically or horizontally.
Select the objects you want to align and use one of the Align commands in the Edit
menu.

You can also use keyboard accelerators:

Left

Center

Right

ALT+L

ALT+C

ALT+R
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Top

Middle

Bottom

ALT+T

ALT+M

ALT+B

Resize Objects
Near the edges and corners of the bounding box of a selection the cursor changes into
a Resize tool.

If you keep the left mouse button pressed you can resize the image with the cursor. If
you drag a corner the aspect ratio of the object is preserved (the object is scaled). If
you drag an edge the object is stretched.
You cannot stretch text objects. They will always keep their aspect ratio. This also applies if you
stretch a selection of multiple objects or a group: the text will keep its aspect ratio, whereas the other
objects will be stretched.

Image objects can also be scaled or stretched in the Image Layout dialog.

Delete Objects
You can delete selected objects from the canvas by means of the Delete key on the
keyboard. You can also use the BackSpace key or the Delete command in the Edit
menu.

Object Priority
Objects are by default drawn in the order in which they are created. The drawing order
is important because objects may cover each other.
You can change the object priority. Select an object and press the + key to increase its
priority by one, the - key to decrease its priority by one, ALT and + pressed
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simultaneously to give the object top priority, or ALT and - pressed simultaneously to
give the object bottom priority.
The Order commands in the Edit menu have the same effect.

Grouped Objects
When you have a selection of two or more objects you can group the objects. A group
is treated as a single composite object. You can move and resize the group as one
object, and you can change any of their compatible attributes (for example fill color)
together, but you can not access the individual members of the group.
You make a group out of a selection by pressing CTRL+G or by means of the Group
command in the Edit menu.

A group can become member of another group in a later selection.
If you want to break a group down into individual objects you select the group and
press CTRL+U or use the Ungroup command in the Edit menu.

Object Duplication
You can create a duplicate of one or more objects by selecting the object(s), and the
press CTRL+D or use the Duplicate command in the Edit menu.

Press CTRL+D again to make more duplicates. Each new duplicate is placed 25 points
below and to the right of its source, and the duplicated object(s) become selected in
place of the source.

Hidden Objects
You can hide objects. Select one or more objects and use the Hide command in the
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Edit menu.

Hidden objects are no longer visible on the canvas, they are not printed, they are not
visible if you save or send the layout as an image. They are, however, saved if you
save the Layout, but still invisible when the saved layout is restored.

The purpose of hidden objects is to make certain objects temporarly invisible. This
gives you an easy switch between two versions of a layout, for example a map or an
aerial photo with or without annotation.

Version without hidden objects

Version with some hidden objects
To make hidden objects visible again you must use the Show Hidden command in the
Edit menu.

Note, that there is no way to select just one hidden object and make that object visible.
This is because a hidden object cannot be selected as long as it is hidden.

It may be a good idea to group objects before they are hidden. This makes it much
easier to manage the situation if you need to make only some of the hidden objects
visible: Use Show Hidden, select the group you want, use Invert Selection, and then
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hide the unwanted groups.

Locked Objects
You can lock objects. Select one or more objects and use the Lock command in the
Edit menu.

Locked objects are visible, but not selectable.
The purpose of locked objects is to secure them against being selected and modified
by mistake.
This might for instance be an object that serves as "background" for the layout (an
image or a rectangle that occupies the entire canvas).
Another example is that you want to make a sequence of layouts with a common
"template". First, create the "template". Then use the Select All command, Lock, and
Save Layout.

You can now add the objects that you want for the first layout. When you have saved
the first layout you can use Select All and Delete to wipe out everything except the
common "template". You can also create new layouts to the sequence in a later
Montage session if you start by selecting the saved "template" in Open Layout.

You can also use a saved layout with locked objects as a fixed overlay that you add as
a "top layer" by inserting it before you print your canvas.

Layout Status
You can get a summary of the objects on the canvas in the Status Display which can
be shown below the Tool Boxes. It is hidden by default.

Use the Layout Status command to show or hide the status display.

The status display may be useful if you have many objects and the canvas behaviour
is different from what you expect. The explanation might be that some objects are
locked or hidden, or you may have grouped objects.
The summary only counts "top level" objects. This means that a group of objects count
as one object, no matter how many objects or nested groups are in the group.
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Zooming into the Montage Canvas
You can zoom your view of the canvas up to a net factor of 16.

Zoom In
Select the zoom cursor
by means of the Zoom In toolbutton or the Zoom In
command in the View menu.

You can also use the keyboard accelerator CTRL++ (press the keys CTRL an +
simultaneously). You may use CTRL and the + key in the numeric key pad in the right
side of the keyboard if you have enabled the NumLock key.

When you have a zoomed view there will be scroll bars at the bottom at to the right of
the canvas, so you can still navigate to any point of the canvas.
There are two modes of zoom: stepwise or area zoom.
Stepwise Zoom:
move it to the position you want as
When you have selected the zoom cursor
center for the zoomed view and click the left mouse button.

This will zoom in by a factor of 2:
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Area Zoom
When you have selected the zoom cursor
corner of the zoomed view.

move it to the position you want as one

Press the left mouse button, and keep it pressed as you drag a rectangle.

When the mouse button is released you zoom into the selected area:

The zoom factor depends on the size of the rectangle.
You cannot zoom in by a factor > 16. This is because larger zoom factors would
require so much system memory that it might slow down your system to an
unacceptable level, or even kill it.
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You may zoom in in succesive steps, but the net zoom factor must still not exceed 16.

Zoom Out
You can zoom out to the previous zoom level by means of the Zoom Out toolbutton
or the Zoom Out command in the View menu.

You may also use the keyboard accelerator CTRL+- (press the keys CTRL and simultaneously). You may use CTRL and the - key in the numeric key pad in the right
side of the keyboard if you have enabled the NumLock key.

Zoom Out is only available if you have a zoomed view.

No Zoom
Get back to an unzoomed view by using the No Zoom toolbutton
command in the View menu.

or the No Zoom

You can also use the keyboard accelerator CTRL+*. These controls are only available
if you have a zoomed view.
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Line Drawing
Lines
To draw a straight line from one point to another do as follows:

or use the Line command in the Draw menu.
Select the Line tool
Move the cursor which now has changed to a cross
to the point on the canvas
where the line should start and click the left mouse button.
Move the cursor to the point on the canvas where the line should end and click the
right mouse button.

The line will be drawn according to the current settings of line properties.

Polylines
A polyline is a sequence of points connected by straight lines. It is drawn by extending
the procedure described above to multiple points.

or use the Line command in the Draw menu.
Select the Line tool
Move the cursor which now has changed to a cross
to the point on the canvas
where the line should start and click the left mouse button.
Move the cursor to the next line point and click the left mouse button.
Repeat this step until the cursor points to the last point. The last point is set by
clicking the right mouse button.

Line Editing
You can edit a line after it has been drawn. When the line object is selected you will
see, that the line points are marked.
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When you move the cursor over one of the line points the cursor changes into a cross
. If you press the left mouse button you can drag the point to a new position.
Release the mouse at the position where you want to move the line point.

Open Bezier Curves
Drawing of Bezier curves is a little more complicated than straight lines, because you
need to set two informations for each point, namely the point itself and the direction of
the curve tangent in the point.

or use the Curve command in the Draw menu.
Select the Curve tool
Move the cursor which now has changed to a cross
to the point on the canvas
where the curve should start and click the left mouse button.
Move it to a new position and left click to set the direction of the curve tangent in
the first point.
Move the cursor to the next curve point and click the left mouse button.
Repeat these two steps until get to the last point. The last point is set by clicking
the right mouse button.

The curve shape between to curve points is not only determined by the directions
of the tangents in the two points, but also on their length. The length of a tangent
is the distance from the curve point to the point where you set the direction. A
long tangent means that the curve is more "attracted" to that tangent.

Curve Editing
You can edit a curve after it has been drawn. When the curve object is selected the
curve points will be marked, and the curve tangents will be shown.
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You can move the curve points just like you can move line points

You can also change direction and length of the tangents if you drag one of the
end-points of a tangent. This will modify the shape of the curve.

Arrows
An arrow is just a (poly)line or a curve equipped with an arrow head and/or an arrow
tail. Refer to Line Properties below.

Line Properties
Line properties apply to lines, curves, and the edges of filled areas.

You can set all line options in the Line Options dialog The most commonly used
options can also be set in the Line Options toolbox.

Line Width
The line width is specified in units of points.

In the Line Options toolbox you can set the line width in a spin-box:

The current line width is visualized in the line width sample next to the spin-box.
In the Line Options dialog there is a similar spin-box and a combined sample that
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visualizes line width and line color.
Line Style
In the Line Options toolbox you can set the line style in a drop-down menu:

There is a similar drop-down menu in the Line Options dialog.

You can choose among these line styles:

Invisible lines can be useful for several purposes, for example when a filled area
should not have a visible edge. Another example is when you want an arrow head
but no arrow.

Line Color
To change the line color click on the line color sample or the drop-down menu in
the Line Options toolbox to expand the line color selection box.

You can now select a new line color in three different ways:

Click on one of the 18 colors in the line color palette, or

Use the Color Dropper tool

and pick a color anywhere on your desktop, or
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Press the More Colors button. It will open the Color Selection dialog by which
you can get any color you want.

The line color palette contains the eight "pure" colors plus ten more colors.
Whenever you get a new line color by means of the dropper or from the Color
Selection dialog it will replace one of the colors in the line color palette, namely the
one which at the given time has the smallest hit rate. This means that the palette
always gives you quick access to the ten most used line colors and the "pure"
colors.
The easiest way to select a line color will normally be through the line color
selection box. However, if you have hidden the Line Options toolbox you must use
the Line Options dialog to select line color. It only contains a Color button by which
you can open the Color Selection dialog; it does not include the shortcut tools
provided by the palette and the dropper.

Arrow Head and Tail
You can make a line or a curve into an arrow by giving it an arrow head. Select the
line or curve object and choose an arrow head in the drop-down menu in the Line
Options toolbox.

There is a similar drop-down menu in the Line Options dialog.

The arrow head is put on the last point of the line or curve.
An arrow tail is just an "arrow head" put on the first point and pointing in the
opposite direction. It is chosen from a similar drop-down menu.
You can choose among these arrow styles for head and tail:
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Note, that there is one of the closed heads which is transparent and some other
closed styles which are white filled.
Line Cap
The line cap determines the style of the end points of a line or curve.
You can set the line cap style only in the Line Options dialog.

Line cap is most important for thick lines.
You can choose among these styles:
Flat

The line is capped exactly at the end point. This is the default.
Square

The end point is painted as a square.
Round

The end point is painted as a circle.
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Line cap also influences the look of dashed and dotted lines:
Dotted line with flat cap

Dotted line with round cap

Line Join
The line join determines the look of the corners where the segments of a polyline
line meet. It also determines the look of very sharp bends of a curve.
You can set the line join style only in the Line Options dialog.

Line join is most important for thick lines.
You can choose among these styles:
Miter (default)

Bevel

Round
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Line Options Dialog
Use this dialog to specify line options. If no objects are selected the line options will
apply to new objects you draw. If one or more objects are selected the options will also
apply to these objects, including members of selected groups.
The most important line options can also be set in the Line Options toolbox.

You open the dialog by means of the Line Options command in the Draw menu.

Line Width
The line width is specified .
You can set the line width in units of points in a spin-box:

The current line width is visualized in the sample below the Color button.
Line Style
You can set the line style in a drop-down menu:
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You can choose among these line styles:

Invisible lines can be useful for several purposes, for example when a filled area
should not have a visible edge, if you want an arrow head but no arrow.

Line Color
Press the Color button to change the line color. It opens the Color Selection dialog.

The current line color is visualized in the sample below the button.
Arrow Head and Tail
You can make a line or a curve into an arrow by giving it an arrow head. Select the
line or curve object and choose an arrow head in the drop-down menu.

The arrow head is put on the last point of the line or curve.
An arrow tail is just an "arrow head" put on the first point and pointing in the
opposite direction. It is chosen from a similar drop-down menu.
You can choose among these arrow styles for head and tail:
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Note, that there is one of the closed heads which is transparent and some other
closed styles which are white filled.
Line Cap
The line cap determines the style of the end points of a line or curve.

Line cap is most important for thick lines.
You can choose among these styles:
Flat

The line is capped exactly at the end point. This is the default.
Square

The end point is painted as a square.
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Round

The end point is painted as a circle.
Line cap also influences the look of dashed and dotted lines:
Dotted line with flat cap

Dotted line with round cap

Line Join
The line join determines the look of the corners where the segments of a polyline
line meet. It also determines the look of very sharp bends of a curve.

Line join is most important for thick lines.
You can choose among these styles:
Miter (default)

Bevel
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Round
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Filled Areas
Boxes
To draw a rectangular box do the following:

or use the Box command in the Draw menu.
Select the Box tool
Move the cursor which now has changed to a cross
to the point on the canvas
where you want one corner of the rectangle and click the left mouse button.
Move the cursor to the position where you want the opposite corner and click the
right button.

Keep the SHIFT key down during the last step if you want a square box.

The box will be filled according to the current settings of fill properties for the interior,
and the current line properties for the edge.

Ellipses and Circles
To draw an ellipse do the following:

or use the Ellipse command in the Draw menu.
Select the Ellipse tool
Move the cursor which now has changed to a cross
to the point on the canvas
where you want one corner of the bounding box of the ellipse and click the left
mouse button.
Move the cursor to the position where you want the opposite corner and click the
right button.

Keep the SHIFT key down during the last step if you want a circle.

The ellipse will be filled according to the current settings of fill properties for the
interior, and the current line properties for the edge.

Closed Polygons
To draw an arbitrary closed polygon do the following:

Select the Polygon tool

or use the Polygon command in the Draw menu.
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Draw the polygon in the same way as you would draw the corresponding polyline.
The polygon is closed automatically when you set the last point (click the right
mouse button).

The polygon will be filled according to the current settings of fill properties for the
interior, and the current line properties for the edge.

Closed Curves
To draw an arbitrary closed Bezier curve do the following:

or use the Closed Curve command in the Draw
Select the Closed Curve tool
menu.
Draw the closed curve in the same way as you would draw the corresponding
open curve.
The curve is closed automatically when you set the last point (click the right
mouse button).

The curve will be filled according to the current settings of fill properties for the interior,
and the current line properties for the edge.

Fill Properties
Fill properties apply to boxes, ellipses, polygons, and closed curves.
You can set the options in the Fill Options dialog. The most commonly used options
can also be set in the Fill Options toolbox.

Note, that the edges of a filled object follow the settings of line options.

Fill Color
To change the fill color click on the fill color sample or the drop-down menu in the
Fill Options toolbox to expand the fill color selection box.

You can now select a new fill color in three different ways:

Click on one of the 18 colors in the fill color palette, or

Use the Color Dropper tool

and pick a color anywhere on your desktop, or

Press the More Colors button. It will open the Color Selection dialog by which
you can get any color you want.

The fill color palette contains the eight "pure" colors plus ten more colors.
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Whenever you get a new fill color by means of the dropper or from the Color
Selection dialog it will replace one of the colors in the fill color palette, namely the
one which at the given time has the smallest hit rate. This means that the palette
always gives you quick access to the ten most used fill colors and the "pure" colors.
The easiest way to select a fill color will normally be through the fill color selection
box. However, if you have hidden the Fill Options toolbox you must use the Fill
Options dialog to select fill color. It only contains a Color button by which you can
open the Color Selection dialog; it does not include the shortcut tools provided by
the palette and the dropper.

Fill Style
You can set the fill style in a drop-down menu:

You can choose among these 8 fill styles:

The fill styles are realized as bit patterns. This means, that the distance between the "hatch
lines" depend on the resolution. In very high resolution it can be difficult to differentiate
between the styles: they all appear as semi-transparent overlays (except the Empty and Solid
styles). Refer to example shown for the Fill Options dialog

Fill Rule
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There are two methods to fill a closed curve or polygon.

The Winding rule (also known as the Non-Zero rule:

The Even-Odd rule (this is the default).

This option can only be set in the Fill Options dialog

Change between Closed and Open Object
You can change a closed curve or polygon into an open curve or polyline by means of
the Change to Open command in the Draw menu.

You can in a similar way change an open object to closed by means the Change to
Closed command in the Draw menu.

When you change a closed object to open the line properties (the edge of the closed
object) are retained and the fill properties are suspended. However, if you later change
it back into a closed object its previous fill properties are restored. If the object
previously in its life cycle in the current session has been open, its previous arrow
properties are restored when you change to open.

When you change an open object to closed the line properties are retained and used
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for the edge of the closed object. Arrow head and tail are suspended. However, if you
later change it back into an open object its previous arrow properties are restored. The
fill properties are inherited from the current settings, unless the object previously in its
life cycle in the current session has been closed, in which case its previous fill
properties are restored.
"Sleeping" line or fill properties are lost when the layout is saved.

Copyright © 2003, AGI (autoGraph international), www.augrin.com.

306

Fill Options Dialog
Use this dialog to specify area fill options. If no objects are selected the fill options will
apply to new objects you draw. If one or more objects are selected the options will also
apply to these objects, including members of selected groups.
The most important fill options can also be set in the Fill Options toolbox.

You open the dialog by means of the Fill Options command in the Draw menu.

Fill Color
Press the Color button to change the fill color. It opens the Color Selection dialog.

The current fill color is visualized in the sample next to the button.
The default color is white. If you change the color, and the current fill style is
empty, it is automatically changed to solid. If you really want an empty fill in a
specific color (which will be invisible) you can select the color and then change the
style back to empty.

Fill Style
You can set the fill style in a drop-down menu:

You can choose among these 8 fill styles:
307

The fill styles are realized as bit patterns. This means, that the distance between the "hatch
lines" depend on the resolution. In very high resolution it can be difficult to differentiate
between the styles: they all appear as semi-transparent overlays (except the Empty and Solid
styles).

On the screen

Printed version
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Fill Rule

There are two methods to fill a closed curve or polygon.

The Winding rule (also known as the Non-Zero rule:

The Even-Odd rule (this is the default).

There is no fill rule to obtain this result:

If this is what you want you must
1. Duplicate the object;
2. Make the duplicate empty, and maybe increase its line width ;
3. Use Winding fill rule for the original object;
4. Make the edge of the original object invisible;
5. Align the original and duplicate object (Center and Middle);
6. Change object order to put the duplicate below the original.

When this is done it might be a good idea to group the two objects.
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Images
You can include image objects in the layout in several ways:

Default Image
The default image is the one you have open in EasyCopy when Montage is started (if
any). It becomes an image object in the canvas automatically. This image does not
have any special status compared to other images that you later put on the canvas.

Inserted Images
You can insert an image on the canvas by means of the Open Image toolbutton
You can also use the Open Image command in the File menu or the keyboard
accelerator CTRL+I.

.

They open the Open Image dialog to let you select an image.

Screen Capture
You can capture a window, a rectangular region, or the complete screen by means of
the Capture commands in the File menu.

You can also repeat the previous capture operation (capture the same window again,
for this.
for example, after its contents has changed). Use the Capture Toolbutton

Image Colors
All the device independent image color options that you can set in the Color Options
dialog are available for each image separately.

These options include background removal, color output modes, reversal modes, color
adjustment and tint balance.
To open the Color Options dialog proceed as follows:

1. Select the image
2. Use the Colors command in the Image menu.
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If you have applied color replacement to the selected image the results of using Color Options may
be surprising. The Color Options dialog does not take color replacement into account, so it will
preview your original image, and the options you specify may conflict with the previously specified
replacements.

If you need both color options and color replacement you should specify color options before color
replacement to get consistent results.

Image Layout
When you import an image it is positioned and scaled according to your default
settings in the Layout dialog.

You can change position and scale simply by moving or resizing the image object on
the canvas.

You can also select an image and open the Layout dialog by means of the Layout
command in the Image menu. The dialog allows you to change the size and position of
the image.
This may have unforeseen side effects. The new settings you specify will apply to other images you
insert, and you may change the orientation which may damage your layout.

Image Crop
To crop an image on the canvas do as follows:

(a rubberband you draw
1. Select the image and click on the Rubberband tool
with the crop tool cannot be used for anything until there is a selected image).
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2. Draw the rubberband: move the mouse to the corner where you want to start the
rubberband and click the left mouse button.
3. Move the mouse to the opposite corner and click the right mouse button. If you
need to fine-adjust the rubberband you can move, scale, or stretch it with the
mouse.
to crop the image.
4. Click on the the Crop tool

5. You can now treat the cropped section as an image object, and - for instance scale it to get a closer look.
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You can get back to the uncropped image by selecting the image and using the
.
Uncrop tool

Color Replacement
You can replace a color in an image by another color.
This is done by means of the Color Pick tool

in the Image Options tool box.

This tool is also available in the Replace Colors command in the Image menu.

The process takes the following steps:
1. In order to hit the right color in the image you may need to zoom into an enlarged
view before you do color replacement.

2. Click on the Color Pick tool
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3. Move the mouse cursor over the image. You will see that the two color samples in
the Image Options tool box change to reflect the color at the actual cursor
position.

4. Click the left mouse button to pick the color you want to replace.
5. Click on the lower color sample or the drop-down menu in the Image Options tool
box. It will expand the image color selection box.

You can now select a new image color in three different ways:

Click on one of the 18 colors in the image color palette, or

Use the Color Dropper tool

and pick a color anywhere on your desktop, or

Press the More Colors button. It will open the Color Selection dialog by which
you can get any color you want.

The image color palette contains the eight "pure" colors plus ten more colors.
Whenever you get a new image color by means of the dropper or from the Color
Selection dialog it will replace one of the colors in the image color palette, namely
the one which at the given time has the smallest hit rate. This means that the
palette always gives you quick access to the ten most used image colors and the
"pure" colors.
The easiest way to select a new image color will normally be through the image
color selection box. However, if you have hidden the Image Options toolbox you
must use the Replace Colors command in the Image menu.
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It only gives you the option that you can open the Color Selection dialog; it does
not include the shortcut tools provided by the palette and the dropper.

6. When you select a new color any occurrence of the color you picked will be
replaced by the the new color.

Transparent Color
"Transparent color" is a special replacement color.
This is quite different from image transparency by which you can make all colors in the image more or
less transparent. The "transparent color" affects only one image color and makes it completely
transparent.

To make an image color transparent do the following:
1. Start color replacement as described above.

2. Select the color you want to make transparent, for example a background color in
a logo.
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3. Press the Transparent button in the Image Options toolbox.

4. The color is now transparent.

Image Transparency
An image can be made semi-transparent which means that objects behind the image
are blended with the image and thus become visible.
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To make an image semi-transparent do the following:
1. Select the image.
2. The image is by default completely opaque, and the Transparency slider in the
Image Options toolbox is at its leftmost position.

Drag the slider to the right to set a transparency. At its rightmost position the
image becomes completely transparent (invisible).
You can use the Transparency command in the Edit menu and open the Transparency dialog to obtain
a more precise setting.

Semi-transparency can be used for many purposes. You may, for example, highlight
an area by placing a filled area under a semitransparent image:

You can also blend two images to get special effects. For instance take these two
images:
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Make them both semi-transparent, and put them on top of each other:

Some platforms do not support genuine semi-transparency and use dithering methods to emulate the
visual effect. This is for example the case on Windows NT 4.0.
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Transparency Dialog
The Transparency dialog is used to set the transparency of an object.

The transparency is a number beween 0 (opaque = no transparency) and 255
(completely transparent = invisible).
Normally, you will use the Transparency slider in the Montage dialog to set the
transparency.

The dialog is useful only if you need a precise setting:

it provides a slider with a larger scale;
it allows you to enter the transparency value directly.

Transparency is also discussed in the topic Image Transparency.
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Image Information Dialog
The Image Information dialog displays available information about an image on the
canvas.

Size and File Information
Image Type
The image file format or the import filter.
Filename
The full path name of the image at its current location.
Filesize
The size of the image file.
Page
Page number of a multi-page file. This item is dimmed for single-page files.
Source
How did this image enter the canvas? (You opened it explicitly or implicitly (open
layout), it was captured, it was embedded inline in an imported layout, etc.).
Pixels
Pixel dimensions of the (unscaled) image.
Resolution
The resolution information contained in the image. This item is dimmed if resolution
information is not available in the image file.
Size
Metric size of the image. If metric size information is not available from the image
file the size is calculated from an (arbitrary) assumption of a resolution of 72 dpi,
and the item is dimmed in order to emphasize that this is only speculation.
Size on Canvas
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Metric image size on the canvas in the current scaling of the image.
Compression
Compression method used in the image file.
Compressed to
Compression ratio relative to a "raw" image. This item is dimmed if there is no
obvious way to interpret the calculated value.
Cropping
Crop parameters (relative to original image) if the image has been cropped.

Original Image Colors
Color Mode
The color mode of the original image.
Colors
Number of colors. This is not a count of the actual number of colors. It only
specifies how many colors can be present, for example 16 mill. for a´n RGB image.
Precision
Bits per color.

Current Image Colors
Color Mode
The color mode currently used for the image.
Background Colors
Number of removed background colors.
Replaced Colors
Number of colors that have been replaced in Montage.
Brightness
Applies when brightness has been adjusted
Contrast
Applies when contrast has been adjusted
Chrominance
Applies when chrominance has been adjusted
Tints
Applies when tint balance has been adjusted
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Texts
Add a Text
To add a text string do the following:

in the Tool bar. The cursor changes into a text entry
Select the Select the Text tool
cursor . Move it to the position where you want to start the text, click the left mouse
button, and begin typing. The text is created using the current font, text color, and
adjustment.

You may also use the Add Text command in the Text menu. This will be necessary if
you have hidden the tool bar.

Symbols
Symbols that are not easily entered from the keyboard (for example when a symbol
font is selected) are entered by means of the Add Symbol command in the Text menu
which will open the Symbols dialog.

Text Edit
The text that you enter appears both in the canvas and in the text frame in the Edit
Text tool box.

The text frame is used when you want to edit the text. When you select a text object
its contents is displayed in the frame, and you can edit it using normal text editing
procedures.

If you have hidden the tool box you can also use the Edit Text command in the Text
menu. This is also suggested if you have a large amount of text simply because it
offers a larger text frame.
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Text Properties
Font
Select the text font (font family) from the drop down menu in the Text tool bar.

You can select any scalable text font installed on your system.
You can also use the Font command in the Text menu to open the Font dialog and
select the font.

Point Size
Text size is specified in units of points (1/72 inch).

You can set the point size in the Text tool bar or in the Font dialog.

Text Color
To change the text color click on the line color sample or the drop-down menu in
the Text tool bar.

This will expand the text color selection box.
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You can now select a new text color in three different ways:

Click on one of the 18 colors in the text color palette, or

Use the Color Dropper tool

and pick a color anywhere on your desktop, or

Press the More Colors button. It will open the Color Selection dialog by which
you can get any color you want.

The text color palette contains the eight "pure" colors plus ten more colors.
Whenever you get a new text color by means of the dropper or from the Color
Selection dialog it will replace one of the colors in the text color palette, namely the
one which at the given time has the smallest hit rate. This means that the palette
always gives you quick access to the ten most used text colors and the "pure"
colors.
The easiest way to select a text color will normally be through the line color
selection box. However, if you have hidden the Text tool bar you must use the
Color command in the Text menu to select text color. It opens the Color Selection
dialog; it does not include the shortcut tools provided by the palette and the
dropper.

Style Variants

Use the Bold tool

to enable or disable bold text.

Use the Italic tool

to enable or disable italic text.

Use the Underline tool

to enable or disable underlined text.

You can also make these selections in the Font dialog.

Text Justification
Text can be Left, Center, or Right adjusted.

Use the Left tool
text.

Use the Center tool

or the Adjust > Left command in the Text menu to left adjust a

or the Adjust > Center command in the Text menu to
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center a text.
Use the Right tool
adjust a text.

or the Adjust > Right command in the Text menu to right
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Symbols Dialog
This dialog is used to select a symbol from a font (usually a symbol font).

The dialog is opened with the Add Symbol command in the Text menu.

You can choose the font from which you want to extract the symbol in the drop-down
menu at the top of the dialog.
All symbols of the selected font are displayed in the scrollable table. Select the one you
want to draw on the canvas, and press OK.
When the dialog then is closed you will see, that the cursor in the Montage canvas has
changed into a text entry cursor . Move it to the position where you want to put the
symbol, and click the left mouse button.
You can use all the Text tools in the Tool Bar to set attributes for symbol (color, size,
etc.).

326

A symbol is treated as a text in Montage. This means, that if you select the object and change the font
you will often get a quite different symbol,
For example, if you have drawn this symbol
ordinary # sign.

and change the font, you will in most cases get an

The same happens if you save a layout that contains symbols, and later restore the layout on a system
where the particular font that contained the symbol was not installed.

This method is mainly used with fonts that contain special symbos, for example oil well
symbols:

It can also be a useful tool together with ordinary text fonts if you need a symbol that is
not easily created by keyboard input, for example the © sign. To create this text:

you can do as follows:
1. Use the Add Symbol command to open this dialog.
2. Select the © sign (assuming it is present in the text font you are using), and press
OK.
3. Edit the text as you would edit any aother text.
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Text Edit Dialog
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Font Dialog
Use the Font dialog to select text font, point size and style properties.

The dialog is opened by means of the Font command in the Text menu.

Size
Text size is specified in units of points (1/72 inch).
You can also set the text size in the Text tool bar.

Font
Select the text font (font family) from the drop-down menu.
You can select any scalable text font installed on your system.
You can also select the font in the Text tool bar.

Bold
Enable Bold to select bold style. You can also use the Bold tool

Italic
Enable Italic to select italic style. You can also use the Italic tool

for this.

for this.

Underline
Enable Underline to select underlined text. You can also use the Underline tool
for this.
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How to Add Fonts
EasyCopy Montage will use all scalable fonts installed on your system, so adding fonts
for use in Montage is in fact a matter of adding more fonts to your system in general.
Fonts are normally copyrighted and (like other software) they must be licensed from the font vendor.

Freeware fonts are available for download from certain sites, but they are usually of poor quality, or
in many cases illegal copies of copyright protected fonts, so be careful that you do not
unintentionally contribute to software piracy!
The fonts distributed with Ghostscript are of good quality. Ghostscript is installed together with
EasyCopy and used by EasyCopy. The Ghostscript fonts can legally be installed in your system and
used with EasyCopy and other applications that use Ghostscript.

How to Add Fonts in Windows
You add fonts by opening the Control Panel.
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Click on the Fonts icon to open the list of installed fonts.

Select Install New Font in the File menu:
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Now you get an Add Fonts dialog.

Locate the new fonts you got from some source.
You can always install TrueType (.ttf) fonts on a Windows system.
On Windows 2000 and Windows XP you can also install Adobe Type 1 (.pfm)
fonts.
To install Type 1 fonts on Windows NT and 98 you need additional software (Adobe
Type Manager from Adobe Systems).

If you install Type 1 fonts you may get the problem that the installation is unsuccesful
due to copyright issues.
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How to Add Fonts in UNIX
The available fonts in a UNIX environment are delivered by the X-server. If you run EasyCopy from
a remote location you have access to the fonts provided by your local X font server. The fonts are not
delivered by the system to which you have logged in.

You can add fonts by means of the xset command.
You can always add Adobe Type 1 fonts (.pfb and associated .afm files). Some
systems also let you add TrueType.
You may for example add the fonts provided by Ghostscript. All files required are
prepared and ready in the Ghostscript fonts directory.
Type this line in a console or terminal window:
xset fp+ /usr/local/easycopy/gpl/gs/fonts
(assuming that you have installed EasyCopy in /usr/local/easycopy).
This will add the Ghostscript fonts to the font path. You need no special priveleges to
do this, but the added font path will only last for the duration of your X Window
session.
To add fonts permanently you must update the confguration of the X font server. The
details may be system dependent, but the guide lines provided here will work on most
systems.

The X font server's configuration file is normally located in /etc/X11/fs/config and
normally you need root access to update this file. Make a backup copy of the
configuration file. Locate the "catalogue=" entry, and
add /usr/local/easycopy/gpl/gs/fonts to the comma-separated list.
You need to restart the font server to make the update effective. Use the kill
command, and rely on the assumption that it will restart itself. If this does not happen
you may have damaged the configuration file when you updated it. Review carefully
your changes, correct any mistakes and try again. If necessary, fall back to your
backup copy and restart the system.
To add fonts from other vendors you may need to setup or edit a fonts.dir and a
fonts.scale file bvefore you add the fonts to the font server. Refer to your system
documentation and/or documentation from the font vendor for further information.
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Ghostscript Fonts
The fonts distributed with Ghostscript are installed together with EasyCopy for use with
Ghostscript. They are not automatically installed for general use in the system.
The fonts are located as follows:
Windows
[easycopy]\gs\fonts
UNIX
[easycopy]/gpl/gs/fonts
(where [easycopy] means the directory in which EasyCopy is installed.
The fonts are metrically equivalent with the basic set of 35 PostScript fonts. They have
other names, however, because the names of the original PostScript fonts are
protected. The fonts are listed below (the number 35 relates to the fact that each style
variation counts as one font in PostScript terms).
Font Name

regular

bold

italic

bolditalic

PostScript Name

New Century Schoolbook

Century Schoolbook L

x

Dingbats

x

Nimbus Mono L

x

x

x

x

Courier

Nimbus Roman No 9 L

x

x

x

x

Times Roman

Nimbus Sans L

x

x

x

x

Helvetica

Nimbus Sans L Condensed

x

x

x

x

Helvetica Narrow

Standard Symbols

x

URW Bookman L

x

x

x

x

ITC Zapf Dingbats

Symbol

x

x

URW Chancery L

x

Bookman

x

ITC Zapf Chancery

URW Gothic L

x

x

x

x

Avant Garde

URW Palladio L

x

x

x

x

Palatino

Century Schoolbook L
This font is part of Ghostscript. It is metrically equivalent to the New Century
Schoolbook font used in PostScript.
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335

336
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You can add this font to your X font server and have it available in Montage.

Dingbats
This font is part of Ghostscript. It is metrically equivalent to the ITC Zapf Dingbats font
used in PostScript.

338

You can add this font to your X font server and have it available in Montage.

Nimbus Mono L
This font is part of Ghostscript. It is metrically equivalent to the Courier font used in
PostScript.

339

340

341

342

You can add this font to your X font server and have it available in Montage.

Nimbus Roman No9 L
This font is part of Ghostscript. It is metrically equivalent to the Times Roman font
used in PostScript.

343

344

345

346

You can add this font to your X font server and have it available in Montage.

Nimbus Sans L
This font is part of Ghostscript. It is metrically equivalent to the Helvetica font used in
PostScript.

347

348

349

350

You can add this font to your X font server and have it available in Montage.

Nimbus Sans L Condensed
This font is part of Ghostscript. It is metrically equivalent to the Helvetica Narrow font
used in PostScript.

351

353

353

354

You can add this font to your X font server and have it available in Montage.

Standard Symbols
This font is part of Ghostscript. It is metrically equivalent to the Symbols font used in
PostScript.
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You can add this font to your X font server and have it available in Montage.

URW Bookman L
This font is part of Ghostscript. It is metrically equivalent to the Bookman font used in
PostScript.

356

357

358

359

You can add this font to your X font server and have it available in Montage.

URW Chancery L
This font is part of Ghostscript. It is metrically equivalent to the ITC Zapf Chancery font
used in PostScript.
It is only available in bold-italic style.
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You can add this font to your X font server and have it available in Montage.

URW Gothic L
This font is part of Ghostscript. It is metrically equivalent to the Avant Garde font used
in PostScript.

361

362

363

364

You can add this font to your X font server and have it available in Montage.

URW Palladio L
This font is part of Ghostscript. It is metrically equivalent to the Palatino font used in
PostScript.

365

366

367

368

You can add this font to your X font server and have it available in Montage.
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Montage Output
Printing a Layout
or the Print command in the File menu to open the Print
Use the Print tool button
dialog and print the layout in the canvas.

Printing Selected Objects
If you only want to print a selection of the layout proceed as follows:
1. Select the objects you want to print
2. Use the Selected Objects > Print command in the File menu to open the Print
dialog.

The print area will in this case not correspond to the complete page size of the canvas.
It will only include the bounding box of the selected objects.
Locked objects cannot be selected and can therefore not be printed by this method.

Printer Selection
You can select printer in the Print dialog. You may also preselect the printer by means
of the Printers command in the File menu which will open the Printer Selection dialog.

Printer Setup
Select printer options from the Printer Setup dialog which you can open from the Print
dialog or by means of the Printer Setup command in the File menu.

Save as Image
You can save the layout in the canvas as an image file in any of the supported image
file formats.

Use the Save As Image command in the File menu to open the Save As dialog where
you can specify the format, options and image size.
cannot be used as a shortcut for saving the layout as an image. It is used to
The Save tool button
save the layout for later reuse.

Saving Selected Objects
If you only want to save a selection of the layout as an image proceed as follows:
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1. Select the objects you want to print
2. Use the Selected Objects > Save As command in the File menu to open the Save
As dialog.

The image area will in this case not correspond to the complete page size of the
canvas. It will only include the bounding box of the selected objects. You can thus use
this method to avoid a white margin around the saved image.
Locked objects cannot be selected and can therefore not be saved by this method.

Send the Layout
You can send the layout in the canvas as an image file attached to an E-mail
message.
Use the Send command in the File menu to open the Send To dialog where you can
specify the file format, options and image size.

Sending Selected Objects
If you only want to send a selection of the layout as an image proceed as follows:
1. Select the objects you want to print
2. Use the Selected Objects > Send command in the File menu to open the Send To
dialog.

The image area will in this case not correspond to the complete page size of the
canvas. It will only include the bounding box of the selected objects. You can thus use
this method to avoid a white margin around the image.
Locked objects cannot be selected and can therefore not be sent by this method.
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Save and Restore
Save the Layout
or use the Save Layout command in the File menu to
Press the Save tool button
open the Save Layout dialog.

By default the file name extension .lay will apply to the saved layout.
The layout is saved in an SVG-compatible format.
Image objects are saved by reference. This means, that the image is represented by a
pointer to the original image file.
If you later move, delete or rename any of the image files referred in your layout there
will be unsatisfied references, and these images will not be loaded when you restore
the layout.

If you restore the layout in another file system environment than the one in which it
was saved (for example restore a layout saved in a Windows environment on a UNIX
platform) all image references may be wrong because the path names used to refer to
the images are invalid in the new context.

This problem can in many cases be solved easily by means of path translation. If an
image is not found you are prompted for an alternate location, and you may choose
automatically to search for other missing images in the same place.
If your layout includes temporary images, for example screen captures, you get a
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warning when you save the layout:

1. You can save the image inline. This means, that the temporary image is saved as
a part of you layout file, and the image is automatically restored when you restore
the layout.
2. You can save the image permanently. This means that the image is moved to a
permanent location that you choose.
3. You can ignore the problem. This implies that the image is lost when you restore
the layout.

Restore a Previously Saved Layout
or use the Open Layout command in the File
Press the Open Layout tool button
menu to open the Open Layout dialog.

You can load the layout into an empty canvas in which case the canvas size is
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changed to reflect the size of the layout you open.
You can also insert the layout into a canvas which is not empty. The canvas size will
then remain unchanged, and all the objects of the layout you load will become selected
(unless some of them are locked or hidden).

The format used for Save/Restore is SVG (Scalable Vector Graphics). Note, however,
that EasyCopy Montage is not supposed to be a general SVG viewer, and you cannot
expect, that SVG files produced by other applications will be imported succesfully.
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Path Translation
Images are represented by reference in layout files. The image itself is not saved
together with the layout (except screen captures and other temporary files which may
be saved inline). This means, that if you open a layout in another file system
environment than the one in which it was originally saved you may have the problem,
that the image files cannot be located.
For example, if you save a layout in a UNIX environment, all its images will be referred
by their path names in the UNIX file system, for
example /home/me/pictures/myimage.tif.
If you want to open this layout in a Windows environment you get the problem,
that /home/me/pictures/myimage.tif is not the correct path to that image. It may, for
example, be that the drive is mounted on the Windows system under drive letter "G",
so that the valid path from the Windows environment is G:\me\pictures\myimage.tif.
To get the correct result you need that Montage will translate /home/ into G:\.
You need not worry about the UNIX/Windows issue concerning forward "/" and backward "\" slash.
Montage takes care of this automatically.

Similar problems occur if you have moved or renamed images.
When a layout is opened and an unsatisfied image reference is found you get a
message:

You may choose to press Ignore. This means that the lost image is ignored and does
not become part of the layout. When you save the layout again it will no longer contain
a reference to the image.
If your press Yes you will get a file dialog where you can specify where to look for the
missing file.

375

The search starts in different locations depending on whether the path was valid or
not. If the path was valid (but the file is missing) the search starts in the folder where
the image was assumed to be. If the path is invalid (for example, when you are in a
different file system environment) the search starts in your home directory.
In Windows this is normally your Documents and Settings folder. In older Windows systems
(where this folder is not necessarily associated with the concept of a home directory) it is C:\

When you have located the missing image file, select it, and press Open. The selected
path will now be used in place of the path that could not be resolved. If you press
Cancel in the file dialog it means that you will ignore the missing file.
If the missing file is located under its original name but at another path, you can
choose that other unsatisfied references to the same path shall be searched at the
path you located before they are reported missing.

This logic makes it possible to setup multiple translations of a missing path. These will
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then be searched in sequence.
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Command Line Interface: ecx
The information provided below applies to the UNIX versions of EasyCopy.

Use the ecx command to start the Graphical User Interface of EasyCopy.

The command line syntax is as follows:
ecx [options] [input-file] [&]
Use the & character to start EasyCopy as a background task.
The ecx program uses right-to-left precedence: if an option is duplicated the value
supplied with the one that is last specified (right most) is used.
Options and parameters (apart from path and host names) can be abbreviated as long
as they can be unambiguously identified. For example, -help can be abbreviated -h.
Options and parameters (apart from path and host names) may be entered with
uppercase and lowercase letters and with underscores between "words." Letters are
converted to lowercase and underscores are removed during parsing. For example,
-Ini_File and -inifile are treated the same.
Input File
If an input file is supplied it becomes the current file, when the graphical user interface
is opened.
Otherwise, there is no current file, until you open or capture an image.

stdin (-)
Input data can also be supplied on standard input (stdin). Supplying - as an option
(a hyphen with no keyword) indicates data on standard input. In this case
EasyCopy opens in a special print mode: The main window and menu is not shown,
instead the Print dialog is entered directly, and EasyCopy terminates after you
press Print or Cancel.

This feature is particularly useful for system integration. It allows you to call
EasyCopy from another application and use it to control output of PostScript or
image files in a way similar to printer drivers in Microsoft Windows.
If there are no data on standard input, or an input file is supplied explicitly, the
graphical user interface opens normally.

-remove
The -remove option can be used together with an input file. If an input file is
supplied on the command line, the -remove option causes the file to be deleted at
exit time, but only if the file has been printed. If another file has been opened
378

during the session, the -remove option is ignored.
Environment Options
-sysdir sysdir
Specifies the path name of the easycopy/system directory, where EPD and PPD
files are located. If the -sys option is not supplied, the directory pointed to by the
SYSDIR variable is used. The -sys option overrides the SYSDIR variable. The
easycopy/system directory must be available to ecx; the normal installation
procedure sets the correct value of the SYSDIR variable in the ecx script. If the
path name is not available the program terminates with an error message.
-inifile initialization-file
Specifies the path name of the system-wide initialization file. If the -inifile option is
not supplied, the file pointed to by the INIFILE variable is used. The -inifile option
overrides the INIFILE variable. The system-wide initialization file must be available
to ecx; the normal installation procedure sets the correct value of the INIFILE
variable in the ecx script. If the path name of the system-wide initialization file is not
available the program terminates with an error message.
-display hostname:server.screen
Specifies the display on which EasyCopy is opened. If the display is not specified,
the DISPLAY variable is used. If the DISPLAY variable is not set, the local screen
(hostname:0.0) is the default display. The -display option overrides the DISPLAY
variable.
You need a license for the display on which you open EasyCopy.

-tmpdir tempdir
Specifies the directory for the temporary files. Normally, you do not need this
option; it is intended for test purposes, for example if you occasionally run a print
job that requires more temporary space than is available in the default location. If
the -tmp option is not supplied the value of the TMPDIR environment variable is
used. The normal installation procedure sets the correct value in the ecx invocation
script.

Informational Options
These options are used for information display and do not start the normal image
printing functions of ecx. If you supply -help or -version all other options are ignored.
-help
Displays help and usage information about ecx, including a list of available options
and their defaults.
-version
Displays version information, release date, operating system, and the system's
primary key (used for registration).
Other Options
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-imagewindow { fitdialog | fullsize | disabled }
Specifies the preference for the Main Window. You may later change this setting in
the Preferences dialog.
-geometry width x height + xoffset + yoffset
Specifies the size and position of the Main Window. Refer to your X Window
System documentation.
-iconic
Starts the graphical user interface iconified. By default the Main Window is opened
in visible mode.
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Command Line Interface: ecconv
Image conversion, for example as used in the Save As dialog , is done by means of the ecconv
program.

You can also use ecconv directly as a command line program. This is decribed in the following.
The command line syntax is as follows:
ecconv [options] [@response-file] [input-file [output-file] ] [&]

Use the & character at the end of the command line to run ecconv as a background task on UNIX.

The ecconv program uses right-to-left precedence: if an option is duplicated, the value supplied with
the one that is last specified (rightmost) is used. Options and parameters (apart from path names) can
be abbreviated as long as they can be unambiguously identified. For example, -export can be
abbreviated to -ex. Options and parameters (apart from path and host names) may be entered with
uppercase and lowercase letters and with underscores between "words". Letters are converted to
lowercase and underscores are removed during parsing. For example, -C_map and -cmap are treated
the same.
@response-file
A response file may contain any number of options. It provides an alternative to typing the options
on the command line; this is useful if you want to do a series of conversions using the same
options.
The master-space character @ must precede the name of the response file.

Input File
You can specify an input file in any of the supported image file formats and any format supported
through filters (the latter includes PostScript , PDF , text files , CGM , and HPGL).

The default is stdin.
You need not specify the format of the input file. It is detected automatically by EasyCopy.

Output File
Specify the name of the output file. The default is stdout.

There is no connection in this context between the output file format and the file name extension. You
must specify the format by means of the -export option, and you must supply the complete filename
(the extension is not automatically appended).

Basic Options
-sysdir sysdir
Specifies the path name of the system directory, where the AGI password file is located. If the
-sysdir option is not supplied, the directory pointed to by the SYSDIR variable is used.
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-tmpdir tmpdir
Specifies the path name of the directory, where temporary files may be written. If the -tmpdir option
is not supplied, the directory pointed to by the TMPDIR variable is used for temporary files.

Informational Options
-help
Displays help and usage information. The program terminates after displaying help.
-version
Displays the version and release date and license information. The program terminates after having
displayed the version information.
-information
Displays details of the input image file. The program terminates when the image information has
been displayed (no conversion is done).

-status { false | true }
Specifies if progress information is displayed (written to stderr) during conversion.
-warning { true | false }
Specifies if warning messages should be issued. Warnings are written to stderr if you have started
ecconv from the command line.

File Options
-prompt { true | false }
Specifies a prompt (yes/no) if the output file specification implies overwriting an existing file.
-pageno n
Input page number (only for TIFF),
-removeinfile { false | true }
Specifies whether the input file should be removed after successful conversion.

Format Options
-export { bmp | cal | ... | xwd }
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Specifies the image file format for the output image file:
Compression

default

alternate

bmp

MS Windows Bitmap

none

cal

CALS Raster Type 1

g4

cat

Catia raster picture

none

cgm

CGM cell array

runlength

gif

GIF 87A

lzw

jpg

JPEG

baseline

sequential, progressive, lossless

jp2

JPEG 2000

irreversible

reversible

pbm

Portable Bitmap

none

png

PNG (Portable Network
Graphics)

deflate

pcx

PCX

packbits

pdf

Adobe PDF

none

sgi

Silocon Graphics RGB

none

stb

HP Starbase

none

sun

SUN Raster

none

tga

TARGA

none

tif

TIFF

packbits

xwd

X Window Dump

none

none

baseline, deflate, g4

none, lzw, baseline, lossless, g3, g4,
modhuff

The default is TIFF.
-compression method
Specifies the compression method.
method
none

No compression

g3

CCITT Group 3

g4

CCITT Group 4

modhuf

CCITT modified Huffman

lzw

LZW

packbits

Optimized run-length

runlength

Simple runlength

deflate

Similar to LZW

jpg

JPEG baseline

baseline

JPEG baseline

sequential

JPEG extended sequential

progressive

JPEG progressive

lossless

JPEG lossless

(same as baseline)
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reversible

JPEG 2000 lossless

irreversible

JPEG 2000 lossy

-jpegquality n
Specifies the quality of JPEG compression as a number in the range 1 to 20 (corresponds to the
JPEG Quality slider in the File Type Options dialog. This option is used for JPEG (baseline,
sequential, and progressive) and TIFF (only when JPEG baseline compression is specified).

-sampling { 4 | 2 | 1 }
Specifies the sampling ratio for chrominance components (refer to the corresponding menu in the
File Type Options dialog. This option is used for JPEG (baseline, sequential, and progressive) and
TIFF (only when JPEG baseline compression is specified).

-rate n
Target compression rate for JPEG 2000. Specify for example -rate 50 if you want to compress 1:50
(to get a file that is 50 times smaller than an uncompressed image). You will normally get a rate
which is not smaller than the one you request. However, you cannot obtain arbitrary high
compression rates. Small images do not compress as good as large images. Remember also, that
the quality decreases, the more you compress.
-scalemethod { metric | abstract }
Specifies the scale method of a CGM file. Refer to the description of the corresponding menu in the
File Type Options dialog.

-profile { ata | cals | pip }
You can specify, that a CGM file is saved with an ATA, CALS, or PIP profile. The default is ATA.

Color Options
-colormode { bestfit | bilevel | gray | rgb | yuv | n }
Specifies the desired color mode of the output image.
bestfit
Choose Best Fit to get the color mode that best preserves the colors of the input image. For
example, if the input image is using an RGB-based color map, and the output file format
supports color map, the same color map is used for the output image. Otherwise, the best
available alternate color mode is used.
bilevel
Bilevel means a bilevel, black-and-white image.
gray
Gray means a gray scale image (8 bits per pixel). In some cases this will be realized as a
colormap of 256 shades of gray.
rgb
RGB means a 24-bit RGB image (true color).
yuv
This is the true color representation used for lossy JPEG modes. Conversion between YUV
and RGB is done automatically.
n
A color mapped image. By default a color map of 256 colors will be used. A smaller number of
colors can be specified by means of the -colors option.
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The specified mode is realized as good as possible taking into account:
1. Color modes supported by the file format;
2. Constraints imposed by other selected options.
For example, if you select TIFF and one of the facsimile compressions, any image is reduced to
bilevel as this is the only supported color mode under these constraints.
Choose bestfit to get the color mode that best preserves the colors of the input image. For
example, if the input image is color mapped, and the output file format supports color maps, the
same color map is used for the output image. Otherwise, the best available alternate color mode is
used.
-colors n
Number of colors (1-256, used together with -colormode n).
-cmap { bestfit | standard }
Specifies the color map to be used if the selected color mode results in a color map of exactly 256
colors.
bestfit
This is the default. It means a color map giving the best representation of the input image. If
the input image is color mapped, the original color map is used, as far as possible; otherwise a
color map optimized for the current image is calculated.
standard
This assigns a fixed, predefined color map to the output image. This option is useful if several
images are to appear side-by-side on a device that can only display 256 colors.
-outputmode { color | gray | bw | eightcolor }
This option specifies a mode that applies before -colormode is used. It corresponds to the setting
you can make in the Color Options dialog.

-reversal { none | color | bw | gray }
Color reversal mode. It corresponds to the setting you can make in the Color Options dialog.

-removebgs n
Remove n background colors. It corresponds to the setting you can make in the Color Options
dialog, except that command line parameter supports removal of 0-255 colors, where the dialog is
limited to a maximum of 5.

-shading { errordiffusion | none }
Specifies the mapping that applies if the color reduction is required. Refer to the topic Image
Dither for more information.

-brightness v
-contrast v
-chrominance v
These options correspond to the three color adjustment sliders in the Color Options dialog.
These command line options are specified in the range -1.0 - +1.0 whereas the slider settings are
in range -100 - +100. A specification like -brightness 0.37 is thus the same as a slider setting of
37.
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-redtint v
-greentint v
-bluetint v
These options correspond to the three tint balance sliders in the Color Options dialog.
These command line options are specified in the range -1.0 - +1.0 whereas the slider settings are
in range -100 - +100. A specification like -redtint -0.09 is thus the same as a slider setting of -9.

Geometry Options
-size widthxheight
Specifies resizing of the output image in pixel measure. Refer also to the -scale option. The -size
and -scale options are treated as duplicates.
By default the size of the output image is identical to the input image. Specify width or height only to
resize the image with the aspect ratio of the input image preserved, or specify both width and
height to resize the image to arbitrary aspect ratio.
-scale hscalexvscale
Specifies resizing of the image in relative measure (percent of the input image). Refer also to the
-size option. The -scale and -size options are treated as duplicates.
By default the size of the output image is identical to the input image. Specify only one scale factor
(-scale x) to scale the output image with its aspect ratio preserved, or specify both horizontal and
vertical scale factors to scale the image to arbitrary aspect ratio.
-resolution n
Specifies the resolution of the output image in pixels per inch. This option takes effect for BMP,
CALS, CGM, PCX, PDF, PNG, and TIFF formats. Other formats do not support resolution.
Resolution information makes it possible to associate a metric size with the image.
The default depends on the input image. If no metric information is available for the input image a
default of 72 applies.
-rotate { 0 | 90 | 180 | 270 }
Specifies a rotation of the image.
-mirror { none | horizontal | vertical | both }
Specify that the output image is mirrored (-mirror both is the same as -rotate 180).
-interpolation { averaging | bilinear | replication }
Specifies the interpolation method to apply if the image is resized; refer to the topic Image Scaling.

-crop widthxheight+xoffset+yoffset
Specifies that the output image is obtained by cropping a rectangular area within the input image.
The width and height of the cropped area are measured from specified xoffset and yoffset. The
offsets are relative to the top-left corner of the input image:
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All values are in pixel units. width+xoffset must not exceed the width of the input image, and
height+yoffset must not exceed the height of the input image.
If both cropping and resizing (-scale or -size option) are specified the resize information refers to
the cropped image.

Stamp and Label
-stamptext textstring
Speciefies an outline text to be written diagonally across the image (refer to the Stamp dialog).

-stampcolor { black | red | green | blue | magenta | cyan | yellow | white | inverse }
Specifies the color used for the outline text.
-stampweight { light | medium | heavy }
Specifies the font weight of the outline text.
-labeltext textstring
Specifies a text to be written as a label at the edge of the image (refer to the Label dialog).

-labelposition { topleft | topcenter | topright | bottomleft | bottomcenter | bottomright }
Specifies the position of the label.
Copyright © 2003, AGI (autoGraph international), www.augrin .com.
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Command Line Interface: eccapt
The information provided below applies to the UNIX versions of EasyCopy.

The screen capture functions of EasyCopy can also be activated by the eccapt
command line interface described here.
$ eccapt [options] [output-file]

If the output-file parameter is present, it must appear last. It denotes the filename you
want to use for saving the captured screen image. If an existing file is specified it will
be overwritten. If no output file is specified, eccapt writes to stdout. This allows you to
pipe the output to other programs, for example ecview, ecprint, or ecconv.

The eccapt program uses right-to-left precedence: if an option is duplicated, the value
supplied with the one that is last specified (rightmost) is used. Options and parameters
(apart from path and display names) can be abbreviated as long as they can be
uniquely identified. For example, -help can be abbreviated to -h. Options and
parameters (apart from path and host names) may be entered with uppercase or
lowercase letters and with optional underscores between "words". Letters are
converted to lowercase and underscores are removed during parsing. For example,
-Capture_mode and -capturemode are treated the same.

Basic Options
-sys sysdir
Specifies the system directory directory where the password file is stored. If the
-sys option is not supplied, the directory pointed to by the SYSDIR variable is used.
The program terminates with an error message if the path name is not available.
The installation procedure supplies a default value for this option by setting the
SYSDIR variable in the invocation script.
-tmp tmpdir
Specifies the path name of the directory, where temporary files may be written. If
the -tmp option is not supplied, the directory pointed to by the TMPDIR variable is
used for temporary files. The installation procedure supplies a default value for this
option by setting the TMPDIR variable in the invocation script.
-inifile initialization-file
Specifies the path name of the system-wide initialization file, ecrc. If the -inifile
option is not supplied, the file pointed to by the INIFILE variable is used. The
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program terminates with an error message if the path name of the system-wide
initialization file is not available. The installation procedure supplies a default value
for this option by setting the INIFILE variable in the invocation script.

Informational Options
-help
Displays help and usage information.
-version
Displays the version and release date of the eccapt program.

Capture Options
A default interactive mode (see below) applies if no capture type option is supplied. If
the command line supplies more than one capture type option only the last one is
used.

-fullscreen
Specifies capture of the full screen.
-window window-id
Specifies capture of the window (excluding frame) with the specified id.
-region widthxheight+xoffset+yoffset
Specifies a particular region to capture in terms of screen pixel coordinates.
-position
Capture the window below the mouse pointer s current position (that is, you must
position the mouse pointer before eccapt is called). The frame of the window is
included if the mouse pointer is positioned on the frame. This mode is only available
in the command line interface. It is not available from EasyCopy s graphical user
interface.
Interactive mode
The default mode, if no capture type option is supplied, is a special interactive
mode which is only available in the command line interface. It is not available from
EasyCopy s graphical user interface. The capture selection in interactive mode is
done with use of the mouse. The cursor changes to a cross.
You can then define what you want to capture in one of the following four ways:
Full screen
Point at screen canvas and click a button on the mouse.
Window excluding frame
Point inside the window and click a button on the mouse.
Window including frame
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Point at the window frame and click a button on the mouse.
Arbitrary rectangular region
1. Press mouse button to affix the first corner point of the region.
2. Drag the mouse pointer until the desired region is defined.
3. Release the mouse button to complete the definition. A rubber band appears
while the mouse pointer is dragged.
-beep { true | false }
Issue a beep before and after screen capture. The default value is set in the
initialization file.
-display hostname:server.screen
Specifies the display on which the screen capture is to be performed. If the display
is not specified, the DISPLAY variable is used. If the DISPLAY variable is not set,
the local screen (localhost:0.0) is the default display. You need a license for both
systems to capture a remote display. You cannot capture a remote display if you
have a single node license.
-application window-id
Specifies the window id of the main window of the calling application. This is used if
the application must be hidden during screen capture. When this option is specified
an output file name must also be specified.
-delay seconds
This enforces a time delay (in seconds) when capturing. The delay applies if the
graphical user interface of the application overlaps the screen area to be captured,
and it has been specified that this window is hidden during capture. Occasionally,
the system s event handling may initiate the capture event before the menu has
been hidden, or the desired redraw events have completed; this conflict is resolved
by inducing a delay. The default is supplied in the initialization file.

Capture Modes
-capturemode { xe | xwd }
On all UNIX platforms choose between the following capture modes:
xe (X Enhanced Mode)
X Enhanced Mode is used for correct capture of all windows controlled by the X
Window system. Colors of individual windows are preserved when you capture
the full screen or a region with any combination of windows. Even when a
window appears in pseudo-color on the screen (due to color map restrictions) it
is captured with its original colors. This is the default capture mode (unless you
change it in the initialization file).
xwd (XWD Mode)
For more simple requirements you can use XWD Mode as a faster alternative.
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The capture is performed by a system call to the X Window capture program
xwd which must be on the path. Images captured in X Enhanced Mode and
XWD Mode are always saved in XWD format. Only if all captured entities are
described in the X Window System by one common color map, the XWD file is
color mapped; otherwise the XWD file is 24-bit RGB, and color mapped
windows or frames are expanded to 24 bits.
Silicon Graphics
-capturemode { xe | xwd | gl }
gl (GL Mode on SGI)
GL capture is available on the local display, and on remote displays, but only from one Silicon
Graphics workstation to another. Select GL Mode to capture windows that have been generated by
GL-based applications or other non-X applications if they contain elements that cannot be "seen"
by the X Window System.
Capture in GL Mode on Silicon Graphics is performed by a system call to the native SGI screen
capture program scrsave which must be on the path, and the captured image is saved in SGI raster
format (RGB).

IBM RS/6000
-capturemode { xe | xwd | gl1 | gl2 | gl3 | gl4 | gl5 }
gl1 ... gl5 (GL Mode on IBM RS/6000)
GL capture is available on IBM RS/6000 workstations, but only if the local display is used. The
frame buffer (1 through 5) to be captured must also also specified.
1. RGB, front buffer
2. RGB, back buffer
3. RGB, full buffer
4. Color map, front buffer
5. Color map, back buffer
Select GL Mode to capture windows that have been generated by GL-based applications or other
non-X applications if they contain elements that cannot be "seen" by the X Window System.
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GL Capture on IBM RS/6000
The information provided in this section is intended for the System Administrator
Capture in GL mode on IBM RS/6000 is performed by the program capgl which saves images in XWD
format. It is an independent capture program that enables IBM RS/6000 users to capture GL windows.
The information provided here is included for reference and as an aid in troubleshooting situations. The
command line interface to capgl is the following:
$ capgl file x0 x1 y0 y1 window buffer
file
The name of the XWD file in which the captured screen is saved.
x0 x1 y0 y1
The left, right, bottom, and top edge of the area to be captured. The origin of the screen coordinate
system is the lower left corner of the display.
window
The window id of the window to be captured
buffer
The GL buffer mode is specified as a number (1-5). The buffer modes are explained on the previous
page.

Configuration of Hot Keys in a Window Manager
The information provided in this section is intended for the System Administrator

It is possible to configure an X Window Manager to execute specific actions when
some key combination is pressed. This is known as key binding.
You can, for example, use this to provide hot keys for screen capture independently of
EasyCopy s graphical user interface.
It is recommended, to use the Hot Keys dialog to setup hot keys. The methods described below are
provided for the case that you want to use eccapt in a customized solution .

The examples provided show how to bind three key combinations:
Key

Shell script (example)

PrintScreen

/mnt/hotkeys/PrtScr
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Shift F1

/mnt/hotkeys/shiftF1

Ctrl F1

/mnt/hotkeys/ctrlF1

Key binding is implemented by entries in the X Window Manager s resource file and
application defaults file. The details depend on which X Window Manager you use.
Mwm (Motif Window Manager)
The resource file .mwmrc resides in your home directory (if not found a system-wide
file /usr/lib/X11/system.mwmrc applies). Locate this sequence:
Keys DefaultKeyBindings
{ ...
}

Insert the following lines inside the {...} block:
<Key>Print root|icon|window f.exec "/mnt/hotkeys/PrtScr &"
Shift<Key>F1 root|icon|window f.exec "/mnt/hotkeys/shiftF1 &"
Ctrl<Key>F1 root|icon|window f.exec "/mnt/hotkeys/ctrlF1 &"

To make sure that the DefaultKeyBindings section is used the Mwm file in your home
directory (or system-wide /usr/lib/X11/app-defaults/Mwm) must contain the line:
Mwm*keyBindings: DefaultKeyBindings

To make the key bindings active the Window Manager must be restarted.
Dtwm (CDE Window Manager)
The resource file .dt/dtwmrc resides in your home directory (if not found a system-wide
file /usr/dt/config/C/sys.dtwmrc applies). Locate the sequence
Keys DtKeyBindings
{ . . .
}

Insert the following lines inside the {...} block:
<Key>Print root|icon|window f.exec "/mnt/hotkeys/PrtScr &"
Shift<Key>F1 root|icon|window f.exec "/mnt/hotkeys/shiftF1 &"
Ctrl<Key>F1 root|icon|window f.exec "/mnt/hotkeys/ctrlF1 &"

To make sure that the DtKeyBindings section is used the Dtwm file in your home
directory (or systemwide /usr/dt/app-defaults/C/Dtwm) must contain the line:
Mwm*keyBindings: DtKeyBindings

To make the key bindings active the Window Manager must be restarted.
4Dwm (Window Manager on SGI workstations)
The resource file .4dwmrc resides in your home directory (if not found a system-wide
file /usr/lib/X11/system.4Dwmrc applies). Locate the sequence
Keys 4DwmKeyBindings { . . . }

Insert the following lines inside the {...} block:
<Key>Print root|icon|window f.exec "/mnt/hotkeys/PrtScr &"
Shift<Key>F1 root|icon|window f.exec "/mnt/hotkeys/shiftF1 &"
Ctrl<Key>F1 root|icon|window f.exec "/mnt/hotkeys/ctrlF1 &"
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To make sure that the 4DwmKeyBindings section is used the 4DWm file in your home
directory (or system-wide /usr/lib/X11/app-defaults/4DWm) must contain the line:
Mwm*keyBindings: 4DwmKeyBindings

To make the key bindings active the Window Manager must be restarted.
Vuewm (Window Manager on HP workstations)
The resource file .vue/vuewmrc resides in your home directory (if not found a
system-wide file /usr/vue/config/sys.vuewmrc applies). Locate the sequence
Keys VueKeyBindings { . . . }

Insert the following lines inside the {...} block:
<Key>Print root|icon|window f.exec "/mnt/hotkeys/PrtScr &"
Shift<Key>F1 root|icon|window f.exec "/mnt/hotkeys/shiftF1 &"
Ctrl<Key>F1 root|icon|window f.exec "/mnt/hotkeys/ctrlF1 &"

To make sure that the VueKeyBindings section is used the Vuewm file in your home
directory (or system-wide /usr/vue/app-defaults/Vuewm) must contain the line:
Mwm*keyBindings: VueKeyBindings

To make the key bindings active the Window Manager must be restarted.
Twm (Tab Window Manager)
The resource file .twmrc resides in your home directory (if not found a system-wide
file /etc/X11/twm/system.twmrc applies). Insert the following lines:
"Print" = all : f.exec "/mnt/hotkeys/PrtScr &"
"F1" = s : all : f.exec "/mnt/hotkeys/shiftF1 &"
"F1" = c : all : f.exec "/mnt/hotkeys/ctrlF1 &"

To make the key bindings active the Window Manager must be restarted.
Fvwm (Feeble Virtual Window Manager)
The resource file .fvwmrc resides in your home directory (if not found a system-wide
file /etc/X11/fvwm/system.fvwmrc applies).
Insert the following lines:
Key Print Exec "PrtScr" /mnt/hotkeys/PrtScr &
Key F1 AT S Exec "shiftF1" /mnt/hotkeys/shiftF1 &
Key F1 AT C Exec "ctrlF1" /mnt/hotkeys/ctrlF1 &

To make the key bindings active the Window Manager must be restarted.

Shell Script Examples
The information provided in this section is intended for the System Administrator

These examples can, for instance, apply to hot key association or system calls from
your own application.

Pipe a Captured Image into EasyCopy's Print Dialog
EasyCopy's graphical user interface opens in a special print mode when an input file is
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supplied on stdin (refer to the description of ecx). The Main window is not shown; the
Print dialog is entered directly:

You can now press Print to print the image supplied on stdin, or you can first modify
the printer setup, layout, or other options.
In this mode EasyCopy terminates after you press Print or Cancel.
You can utilize this in a shell script where you pipe the image captured by eccapt into
EasyCopy, and associate this script with a hot key, for example the Ctrl+PrintScreen
key.
Pressing Ctrl+PrintScreen will then have the effect that you first capture a window or
an area, and then get the Print dialog that allows you to print the captured image.
Local Setup

#!/bin/sh
eccapt | ecx This example script calls eccapt with default parameters. This implies that the
interactive capture type applies. If you need other options you can specify these in
the script, for example to capture the full screen and force a beep before and after
screen capture:

#!/bin/sh
eccapt -fullscreen -beep true | ecx 395

If you need a choice between options, you must configure two (or more) hot keys,
for example Ctrl+PrintScreen for one set of options (one variant of the script) and
Shift+PrintScreen for an alternate set of options (another variant of the script).
Remote Setup
For remote use you must change the script to access EasyCopy on the remote
server. This example assumes that the name of the remote server is pserver; you
must substitute this with the correct server name.

#!/bin/sh
xhost pserver
rsh pserver eccapt -display `hostname`:0.0 |
rsh pserver ecx - -display `hostname`:0.0
`hostname` is automatically replaced by the name of your local workstation.
The described approach requires that you have a home directory on the server.
You can avoid that the script prompts you for a password for accessing the server,
if your home directory on the server contains an .rhosts file in which you specify,
that your workstation node can login without password.
Immediate Print of the Captured Image
You can also pipe the captured image directly into ecprint if you want to print it without
opening the graphical user interface.
Local Setup

#!/bin/sh
eccapt | ecprint -printer prt1 -size 4 | lpr -Pprt1
This example assumes that you want to scale the captured image to a width of 4
inches and want to send the print job to a printer installed under the name prt1 on
the print queue prt1.
The last pipe ( | lpr -Pprt1) indicates that the printer is connected to the print queue
prt1 in a BSD print system.
Network Setup
For remote use you must change the script to access EasyCopy on the remote
server.

This example assumes that the name of the remote server is pserver; you must
substitute this with the correct server name.
#!/bin/sh
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xhost pserver
rsh pserver eccapt -display `hostname`:0.0 |
rsh pserver ecprint -printer prt1 -size 4 -display
`hostname`:0.0 |
rsh pserver lpr -Pprt1
`hostname` is automatically replaced by the name of your local workstation. The
described approach requires that you have a home directory on the server. You
can avoid that the script prompts you for a password for accessing the server, if
your home directory on the server contains an .rhosts file in which you specify, that
your workstation node can login without password. Save the Captured Image as a
TIFF File You can pipe the captured image into ecconv to convert it from XWD
format to another format of your choice, for example TIFF. #!/bin/sh eccapt |
ecconv export tif compression lzw > /usr/tmp/0001.tif The resulting TIFF file is
here saved by ecconv as /usr/tmp/0001.tif.
Copyright © 2003, AGI (autoGraph international), www.augrin.com.
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Command Line Interface: ecview
The information provided below applies to the UNIX versions of EasyCopy.

You can also use the image viewer used in EasyCopy through a command line
interface as described below.
Here is shown an example of an image displayed by ecview.

The window closes automatically if you have specified a non-zero value to the -timer
option; otherwise, just use the explicit system procedures to close the window.

The syntax for the ecview command is as follows:
$ ecview [options] [input-file]

The program uses right-to-left precedence: if an option is duplicated, the value
supplied with the one that is last specified (rightmost) is used.
Options and parameters (apart from path and host names) can be abbreviated as long
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as they can be unambiguously identified, for example, -help can be abbreviated to -h.
Options and parameters (apart from path and host names) may be entered with
uppercase and lowercase letters and with underscores between "words". Letters are
converted to lowercase and underscores are removed during parsing. For example,
-C_map and -cmap are treated the same.

Input file
This is the image file to be displayed. Standard input (stdin) is assumed if no input file
is specified. Refer to the list of supported file formats. Any input filters you have
configured for EasyCopy apply also to ecview.

Environment Options
-sysdir sysdir
Specifies the path name of the system directory directory. If the -sysdir option is
not supplied, the directory pointed to by the SYSDIR variable is used. The system
directory directory must be available to ecview; the normal installation procedure
sets the correct value of the SYSDIR variable in the ecview script. If the path
name is not available the program terminates with an error message.
-tmp tempdir
Specifies the directory for the temporary files. If the -tmp option is not supplied the
value of the TMPDIR environment variable is used. The normal installation
procedure sets the correct value in the ecview invocation script.
-display hostname:server.screen
Specifies the display on which the image is wanted. If the display is not specified,
the DISPLAY variable is used. If the DISPLAY variable is not set, the local screen
(hostname:0.0) is the default display.

Informational Options
These options are used for display of information. They do not start the image viewer.
If you supply -help or -version all other options are ignored.
-help
Displays help and usage of the ecview command. The program terminates after
displaying the help information.
-version
Displays the version and release date of ecview, and the name and version of the
operating system. The program terminates after displaying the version information.

Display Window Options
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-bartitle text
Specifies the title in the title bar of the window. By default the image file name is
displayed.
-size heightxwidth
These two options specify the dimensions of the window (exclusive of frame). The
default is the dimension of the input image, unless this exceeds the screen size in
which case the window is made as large as possible within the screen. The image
is scaled to fit the specified window size.
-timer secs
Specifies a time interval (secs seconds) after which the window is closed
automatically.

Image Options
-pageno page
Speciefies a page number of a multi-page image. The default is the first page.
-rotate { 0 | 90 | 180 | 270 }
Specifies a rotation of the image.
-mirror { none | horizontal | vertical | both }
Specify that the output image is mirrored (-mirror both is the same as -rotate 180).
-interpolation { averaging | bilinear | replication }
Specifies the interpolation method to apply if the image is resized; refer to the topic
Image Scaling.

-crop widthxheight+xoffset+yoffset
Specifies that the output image is obtained by cropping a rectangular area within
the input image. The width and height of the cropped area are measured from
specified xoffset and yoffset. The offsets are relative to the top-left corner of the
input image:
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All values are in pixel units. width+xoffset must not exceed the width of the input
image, and height+yoffset must not exceed the height of the input image.

Color Options
-output { color | gray | bw | eightcolor }
This option specifies a mode that applies before -colormode is used. It corresponds
to the setting you can make in the Color Options dialog.

-reversal { none | color | bw | gray }
Color reversal mode. It corresponds to the setting you can make in the Color
Options dialog.

-removebgs n
Remove n background colors. It corresponds to the setting you can make in the
Color Options dialog, except that command line parameter supports removal of
0-255 colors, where the dialog is limited to a maximum of 5.

-brightness v
-contrast v
-chrominance v
These options correspond to the three color adjustment sliders in the Color
Options dialog.
These command line options are specified in the range -1.0 - +1.0 whereas the slider settings are
in range -100 - +100. A specification like -brightness 0.37 is thus the same as a slider setting of
37.

-redtint v
-greentint v
-bluetint v
These options correspond to the three tint balance sliders in the Color Options
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dialog.
These command line options are specified in the range -1.0 - +1.0 whereas the slider settings are
in range -100 - +100. A specification like -redtint -0.09 is thus the same as a slider setting of -9.

Copyright © 2003, AGI (autoGraph international), www.augrin.com.
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Command Line Interface: ecprint
The information provided below applies to the UNIX versions of EasyCopy.

Use the ecprint command to start EasyPrint as a command line program.
EasyPrint is the printing program of EasyCopy. It is called automatically when you
create a print job in the graphical user interface (Print dialog). Printer selection, printer
setup, and page layout options are specified by using the various dialogs and
transferred together with image data from the graphical user interface to EasyPrint.

ecprint is used to create the ready-to-print data stream for the selected printer. It is
invoked silently, when files are submitted from the Graphical User Interface, or when
an application is printing using the lp or lpr command for a print queue setup by
EasyCopy for print queue processing.

The program can also be used alone. Its command line interface gives you the same
control as the graphical user interface.
ecprint creates a data stream which is ready to print. It does not send this data stream to the print
queue. When you use ecprint from the command line you must direct its output data stream to lp or
lpr to create print jobs.

Supported Formats
ecprint detects if the input file is supported. Any file that can be opened by EasyCopy
is supported, except graphics. This includes:
Raster image files

Graphics files
Requires the licensable option EasyCGM.

PDF files
Uses the Ghostscript filter.

PostScript files
If the current printer is a PostScript printer it sends the file directly to the printer.
Otherwise the Ghostscript filter is used.

Compressed files
Uses the decompression filters.

ASCII text files
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(uses the ASCII to PostScript filter);

In addition to these file types ecprint supports Print Job files (these files are prepared
for ecprint by the graphical user interface or by ecprint itself).
If the file is not recognized as a supported type ecprint lets the file pass unmodified. A
warning message is given only if the informational option -warning true has been
specified.

Command syntax
The command line syntax is as follows:
ecprint [options] [@response-file] [in-file [out-file]]

The ecprint program uses right-to-left precedence: if an option is duplicated the value
supplied with the one that is last specified (right most) is used.
Any of the options for absolute or relative image size (-size or -scalefactor) are
duplicates. The one specified last counts. Similarly, options for absolute or relative
image position (-horizontal and -vertical, or -offset) are duplicates.
If two options contradict each other ecprint displays an error message and terminates.
This may happen if the specified options violate constraints expressed in the printer
description file.
Options and parameters (apart from path and queue names) may be entered with
uppercase and lowercase letters and with underscores between "words." Letters are
converted to lowercase and underscores are removed during parsing. For example,
the following are all interpreted identically:-PageSize, -pagesize, -page_size, or
-Pagesize.
Options and parameters (apart from path and host names) can be abbreviated as long
as they can be unambiguously identified. For example, -unit can be abbreviated -un.
It may happen, that an abbreviation is valid for one printer and ambiguous for another printer because
of different printer specific options.

If an option is not supplied in the command line, a default value applies. The default
parameters originate (in order of precedence) from three sources:
1. Your private initialization file
2. The system-wide initialization file created by system administrator
3. Factory defaults embedded in the software
Refer to the topic Scope of Options for further information.

Help listing
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The current default options can at any time be determined from the help list. Use the
-help option to get this list:
$ ecprint -help
Copyright (c) 2002 AutoGraph International Inc.
Copyright (c) 2002 Augrin Software ApS.
All rights reserved.
----------------------------------------------ecprint [options] [@<response-file>] [<in-file>[<out-file>]]
# Basic Options
-printer <printer> overrides PRINTER.
-printqueue <printqueue> selects printer by queue name.
-sysdir <sysdir> overrides SYSDIR. /opt/easycopy/system is default
-tmpdir <tmpdir> overrides TMPDIR. /usr/tmp is default
...

For choice options the leftmost choice is the default. For value options the range is
shown, and the default is written explicitly in the help listing:
...
-unit {inches | millimeters | dots | points}
-scalefactor <1-100> 100 percent is default
...

-unit is a "choice option"
and inches is default.
-scalefactor is a "value
option". Valid range is 1
through 100. The default
is 100.

Input and Output files
These parameters must appear last in the command line.

in-file
The input file, refer to Supported Formats. The default is stdin.
out-file
The output file in a printer specific format. The default is stdout.
-eps
This option is only used if a PostScript printer is selected. It ensures that the output
file conforms to the conventions for Encapsulated PostScript.

Environment Options
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-printer printer
This specifies the name of the printer. You can also specify the printer by means of
the PRINTER variable. The -printer option overrides the PRINTER variable. The
default is the printer you most recently have selected in the Printer Selection dialog.

The printer name enables ecprint to retrieve defaults and find the correct printer
description file.
-printqueue queuename
You may specify the print queue and the printer description file as an alternative to
the -printer option. The print queue must be specified, either directly or through the
-printer option (the print queue is given if you specify the -printer option, because
the printer name is just shorthand for a combination of a specific print queue and a
specific printer description file).
-pd printer-description-file
This is the name of the printer description file (PPD or EPD file) for the printer. The
default is generic.ppd.
If you specify the -printer option the printer description file is given, because the
printer name is just shorthand for a combination of a specific print queue and a
specific printer description file.
-sysdir sysdir
Specifies the path name of the easycopy/system directory, where EPD and PPD
files are located. If the -sysdir option is not supplied, the directory pointed to by the
SYSDIR variable is used. The -sysdir option overrides the SYSDIR variable. The
easycopy/system directory must be available to ecprint; the normal installation
procedure sets the correct value of the SYSDIR variable in the ecprint script. If the
path name is not available the program terminates with an error message.
-inifile initialization-file
Specifies the path name of the system-wide initialization file. If the -inifile option is
not supplied, the file pointed to by the INIFILE variable is used. The -inifile option
overrides the INIFILE variable. The system-wide initialization file must be available
to ecprint; the normal installation procedure sets the correct value of the INIFILE
variable in the ecprint script. If the path name of the system-wide initialization file is
not available the program terminates with an error message.
-tmpdir tempdir
Specifies the directory for the temporary files. Normally, you do not need this
option; it is intended for test purposes, for example if you occasionally run a print
job that requires more temporary space than is available in the default location. If
the -tmpdir option is not supplied the value of the TMPDIR variable is used. The
normal installation procedure sets the correct value in the ecprint invocation script.
-user login-name
When ecprint is used as a print queue filter this option provides the name of the
user who submitted the print job. This enables ecprint to retrieve user defaults.
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When ecprint is used on the command line, there is no need for this option.
Informational Options
-help
Displays help and usage information about ecprint, refer to example above.

Printer options in the help list refer to the printer given by the -printer option, so if
you want to display options for another printer than your default printer you must
supply the printer name.
ecprint terminates after it has displayed the help information.
-version
Displays version information, release date, operating system, and the system's
primary key (used for registration).
ecprint terminates after it has displayed the version information.
-warning { false | true }
This option controls if warning messages should be issued. Specify -warning true
on the command line in troubleshooting situations. Warnings are written to stderror
(normally your terminal or console window) if you have invoked ecprint from the
command line.
If ecprint is running as part of the spooling process (print queue processing)
warning and error messages are written to the error log file that is associated with
the print queue.

Page Layout Options
These options are used to specify the position and size of the printed image. Layout
options are ignored if the input file is a PostScript file that is passed through to a
PostScript printer. The options correspond to the controls available in the Page Layout
dialog. Refer to the Page Layout dialog for detailed descriptions.

-orientation { bestfit | portrait | landscape }
Specifies the orientation of the printed output on the page.
-unit { inches | millimeters | dots | points }
Specifies the unit of measurement.
-horizontal { left | center | right }
-vertical { top | center | bottom }
Specifies the alignment of the printed image.
-offset [left] [+top]
Specifies the offset of the printed image from the top left corner of the physical
page.
Specify either alignments or offset. If you specify both the last given option counts.
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-size [width] [xheight]
Specifies the absolute size of the printed image.
The -size option also implies the aspect ratio.
To produce a print with a width of 4 inches and the height calculated automatically according to
the aspect ratio of the input image, type -size 4.
To produce a print with the height of 8 inches and the width calculated automatically with
maintained aspect ratio, type -size x8.
Include both the width and the height if you do not want to maintain the aspect ratio.

-scalefactor
Specifies the relative size of the printed image in percent (refer also to Page Layout
dialog).
-pixscale scale
Specifies a scale factor as number of printer dots per input pixel (refer also to Page
Layout dialog).
-metricscale scale
Specifies a metric scale factor. To get a printed images in 1:1 scale
specify metricscale 1. This method is only available if the input file has a known
metric size (refer also to Page Layout dialog).
Specify either -size or one of the scale options. If you specify more than one size or scale option
only the last one given counts.

Color Options These device independent color options specify color modifications that
apply before the image is rendered for printing. Color options are ignored if the input
file is a PostScript file that is passed through to a PostScript printer. The options
correspond to the controls available in the Color Options dialog. Refer to the Color
Options dialog for detailed descriptions.

-output { color | gray | bw }
Specifies the output mode.
-removebgs {none | 1 | 2 | 3 | 4 | 5} Specifies removal of one or more background
colors.
-reversal {none | bw | gray | color} Specifies color reversal mode.
-8color {false | true} Specifies reduction to 8 pure colors.
Printer Setup Options
These are printer specific setup options defined in the associated printer description
file. They correspond to the controls available in the three tabs of the Printer Setup
dialog. Refer to the Printer Setup dialog for detailed descriptions.

The available options, their names, and valid range of values depend on the printer.
Use the help list to get a list of the available options for a given printer:
408

$ ecprint -printer printer-name -help

Many printer setup options appear with the first letter of each "word" capitalized exactly as extracted
from the printer description file. You need not type the option exactly as shown. Printer options can
be entered in lowercase or abbreviated like other command line options.

The printer options described here are commonly used; however, an option is available
for a given printer only if it is defined in the printer description file as a multiple choice;
otherwise the option is illegal.
Printer Setup - Paper Options
-PageSize { Letter | Legal | A4 | ... | Custom }
Specifies the page size.
The last entry in the list of page sizes is Custom if the printer supports custom page
sizes. The dimensions of the custom page can be specified with the
-custompagesize option.
If a page size defined in the printer description file is unavailable due to a license
restrictions it appears with an asterisk in the help listing.
-custompagesize [width] [xheight]
Specifies the dimensions of a custom defined page size. This option is available if
the printer supports custom page sizes. The unit of measurement is controlled by
the -unit option (inches is the default).
The -custompagesize option is acknowledged only if -pagesize custom is also
specified.
-MediaType { Paper | Transparency | ... }
Specifies the media type.
-Source {AutoSelect |UpperTray | LowerTray |...| ManualFeed}
Specifies the media tray or input slot to use as the media source.
Printer Setup - Appearance Options
-Resolution { 300x300dpi | 300x600dpi | 600x600dpi |... }
Specifies the printer resolution in dots per inch (dpi).
Many printers only support one resolution setting. However, to ensure that you can
always find the resolution information in a consistent way (in the Printer Setup
dialog or by means of ecprint -help) the option is always defined.

Normally, the resolution is the same in both directions (isomorphic resoluution).
However, many newer printers support anamorphic resolution modes, for example
300x600dpi which means a resolution of 300 dpi horizontally, and 600 dpi vertically.
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If all resolution settings for the printer are isomorphic, the printer description file may specify the
settings in a shorthand form, for example 300dpi in stead of 300x300dpi. The shorthand form and
the complete form cannot be intermixed in a printer description file. If you supply this option
unabbreviated you must use the same form as practiced in the printer description file. However,
due to the abbreviation rules -res 300 matches an isomorphic resolution of 300 dpi no matter
which of the two forms is employed in the printer description file.

-gamma <0.10-9.90>
Specifies the gamma correction.
This is not taken into consideration if gamma correction is inconsistent with possible printer
options for color correction.

These options apply only to printers with an active EasyColor profile:

-EasyColor { ColorInks | BlackInk | ... | None }
Specifies the EasyColor color correction profile.
-saturation <0-100>
Specifies the weight of saturation when EasyColor color correction must trade off between correct
saturation and correct hue. This is only taken into consideration if also the -EasyColor option is
effective.
-ecblue <0-100>
Specifies the adjustment of blue. The default value is 50 (no adjustment). Set a value < 50 to reduce
green. Set a value > 50 to reduce purple.
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These options do not apply to PostScript printers:
-quality { presentation | draft }
Specifies the print quality; presentation is default.
If this option is present you should not specify -scaling and -shading because an explicit print
quality specification implies given printer specific settings of these options.
-ShadingMethod { Scatter | Screening | Dithering | Halftoning | ... }
Specifies the shading method .
-ShadingMatrix { 6x6 | 8x8 | ... }
Some shading methods also use a specific matrix size.
-ScalingMethod { Averaging | Replication | Interpolation | hwn }
Specifies the scaling method . The default is implied by the -quality option.

If you choose a hardware scaling you must also specify hardware shading and vice versa.

Printer Setup - Features
-mirror { false | true }
Specifies mirrored print.
These options refer to PostScript printers:
-encoding { autoselect | ascii }
Specifies the encoding of a PostScript output file.
-lzw { true | false }
Specifies LZW compression of the data stream.
-lzwmode { autoselect | predictor | nopredictor } Specifies the LZW predictor mode.
-jpeg { false | true | <1-20> }
Specifies JPEG compression of the image data stream. You can specify false to disable JPEG
compression, true to enable JPEG compression using the default quality, or a number from 1 to 20 to
enable JPEG compression and set the quality explicitly.

This options refer to PCL printers:
-compression { packbits | runlength | none }
Specifies the compression of the data stream.

Other Options
-copies <1-999>
This specifies the number of copies. One copy is default. You can specify a
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maximum of 999 copies.
Response File
-mkres response-file
Specifies the path name of a response file to be made. The response file created
with the -mkres option is identical to the response header that ecx creates when a
print is requested. The file can be used for subsequent invocations of ecprint, or
you can put it in front of the input file to create a print job file. If the specified
response file already exists, it is updated.
The generated response file encloses the options between AGICMD and
AGICMDEND. The response file does not contain any of the options -printer, -sys,
-inifile, -tmp, -user, and -mkres.
@response-file
The response file may contain any number of options, exactly as they are specified
on the command line, enclosed between AGICMD ... AGICMDEND. The
master-space character @ must precede the name of the response file.
Copyright © 2003, AGI (autoGraph international), www.augrin.com.

412

Print Queue Administration
The information provided below applies to the UNIX versions of EasyCopy.

The ecqadm script is used to create, remove, and query print queues for EasyCopy. It
is normally invoked automatically by the print queue related functions of the graphical
user interface. In certain situations you may also want to use the script from the
command line, for example for the management of print queues on a UNIX server with
no X Window system installed, or in order to fix or verify system malfunction problems.

The syntax is as follows:
ecqadm

[ -create | -remove | -status ]

[print-queue]

You may enter one of the options -create, -remove, or -status, and supply the name of
the print queue as an optional parameter to any of the three options.
To remove the print queue acme, for example, type:
# ecqadm -remove acme
If no arguments are specified ecqadm opens a menu.

The functions Create and Remove are only available for the System Administrator. The Status
function is available to all users.

Create a Print Queue
This function of ecqadm can be requested in one of three ways:

Type ecqadm -create from the command line
Select option [1] from the ecqadm menu
Press Create New Queue in the Add Printer dialog
In any case, you must be system administrator to create a print queue.
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Print Queue Name
If the name of the print queue to be created has not been specified in the
command line, ecqadm prompts for the name. A print queue name can only
contain letters A-Z and a-z, digits 0-9, and underscore _. Each name must be
unique. The maximum length is 14 characters.
Connection Method
When the print queue name has been supplied, ecqadm prompts for information to
establish the desired print queue. The details depend on the connection method
and on the workstation platform.
These are the choices for connection method:

Select the connection method that corresponds to the way the printer is physically
attached.
Parallel Device
The name of the parallel device is requested.
Serial Device
The name of the serial device and the baud rate are requested. The baud rate
must be set the same as the printer's baud rate. The default baud rate is 9600.
Baud rates higher than 19200 are normally not recommended.
SCSI Device
The name of the SCSI device, for example /dev/scsi/6, is required. Refer to the
topic SCSI Printers for information on how to install SCSI devices.

Remote Workstation/Server
The name or IP address of the remote host, the print system type (BSD,
System V, etc.) and the name of the remote print queue are requested.
It is recommended, that the print queue you want to use exists on the remote
system before you create queues on other workstations.
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There must be a user called lp on the remote system unless both the remote
and the local print system are BSD systems. The lp user must in some cases
(see below) allow your local system to perform remote login without being
prompted for a password when a print job is being submitted to the remote
queue.
Any combination of local and remote system that requires a remote lp user with no password
may conflict with your system security policy. If this is the case, you must refrain from such
combinations.

The local workstation must be known on the remote system. This means that its
host id must exist in /etc/hosts on the remote system, and in /etc/hosts.equiv or
locally in .rhosts in lp's home directory.
The setup of the lp user as described may sometimes cause troubles. The
following summarizes extra precautions that apply to certain combinations of
local and remote system:
Connecting from a BSD system to another BSD system:
No special precautions.
Connecting from a BSD system to HP 9000 or Silicon Graphics:
The local runtime user id is daemon, so the remote lp user must be allowed
to login without a password.
Connecting from a BSD system to Solaris 2:
The local runtime user id is daemon, so the remote lp user must be allowed
to login without a password. On the remote Solaris system you must edit the
file /usr/spool/lp/.rhosts. There must be a line containing the host name and
the user id daemon. This allows the BSD system to do the required remote
shell operation.
Connecting from a HP 9000 or Silicon Graphics system:
The local runtime user id is lp, so remote printing is possible even if the
remote lp user has a password.
Connecting from an IBM RS/6000 system:
No special precautions, except that connection to a Silicon Graphics system
malfunctions if the remote system is running IRIX 4.0.1.
Connecting from a Solaris 2 system:
The local runtime user id is the user who made the print request, so the
remote lp user must be allowed to login without a password.
Removing the Password for the lp User
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On Silicon Graphics and SUN Solaris 2 systems the password is deleted by
the command:
# passwd -d lp

On IBM RS/6000 systems the password is deleted by hitting <Enter> in
response to a prompt for a new password:
# passwd lp
lp's new password:

On HP 9000 and SunOS systems you must remove the password manually
by editing the file /etc/passwd. The entry for lp may for example look like:
lp:

yv3ZhyNgai4zvP

:9:9:Line Printer:/usr/spool/lp:/bin/csh

Remove
this part
lp::9:9:Line Printer:/usr/spool/lp:/bin/csh

Internal TCP/IP Connection
This is used for printers with a network interface card offering a socket
interface. The host name or IP address of the printer is requested.
BSD Network Interface
This is used for printers with a network interface card offering a BSD interface.
The host name or IP address of the printer and the name of its BSD print queue
are requested.
Processing Method
Choose between Direct Processing and Print Queue Processing. These two
concepts are explained in the topic Printing Models.

Confirm the Creation of a New Print Queue
After you have entered all the requested information, ecqadm displays a summary
of your selections; you may now choose to continue, or if you wish to make
corrections you may return to the ecqadm menu without creating the print queue.
If you accept the selections the new print queue is created. In some operating
system environments, this requires that all print queues are shut down and
restarted. If this is the case, the current status of all print queues are displayed, so
that you can make sure that they are all idle before you proceed.

Remove a Print Queue
This function of ecqadm can be requested in one of three ways:

Type ecqadm -remove from the command line;
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Select option [2] from the ecqadm menu;
Enable Also Remove Print Queue in the Remove Printer dialog and press the OK
button.
In any case, you must be system administrator to remove a print queue.

If the name of the print queue has not been specified in the command ecqadm
displays the names of all existing print queues, and asks you to select the one you
want to remove.
Before the queue is removed, the print queue name is displayed again, and you are
asked to confirm the operation. The current status of the queue is displayed, so that
you can make sure that the queue is idle, otherwise, you can loop back, and get a
display of the updated status.
Before any files or directories are deleted, you are asked to confirm this.

Status of a Print Queue
This function of ecqadm can be requested in one of four ways:

Type ecqadm -status from the command line
Select option [3] from the ecqadm menu
Press Status in the Printer Selection dialog
Press Queue Status in the Add Printer dialog

You need not be system administrator to use this function.
If the name of the print queue has not been specified in the command ecqadm
displays the names of all existing print queues, and asks you to enter the one you want
to query.
The detailed format of the Status display depends on the platform and system you are
using. The commands lpstat or lpq are used to build the the status part of the display.
Here is shown an example:

Copyright © 2003, AGI (autoGraph international), www.augrin.com.
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Command Line Interface: eclpd
The information provided below applies to the UNIX versions of EasyCopy.

This is a filter used to send a file to a BSD system.
$ eclpd [options] [file ...]

The command is used when ecprint is invoked in a print queue connected to a remote
BSD system. The filter reads each supplied file (in sequence) and sends the file via
TCP/IP to the remote controller. If no files are supplied, the program operates as a
standard input filter.
Options can be abbreviated as long as they can be unambiguously identified.
-ph printer-host
Specifies the name or IP address of the remote host with the lpr based print
system. If the remote host is not specified, the default printer host defined by the
PRINTER variable is used. The host name of the printer must be available to
eclpd.
The -ph option must be supplied if no default printer host is defined by the
PRINTER variable; Otherwise, eclpd terminates with an error message.
-rq remote-queue
Specifies the name of the remote print queue.
-tmp tmpdir
Specifies the path name of the directory, where temporary files may be written. If
the -tmp option is not supplied, the directory pointed to by the TMPDIR variable is
used for temporary files. The normal installation procedure sets an appropriate
value of the TMPDIR variable in the eclpd script. If the path name of the temporary
directory is not available, the system s default (typically /usr/tmp) is used.
-help
Displays help and usage of the eclpd command.
-version
Displays the version and release date of eclpd, and the name and version of the
operating system. The filter terminates after displaying the version information.
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-sys sysdir
Specifies the path name of the system directory directory where the sequence
(.seq) file is located. If the -sys option is not supplied, the directory pointed to by
the SYSDIR variable is used. The sequence file is used by eclpd to ensure unique
naming of spool files.
-user login-name
When eclpd is invoked silently in the print queue, this option provides eclpd with
the name of the user who submitted the print job. When eclpd is used on the
command line there is no need for this option.
Copyright © 2003, AGI (autoGraph international), www.augrin.com.
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